## Table of Contents

Preface ................................................................................................................................. 1
Purpose ................................................................................................................................. 1
Audience ............................................................................................................................. 1
Organization ....................................................................................................................... 1
Related Documentation .................................................................................................... 2
Conventions ......................................................................................................................... 3
Obtaining Documentation and Submitting a Service Request ............................................ 4
Documentation Feedback .................................................................................................. 4

### Part 1. Product Overview and Deployment ............................................................. 5

1. Product Overview ........................................................................................................ 7
   About Cisco Unified Intelligence Suite ........................................................................ 7

2. Deployment Models ..................................................................................................... 9
   Deployment Models ....................................................................................................... 9
   Simple Deployment ....................................................................................................... 9
   Standard Deployment ................................................................................................... 10
   Scaled Deployment ...................................................................................................... 11

3. Understanding Unified IS Security ............................................................................ 13
   Unified IS Security Model ............................................................................................. 13
   Security and Data Access ............................................................................................. 14
   Encryption ...................................................................................................................... 15
   Security Hardening ....................................................................................................... 16
   Synching with the Time Server .................................................................................... 16
   Passwords ...................................................................................................................... 16

4. Databases Used by Unified IS .................................................................................. 17
   The Unified IC Database ............................................................................................... 17
   The Unified ICM/CCE Admin Workstation Databases (AW/HDS) ......................... 17
     The AW Database ..................................................................................................... 18
     About Real Time Data ............................................................................................... 18
   The Unified ICM Historical Data Server (HDS) .......................................................... 19
     About Half Hour Data ............................................................................................. 19
   The Archiver Database ................................................................................................. 19
   Database Backups ......................................................................................................... 19

### Part 2. Installation and Configuration ................................................................. 21

5. Installation and Configuration ................................................................................... 23
   Checklist for a Simple Deployment ............................................................................. 23
   Checklist for a Standard or Scaled Deployment ......................................................... 25
   Installation .................................................................................................................... 28
     Installation Prerequisites ........................................................................................... 28
     Installing Unified IS .................................................................................................. 29
     Uninstalling / Reinstalling Unified IS ...................................................................... 30
     Install and Uninstall Logs ......................................................................................... 31
     Disabling the usage of extra memory (Applicable only for systems that has a memory of more than 16 GB) ........................................................................................................ 31
   Internal Users ................................................................................................................ 32
   Internal User Properties ............................................................................................... 32
Part 3. Unified IS Administration

6. Initial Actions for the Administrator after Installation and Configuration

7. Administering Users and User Groups

8. Administering Value Lists and Collections and Viewing Diagnostics

Domain or Local? ........................................................................................................................................ 33
The Unified IC User in a Simple Environment ......................................................................................... 33
The Unified IC User and Archiver User in a Standard or Scaled Environment ....................................... 33
Configuration ............................................................................................................................................ 35
    Configuration Prerequisites ................................................................................................................... 36
    Configuring the Unified IC Database ................................................................................................. 37
    Configuring the Intelligence Web Server ......................................................................................... 40
    Configuring the Archiver .................................................................................................................... 46
    Configuration Log .................................................................................................................................. 50
Licensing ..................................................................................................................................................... 50
Upgrading to a Maintenance Release ........................................................................................................ 52

6. Initial Actions for the Administrator after Installation and Configuration ........................................ 55
Logging In .................................................................................................................................................. 55
Editing the Default Data Sources ........................................................................................................... 56
Configuring and Refreshing Stock Values Lists ....................................................................................... 58
Importing and Configuring Stock Reporting Templates ........................................................................... 60
Adding Unified IC Users as Members of the CuisLocalUserGroup ......................................................... 62

7. Administering Users and User Groups

The User List ............................................................................................................................................. 67
    Locating a User ..................................................................................................................................... 67
    Adding Users and Editing User Information ...................................................................................... 68
    User Profile Tab .................................................................................................................................. 69
    User History Tab .................................................................................................................................. 69
    Grouping Users ..................................................................................................................................... 70
Editing User Roles ..................................................................................................................................... 70
    Admin Role .......................................................................................................................................... 71
    Report Designer Role ......................................................................................................................... 71
    Restricted Viewer Role ....................................................................................................................... 72
    Security Admin Role .......................................................................................................................... 72
User Groups ............................................................................................................................................... 73
    Adding a User Group ............................................................................................................................ 73
    Editing a User Group .............................................................................................................................. 74
    Removing a User Group ....................................................................................................................... 75
Fake a User .................................................................................................................................................. 75
Setting Permissions in the Security Center ............................................................................................... 76
Adding or Deleting Access to a Shared Report ......................................................................................... 76

8. Administering Value Lists and Collections and Viewing Diagnostics

Managing Value Lists and Collections ...................................................................................................... 79
    Value Lists .......................................................................................................................................... 80
    Adding a Value List .............................................................................................................................. 81
    Editing a Value List .............................................................................................................................. 81
    Displaying and Refreshing Values ...................................................................................................... 82
    Deleting a Value List ........................................................................................................................... 82
    Collections .......................................................................................................................................... 82
    Adding a Collection .............................................................................................................................. 83
    Editing a Collection .............................................................................................................................. 84
    Deleting a Collection ............................................................................................................................ 84
    Adding or Deleting Access to a Shared Collection ............................................................................. 84
# Part 5. Cisco Unified IC Reporting

## 12. Basic Reporting

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generating a Report</td>
<td>109</td>
</tr>
<tr>
<td>Simple Filter Dialog Box</td>
<td>110</td>
</tr>
<tr>
<td>The Report Interface</td>
<td>111</td>
</tr>
<tr>
<td>Save</td>
<td>113</td>
</tr>
<tr>
<td>Save As</td>
<td>113</td>
</tr>
<tr>
<td>Simple Wizard</td>
<td>114</td>
</tr>
<tr>
<td>Exporting a Report to Excel using the Export command</td>
<td>115</td>
</tr>
<tr>
<td>Exporting a Report to Excel using Permalinks</td>
<td>116</td>
</tr>
<tr>
<td>Advanced Filter</td>
<td>117</td>
</tr>
<tr>
<td>Adding a Value to an Advanced Filter</td>
<td>117</td>
</tr>
<tr>
<td>Report Categories and Subcategories</td>
<td>119</td>
</tr>
<tr>
<td>Report Fields</td>
<td>119</td>
</tr>
</tbody>
</table>

---

# Part 4. The Cisco Unified IC Web Application

## 10. The Unified Intelligence Center Interface

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial View at Login</td>
<td>93</td>
</tr>
<tr>
<td>Localization</td>
<td>93</td>
</tr>
<tr>
<td>SQL Server Collation for Localization</td>
<td>94</td>
</tr>
<tr>
<td>Multilingual User Interface</td>
<td>95</td>
</tr>
<tr>
<td>Menus and Menu Access</td>
<td>96</td>
</tr>
<tr>
<td>Reports Menu</td>
<td>97</td>
</tr>
<tr>
<td>Administrative Menu</td>
<td>97</td>
</tr>
<tr>
<td>Report Administration Menu</td>
<td>97</td>
</tr>
<tr>
<td>Security Menu</td>
<td>97</td>
</tr>
<tr>
<td>Profile Menu</td>
<td>98</td>
</tr>
</tbody>
</table>

## 11. Working with Dashboards

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dashboards</td>
<td>99</td>
</tr>
<tr>
<td>About Dashboards</td>
<td>99</td>
</tr>
<tr>
<td>Adding a New Dashboard</td>
<td>100</td>
</tr>
<tr>
<td>The Dashboard Menu</td>
<td>100</td>
</tr>
<tr>
<td>Creating a Dashboard Item</td>
<td>101</td>
</tr>
<tr>
<td>Adding a Report to a Dashboard</td>
<td>102</td>
</tr>
<tr>
<td>Adding a Report List to a Dashboard</td>
<td>102</td>
</tr>
<tr>
<td>Adding a Scheduled Report to a Dashboard</td>
<td>102</td>
</tr>
<tr>
<td>Adding a Widget to a Dashboard</td>
<td>103</td>
</tr>
<tr>
<td>Adding a URL Frame to a Dashboard</td>
<td>104</td>
</tr>
<tr>
<td>Sharing a Dashboard</td>
<td>104</td>
</tr>
<tr>
<td>Editing Dashboard Properties</td>
<td>104</td>
</tr>
<tr>
<td>Using Dashboard Design Mode</td>
<td>105</td>
</tr>
</tbody>
</table>

---

# Part 5. Cisco Unified IC Reporting

## 12. Basic Reporting

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generating a Report</td>
<td>109</td>
</tr>
<tr>
<td>Simple Filter Dialog Box</td>
<td>110</td>
</tr>
<tr>
<td>The Report Interface</td>
<td>111</td>
</tr>
<tr>
<td>Save</td>
<td>113</td>
</tr>
<tr>
<td>Save As</td>
<td>113</td>
</tr>
<tr>
<td>Simple Wizard</td>
<td>114</td>
</tr>
<tr>
<td>Exporting a Report to Excel using the Export command</td>
<td>115</td>
</tr>
<tr>
<td>Exporting a Report to Excel using Permalinks</td>
<td>116</td>
</tr>
<tr>
<td>Advanced Filter</td>
<td>117</td>
</tr>
<tr>
<td>Adding a Value to an Advanced Filter</td>
<td>117</td>
</tr>
<tr>
<td>Report Categories and Subcategories</td>
<td>119</td>
</tr>
<tr>
<td>Report Fields</td>
<td>119</td>
</tr>
</tbody>
</table>
# Table of Contents

17. Working with Charts and Gauges
   - About Charts and Gauges
   - Chart Wizard Appearance Tab

14. Maintaining Reports
   - Modify the Number of Rows to be Extracted
   - Importing Stock Report Templates
   - Importing the Expert Advisor Report Templates (English)
   - Importing New and Localized Templates from Cisco.Com
   - Renaming a Report
   - Deleting a Report
   - Working with Report XML
     - Editing Report XML
     - Exporting Report XML
   - Advanced Excel Integration

13. Advanced Reporting
   - Report Manager
     - Report List
     - Report Context Menu
     - Report Info
     - Drilldowns
       - Editing or Adding a Drilldown
       - Drilldown Filter
     - Thresholds
       - Editing or Adding a Threshold
     - Scheduled Reports
       - Creating Report Schedules
       - Managing Scheduled Reports
       - RSS Feeds for Scheduled Reports

15. Caching
   - About Caching
   - Flushing the Global Cache

16. Working with the Report Wizard
   - About the Report Wizard
     - Report Wizard Data Source Tab
     - Report Wizard Field Map Tab
   - Creating a New Field on the Field Map Tab
   - Modifying an Existing Field on the Field Map Tab
     - Report Wizard Field Properties (Field Map Tab)
   - Report Wizard Parameters Tab
   - Report Wizard Data Settings Tab
     - Report Wizard Formatting Tab
     - Report Wizard Formatting Tab (Grouping Definition)
     - Report Wizard Help Tab

12. Archiver Reports and Unified IC Reports
   - Archiver Call Type Daily All Fields Report
   - Archiver Reports and Unified IC Reports

11. Cisco Stock Report Templates
   - Cisco Stock Report Templates
     - Report Field Data Source
       - Report Wizard Formatting Tab
       - Report Wizard Data Settings Tab
       - Report Wizard Parameters Tab
     - Modifying an Existing Field on the Field Map Tab
     - Creating a New Field on the Field Map Tab
     - Report Wizard Data Source Tab
     - Exporting Report XML
     - Editing Report XML
     - RSS Feeds for Scheduled Reports
   - Thresholds
   - Drilldowns
   - Drilldown Filter
   - Report Info
   - Report Context Menu
   - Archiver Reports and Unified IC Reports

10. System Error Reports
   - System Error Reports

9. Report Summaries
   - Report Summaries

8. About Charts and Gauges
   - About Charts and Gauges

7. Report Manager
   - Report Manager

6. Advanced Excel Integration
   - Advanced Excel Integration

5. Scheduled Reports
   - Scheduled Reports

4. Creating Report Schedules
   - Creating Report Schedules

3. Managing Scheduled Reports
   - Managing Scheduled Reports

2. RSS Feeds for Scheduled Reports
   - RSS Feeds for Scheduled Reports

1. Flushing the Global Cache
   - Flushing the Global Cache

---

120
121
122
125
125
127
127
128
129
130
132
132
133
134
135
135
137
138
141
141
142
142
143
144
144
145
145
146
147
147
148
149
149
151
151
152
152
154
155
156
156
157
158
159
159
160
Hidden Fields in the Agent Skill Group Real Time All Fields Report........................................248
Sample Agent Skill Group Real Time All Fields Report.........................................................248
Enterprise Skill Group Historical All Fields........................................................................249
About the Enterprise Skill Group Historical All Fields Report.............................................249
Visible Fields in the Enterprise Skill Group Historical All Fields Report...............................250
Hidden Fields in the Enterprise Skill Group Historical All Fields Report...............................253
Sample Enterprise Skill Group Historical All Fields Report.................................................253
Enterprise Skill Group Real Time All Fields.........................................................................254
About the Enterprise Skill Group Real Time All Fields Report.............................................254
Visible Fields in the Enterprise Skill Group Real Time All Fields Report...............................255
Hidden Fields in the Enterprise Skill Group Real Time All Fields Report...............................258
Sample Enterprise Skill Group Real Time All Fields Report.................................................258
Peripheral Skill Group Historical All Fields...........................................................................259
About the Peripheral Skill Group Historical Report............................................................259
Visible Fields in the Peripheral Skill Group Historical Report...............................................260
Hidden Fields in the Peripheral Skill Group Historical Report...............................................264
Sample Peripheral Skill Group Historical Report...............................................................264
Peripheral Skill Group Real Time All Fields...........................................................................264
About the Peripheral Skill Group Real Time All Fields Report.............................................264
Visible Fields in the Peripheral Skill Group Real Time All Fields Report...............................265
Hidden Fields in the Peripheral Skill Group Real Time All Fields Report...............................269
Sample Peripheral Skill Group Real Time All Fields Report.................................................269

23. IVR Reports..................................................................................................................271
IVR Ports Performance Historical.........................................................................................271
About the IVR Ports Performance Historical Report........................................................271
Visible Fields in the IVR Ports Performance Historical Report...........................................272
Hidden Fields in the IVR Ports Performance Historical Report...........................................272
Sample IVR Ports Performance Historical Report............................................................272

Part 7. Expert Advisor Templates.........................................................................................275

24. Expert Advisor Report Templates..................................................................................277
Agent Assignment Queue Report..........................................................................................277
Agent Handle Report...........................................................................................................278
Agent Reject and Timeout Report.........................................................................................278
Agent State Summary Report..............................................................................................279
Assignment Queue Detail Report..........................................................................................279
Contact Detail Reports.........................................................................................................280
Contact Media Detail Report.................................................................................................281

25. Fields Used in Expert Advisor Templates......................................................................283
Alphabetical List of All Fields in the Historical Reports.........................................................283
Appendix A. Troubleshooting Tips and FAQs......................................................................289
Installation..........................................................................................................................289
SQL Hardening.....................................................................................................................289
Troubleshooting Configuration.............................................................................................290
Configuration Tool and Fully Qualified Domain Names.......................................................290
Configuring IIS Failed..........................................................................................................290
Configuring the CUIC Scheduler Service Failed.................................................................291
Creating CUIC Database Failed..........................................................................................292
Domains and Named Instances............................................................................................292
Machines in Multiple Domains..............................................................................................292
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port 80 Error</td>
<td>292</td>
</tr>
<tr>
<td>Rerunning the Configuration</td>
<td>293</td>
</tr>
<tr>
<td>Row Limit</td>
<td>293</td>
</tr>
<tr>
<td>Server Not Responding to Ping Command</td>
<td>294</td>
</tr>
<tr>
<td>Setting Folder Permissions Failed</td>
<td>294</td>
</tr>
<tr>
<td>Setting Up Permissions for CUIS SQL Server Login Failed</td>
<td>294</td>
</tr>
<tr>
<td>Troubleshooting Security</td>
<td>295</td>
</tr>
<tr>
<td>Windows Integrated Authentication or SQL Authentication</td>
<td>295</td>
</tr>
<tr>
<td>Troubleshooting Licenses</td>
<td>295</td>
</tr>
<tr>
<td>License Message at Login</td>
<td>295</td>
</tr>
<tr>
<td>License Message - Exceeded Number of Licensed Users</td>
<td>295</td>
</tr>
<tr>
<td>License URL</td>
<td>295</td>
</tr>
<tr>
<td>Windows Event Viewer License Information</td>
<td>295</td>
</tr>
<tr>
<td>Troubleshooting Login</td>
<td>296</td>
</tr>
<tr>
<td>Cannot Access Using IP Address</td>
<td>296</td>
</tr>
<tr>
<td>User Cannot Log In</td>
<td>297</td>
</tr>
<tr>
<td>Troubleshooting the User Interface</td>
<td>297</td>
</tr>
<tr>
<td>Dashboard Slide Show</td>
<td>297</td>
</tr>
<tr>
<td>New Values Not Being Saved</td>
<td>297</td>
</tr>
<tr>
<td>Stylesheet StaticGroup.css</td>
<td>297</td>
</tr>
<tr>
<td>Troubleshooting Reporting</td>
<td>298</td>
</tr>
<tr>
<td>Bypass Filter</td>
<td>298</td>
</tr>
<tr>
<td>Cloning Reports</td>
<td>298</td>
</tr>
<tr>
<td>Data Source Failover</td>
<td>298</td>
</tr>
<tr>
<td>Deleting Reports</td>
<td>298</td>
</tr>
<tr>
<td>Duplicate Collection Names</td>
<td>298</td>
</tr>
<tr>
<td>Dynamic Headers</td>
<td>299</td>
</tr>
<tr>
<td>Export to Excel Error</td>
<td>299</td>
</tr>
<tr>
<td>Importing Reports</td>
<td>299</td>
</tr>
<tr>
<td>Independent Subgroup Footer Formulas</td>
<td>300</td>
</tr>
<tr>
<td>Report Info Window Has Invalid Links</td>
<td>300</td>
</tr>
<tr>
<td>Saving Historical as Real Time or Real Time as Historical</td>
<td>300</td>
</tr>
<tr>
<td>Scheduled Reports</td>
<td>300</td>
</tr>
<tr>
<td>Simple Wizard Does Not Allow Moving Grouped Columns</td>
<td>301</td>
</tr>
<tr>
<td>SQL Block Support</td>
<td>301</td>
</tr>
<tr>
<td>Using Temp Tables in Stored Procedures and Anonymous Blocks</td>
<td>302</td>
</tr>
<tr>
<td>WHERE Clause Required in Query</td>
<td>303</td>
</tr>
<tr>
<td>Value List Items Deleted in Unified ICM Configuration Display in Unified IC</td>
<td>304</td>
</tr>
</tbody>
</table>

Index ........................................................................................................ 305
## List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Simple Deployment Model</td>
<td>10</td>
</tr>
<tr>
<td>2</td>
<td>Standard Deployment Model</td>
<td>11</td>
</tr>
<tr>
<td>3</td>
<td>Scaled Deployment</td>
<td>12</td>
</tr>
<tr>
<td>4</td>
<td>Authentication Model</td>
<td>14</td>
</tr>
<tr>
<td>5</td>
<td>User Information Window</td>
<td>15</td>
</tr>
<tr>
<td>6</td>
<td>Folders added by Installation</td>
<td>30</td>
</tr>
<tr>
<td>7</td>
<td>Local Users in a Standard Deployment</td>
<td>34</td>
</tr>
<tr>
<td>8</td>
<td>Domain Users in a Standard Deployment</td>
<td>35</td>
</tr>
<tr>
<td>9</td>
<td>Location of the Configuration Tool</td>
<td>36</td>
</tr>
<tr>
<td>10</td>
<td>Configuring Unified IC Database: Components Selection Window</td>
<td>38</td>
</tr>
<tr>
<td>11</td>
<td>Configuring Unified IC Database: User Information</td>
<td>38</td>
</tr>
<tr>
<td>12</td>
<td>Configuring Unified IC Database: Servers Information</td>
<td>39</td>
</tr>
<tr>
<td>13</td>
<td>The CuisLocalUserGroup</td>
<td>46</td>
</tr>
<tr>
<td>14</td>
<td>CUIS Website</td>
<td>46</td>
</tr>
<tr>
<td>15</td>
<td>Configuring Archiver: Product Selection</td>
<td>47</td>
</tr>
<tr>
<td>16</td>
<td>Archiver Database Tables</td>
<td>50</td>
</tr>
<tr>
<td>17</td>
<td>License Folder</td>
<td>51</td>
</tr>
<tr>
<td>18</td>
<td>Downloading a Maintenance Release</td>
<td>53</td>
</tr>
<tr>
<td>19</td>
<td>Logging In</td>
<td>56</td>
</tr>
<tr>
<td>20</td>
<td>Default Data Sources</td>
<td>56</td>
</tr>
<tr>
<td>21</td>
<td>Configuring Stock Value Lists 1 of 3</td>
<td>59</td>
</tr>
<tr>
<td>22</td>
<td>Configuring Stock Value Lists 2 of 3</td>
<td>59</td>
</tr>
<tr>
<td>23</td>
<td>Configuring Stock Value Lists 3 of 3</td>
<td>60</td>
</tr>
<tr>
<td>24</td>
<td>Importing Reports</td>
<td>61</td>
</tr>
<tr>
<td>25</td>
<td>Import Report Dialog Box</td>
<td>61</td>
</tr>
<tr>
<td>26</td>
<td>Verifying Import of Reports</td>
<td>62</td>
</tr>
<tr>
<td>27</td>
<td>Adding Users 1 of 2</td>
<td>63</td>
</tr>
<tr>
<td>28</td>
<td>Adding Users 2 of 2</td>
<td>63</td>
</tr>
<tr>
<td>29</td>
<td>Diagnostics Page 1 of 3</td>
<td>86</td>
</tr>
<tr>
<td>30</td>
<td>Diagnostics Page 2 of 3</td>
<td>86</td>
</tr>
<tr>
<td>31</td>
<td>Diagnostics Page 2 of 3</td>
<td>86</td>
</tr>
<tr>
<td>32</td>
<td>Dashboards</td>
<td>99</td>
</tr>
<tr>
<td>33</td>
<td>Historical Filter Panel</td>
<td>110</td>
</tr>
</tbody>
</table>
Figure 34: Thresholds.........................................................................................................................118
Figure 35: Field Added to Advanced Filter............................................................................................118
Figure 36: Filtering Hidden Fields........................................................................................................120
Figure 37: Error Messages Report 1 of 3..............................................................................................124
Figure 38: Error Messages Report 2 of 3..............................................................................................124
Figure 39: Error Messages Report 3 of 3..............................................................................................124
Figure 40: Report List..........................................................................................................................128
Figure 41: Report Context Menu..........................................................................................................128
Figure 42: Drilldowns..........................................................................................................................131
Figure 43: Drilldown Created................................................................................................................133
Figure 44: Schedule Menu..................................................................................................................138
Figure 45: Download a Maintenance Release......................................................................................144
Figure 46: Gauge....................................................................................................................................163
Figure 47: WebView Report with SuperHeader....................................................................................180
Figure 48: Unified IC Report with No Superheader.............................................................................180
Figure 49: Agent Historical All Fields report 1 of 3.............................................................................189
Figure 50: Agent Historical All Fields report 2 of 3.............................................................................189
Figure 51: Agent Historical All Fields report 3 of 3.............................................................................189
Figure 52: Agent Real Time All Fields (1 of 2)....................................................................................193
Figure 53: Agent Not Ready Detail Report............................................................................................196
Figure 54: Agent Team Historical Report 1 of 2..................................................................................201
Figure 55: Agent Team Historical Report 2 of 2..................................................................................201
Figure 56: Agent Real Time All Fields Report 1 of 2..........................................................................205
Figure 57: Agent Real Time All Fields Report 2 of 2..........................................................................205
Figure 58: Agent Team State Count Report 1....................................................................................209
Figure 59: Agent Team State Count Report 2....................................................................................209
Figure 60: Ans Aban Columns with Data............................................................................................212
Figure 61: Ans Aban Columns without Data.........................................................................................212
Figure 62: Call Type Abandon/Answer Distribution report 1 of 2.......................................................215
Figure 63: Call Type Abandon/Answer Distribution report 1 of 2.......................................................215
Figure 64: Call Type Historical All Fields 1 of 3..................................................................................221
Figure 65: Call Type Historical All Fields 2 of 3..................................................................................221
Figure 66: Call Type Historical All Fields 3 of 3..................................................................................221
Figure 67: Call Type Real Time All Fields Report 1 of 2.....................................................................225
Figure 68: Call Type Real Time All Fields Report 2 of 2.....................................................................225
Preface

Purpose

This guide explains Cisco Unified Intelligence Suite (Unified IS).

Unified IS includes Unified Intelligence Center, which is the new reporting platform for the Cisco Unified Contact Center environment.

With Unified IC, it is possible to generate reports from either the Unified ICM/CCE 7.5 or the Unified ICM/CCE 7.2 AW/HDS database.

Audience

This guide is intended for:

- Partners and system administrators who install and configure Unified IS.
- Reporting users, administrators, and developers who use the Cisco Unified Intelligence Center (Unified IC) web server to generate, manage, or modify reports for the Cisco Unified Contact Center products.

Organization

This guide is organized in six parts.

PART 1, Product Overview and Deployment (page 5) is intended for all Unified IS users.
PART 2, Installation and Configuration (page 21), is intended for partners and system administrators who install and configure Unified IS.

PART 3, Unified IS Administration (page 65), is intended for Unified IS Administrators and Security Administrators.

PART 4, The Cisco Unified IC Web Server (page 91) is intended for all Unified IC reporting users.

PART 5, Cisco Unified Unified IC Reporting (page 107) is intended for reporting users and report designers.

PART 6, Reporting Templates (page 181) documents the stock templates that are installed with Unified IC.

Part 7, Expert Advisor Templates (page 275), documents the seven Expert Advisor reports that you can run in this release, if you have downloaded them and set their data source.

Appendix A: Troubleshooting and FACS (page 289) contains tips and troubleshooting information relevant to installation and functionality.

Related Documentation

The following documentation supplements and complements this guide:


  This site is designed for customer collaboration and includes tips, utilities, and sample reports contributed by customers and partners. Enjoy this site and participate in it.

  **Note:** The information on this site has not been developed or tested by Cisco Systems and is not supported by your Cisco Support Provider.

- The Unified IC online help (available from the Unified IC web application interface)


• The customer-facing Troubleshooting tips, available to anyone with a Cisco User Name and Password: Troubleshooting Tips for Unified IS 7.5 (http://docwiki.cisco.com/wiki/Troubleshooting_Tips_for_Unified_IS_7.5)

**Conventions**

This manual uses the following conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface font</strong></td>
<td>Boldface font is used to indicate commands, such as user entries, keys, buttons, and folder and submenu names. For example:</td>
</tr>
<tr>
<td></td>
<td>• Choose <em>Edit &gt; Find</em>.</td>
</tr>
<tr>
<td></td>
<td>• Click <em>Finish</em>.</td>
</tr>
<tr>
<td><strong>italic font</strong></td>
<td>Italic font is used to indicate the following:</td>
</tr>
<tr>
<td></td>
<td>• To introduce a new term. Example: A <em>skill group</em> is a collection of agents who share similar skills.</td>
</tr>
<tr>
<td></td>
<td>• For emphasis. Example: <em>Do not</em> use the numerical naming convention.</td>
</tr>
<tr>
<td></td>
<td>• A syntax value that the user must replace. Example: IF <em>(condition, true-value, false-value)</em></td>
</tr>
<tr>
<td></td>
<td>• A book title. Example: See the <em>Cisco CRS Installation Guide</em>.</td>
</tr>
<tr>
<td><strong>window font</strong></td>
<td>Window font, such as Courier, is used for the following:</td>
</tr>
<tr>
<td></td>
<td>• Text as it appears in code or that the window displays. Example: <code>&lt;html&gt;&lt;title&gt;Cisco Systems, Inc. &lt;/title&gt;&lt;/html&gt;</code></td>
</tr>
<tr>
<td><code>&lt; &gt;</code></td>
<td>Angle brackets are used to indicate the following:</td>
</tr>
</tbody>
</table>
### Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, submitting a service request, and gathering additional information, see the monthly *What's New in Cisco Product Documentation*, which also lists all new and revised Cisco technical documentation, at:


Subscribe to the *What's New in Cisco Product Documentation* as a Really Simple Syndication (RSS) feed and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free service and Cisco currently supports RSS version 2.0.

### Documentation Feedback

You can provide comments about this document by sending email to the following address:

mailto:ccbu_docfeedback@cisco.com

We appreciate your comments.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>•</td>
<td>For arguments where the context does not allow italic, such as ASCII output.</td>
</tr>
<tr>
<td>•</td>
<td>A character string that the user enters but that does not appear on the window such as a password.</td>
</tr>
</tbody>
</table>
Part 1: Product Overview and Deployment

Part 1 contains:

Product Overview (page 7)
Deployment Models (page 9)
Unified IS Security (page 13)
Databases Used by Unified IS (page 17)
Chapter 1

Product Overview

About Cisco Unified Intelligence Suite

Cisco Unified Intelligence Suite (Unified IS) is a web-based reporting platform for the Cisco Unified Communication products and can be used with Releases 7.5 and 7.2 of Cisco Unified Intelligent Contact Management Enterprise and Hosted editions.

Currently, Unified ICM/CCE/CCH support both the Unified IS and the WebView reporting applications. In a future release, Unified IS will replace WebView1.

Unified IS consists of two components: the Unified Intelligence Center (Unified IC) and the Archiver. Each component requires a separate and dedicated server.

• **Unified Intelligence Center (Unified IC)** is the user interface for reporting. The Unified IC component, in turn, has two sub-components—a database and a web server.

  **Unified IC:**

  – Is installed with stock Cisco reporting templates and with tools for modifying those templates.

  – Is the interface for creating and maintaining users and user groups.

  – Has a Unified IC database that stores metadata and configuration settings and provides the data that is displayed in Error Reports.

  Depending on the deployment model, this database can be configured to reside on the Unified IC server or on the Archiver server.

  – Can be deployed with or without the Archiver. See Deployment Models (page 9).

1) WebView is the legacy reporting application that is currently provided with each installation of Cisco Unified Intelligence Contact Management and Cisco Unified Contact Center.
• **The Archiver** is an MS SQL Server data repository. It contains a normalized data schema and a set of stored procedures that pull data from defined data sources for use in reporting. The Archiver is configured to pull data from the Unified ICM AW/HDS.

Archiver is an optional component. Unified Intelligence Center may be deployed without it to provide reporting directly from existing databases. Archiver should be deployed if it is desired to execute custom consolidation of data prior to reporting on it. For example data could be extracted from AW/HDS and from a Workforce Management System to create a single record with data from both. Archiver can also be used to compress data; for example to create a custom daily record from 48 half-hour records.

Cisco supports three deployment models for Unified IS: Simple Deployment (page 9), Standard Deployment (page 10), and Scaled Deployment. (page 11)

Simple Deployment

In the simple deployment model, the Unified IC web server application and the Unified IC database are installed and configured on a single, dedicated Unified IC server that meets the specifications defined in the Hardware & System Software Specification (Bill of Materials) for Unified ICM/CCE and the The Cisco Unified Intelligence Suite 7.5(x) Bill of Materials. A simple deployment has no Archiver server.

Unified IC is configured to connect to the Unified ICM/CCE Admin Workstation that houses the AW database (_awdb) and the Historical Data Server (_hds). The AW is the data source for real time reports. The HDS is the data source for historical reports.
A simple deployment provides up-to-date reporting information and is more economical than a standard deployment in terms of server and SQL Server requirements.

A simple deployment is not recommended when a large number of reports are generated or when older data is needed and if HDS data on the Unified ICM/CCE Admin Workstation is purged frequently because of space considerations.

**Standard Deployment**

In the standard deployment model, the Unified IC connects to the Unified ICM/CCE Admin Workstation (AW) and to the databases on the Unified IS Archiver.

All Unified IS databases—the Unified IC database and the Archiver databases—are configured on the Archiver server. Microsoft SQL Server is installed on the Archiver server.

As in the simple deployment model, Unified IC builds real time reports directly from the AW database on the Admin Workstation.

By default, in this release, Unified IC also builds most historical reports directly from the HDS.

One exception is the Call Type Daily All Fields Report (page 125), which is installed with Unified IC to this path: %CUIS_HOME%\CuisWeb\ArchiverReports. Data from the Archiver populates the Call Type Daily All Fields report template.

By adding the Archiver as a Data Source in the Unified IC web application and by working with the Report Wizard functionality in the Unified IC interface, you can clone ("save as") the Call Type Daily All Fields report template and create other reporting templates that use the Archiver databases.
The Archiver connects to AW database (_awdb) which has views into the HDS database (_hds).

It is the responsibility of the Archiver to collect and aggregate historical data from the Unified ICM/CCE Admin Workstation. Unified IC queries are run against the historical data that the Archiver has extracted from the AW database and are not run against the AW database directly.

Building historical reports from the Archiver instead of forcing the database on the Admin Workstation to perform potentially complex queries on-demand removes some performance load and provides an environment for reporting on historical and aggregated data.

Since the Archiver collects data periodically, by default once per day, reports might not provide the most up-to-date information. However, the Archiver can retain the data for longer periods of time than the HDS. You can configure how long Archiver retains data and what level of granularity is captured.

**Scaled Deployment**

The scaled deployment is a variation of the standard deployment.

In a scaled deployment, there is one Archiver server and there can be multiple Unified IC servers—each with its own Unified IC database.

The Unified IC servers can share SQL DataServer with the Archiver database, but they must have their own Unified IC databases.

You can deploy a maximum of two Unified IC servers per AW/HDS, supporting up to a maximum of 200 Cisco Profiled Reporting User. This allows headroom for other historical reports to be run against the Archiver Database.
Cisco supports a maximum of four AW/HDSs, two on each Logger (Side A and Side B). The number of combined concurrent Cisco profiled reporting users should not exceed 200 per AW/HDS (or 800 for the Unified ICM/CCE/CCH System).

*Figure 3: Scaled Deployment*
Chapter 3

Understanding Unified IS Security

This chapter contains the following topics:

- Unified IS Security Model, page 13
- Security and Data Access, page 14
- Passwords, page 16

Unified IS Security Model

Unified IS uses a trusted security model as outlined below:

**Trusted Subsystem Model**

- Web server authorizes users (must be Windows users).
- No Form Based Login.
- Database trusts the web server.

**IIS Scheduler Service - Trusted Service**

- Identity IIS run by a domain or local account (Pre-requisite)
- Dedicated Application Pool

**Windows Integrated Authentication/SQL Authentication**

- Windows integrated authentication: No password needed
- SQL authentication: Password encrypted
Security and Data Access

Security and Data Access

This chapter explains the security requirements in place for Unified IS and the credentials that you must set up so that Unified IC and the Archiver can access data sources for reports.

Successful database access is critical to the Unified IS.

The configurations for Unified IC database, Unified IC server, and the Archiver all require you to specify a User name and password on a User Verification window, similar to this:
These user credentials must be set up to access the Unified IC database, the Archiver database, and the AW/HDS databases on the Unified ICM/CCE Admin Workstation.

Unified IS solution will implement the different mechanisms to access different database sources.

To comply with Cisco security baseline guidelines and to work consistently with Unified ICM/CCE version 7.5, the Windows integration authentication will be the default authentication method used by both Unified IC and Archiver.

For downward compatibility reasons, Unified IC and Archiver is also able to connect to the Release 7.2 version of Unified ICM/CCE databases. For this reason, using SQL authentication to access remote SQL databases is also supported. You specify the type of authentication when you configure the remote database connections.

## Encryption

Unified IS servers encrypt recoverable database credentials using the Advanced Encryption Standard (AES) algorithm. AES, also known as Rijndael, is a block cipher used as an encryption standard by the US government.

All the recoverable passwords stored use the same key and initial vector string for encryption and decryption. The key phrase and initial vector string are provided by users during the Unified IC Web Server configuration (page 40) and are themselves encrypted and stored in the web configuration file as special connection strings.

The key used to encrypt and decrypt the user provided key phrase and initial vector is a unique machine GUID created by Microsoft and stored in the Windows registry. The initial vector is a predefined byte array. In addition, the web configuration file itself acts as the security key store for Unified applications is protected by .NET security mechanism so that the connection string section is encrypted.

The IV (initial vector) string and the Key string are not auto-generated. Cisco suggests that you record and save them. That way, in the event of an emergency, your support provider can contact Cisco to have all passwords in the configuration file decrypted.
Security Hardening

During Archiver Configuration, security hardening is applied to SQL Server.

The following unnecessary services are disabled, if they were installed: MSSQLServerADHelper, SQLWriter, and SQLBrowser.

Hardening can be rolled back, by running `cuissqlsecurity.pl ROLLBACK`.

Synching with the Time Server

One Security best practice is to synchronize server time with an external time source. Common time sources can be domain services or a dedicated Windows time server.

Unified IS databases reside on a Microsoft Windows platform and should follow the time server practices of the enterprise.

Passwords

Unified IS enforces strong passwords.

A password must:

• Be at least seven characters long

• Contain at least one character from three of the following four groups:
  – Uppercase letters
  – Lowercase letters
  – Numerals
  – Symbols

• Have no character that repeats more than three times consecutively.

• Not repeat or reverse the user name.

• Not be a variant of the word 'cisco'.

Databases Used by Unified IS

This chapter contains the following topics:

- The Unified IC Database, page 17
- The Unified ICM/CCE Admin Workstation Databases (AW/HDS), page 17
- The Archiver Database, page 19
- Database Backups, page 19

The Unified IC Database

Unified IC stores reporting configuration information and metadata in its own database. The Unified IC database is also the source of data for Error Reports (page 122).

In a simple deployment, the Unified IC database is configured to be located on the Unified IC server.

In standard and scaled deployments, the Unified IC database is typically configured to be located on the Archiver server, eliminating the need to install SQL Server on both the Unified IC and Archiver machines.

The Unified IC database schema is not exposed in this document.

The Unified ICM/CCE Admin Workstation Databases (AW/HDS)

There are two databases on the Unified ICM/CC Admin Workstation that populate Unified IC reports.

It is recommended that you dedicate an Admin Workstation for Unified IC.
It is possible to share the AW and the HDS as a source of data for both WebView and Unified IC if you do not exceed the maximum number of combined Unified IC and WebView users - which is 200.

You define the both the AW and the HDS as the data source for reports in the Data Sources (page 87) window in the Unified IC web application.

You configure the Archiver to point to the Admin Workstation machine as a Linked Server. See (page 48).

The AW Database

The Admin Workstation (AW) database is a data repository for real time data (forwarded by the Router).

The AW database also has views into the HDS.

About Real Time Data

In real-time, each Peripheral Gateway passes current status information to Unified ICM software. This current (real-time) data, which is kept in the Router’s memory, includes data about agents, skill groups, services, Call Types, trunk groups, and other entities.

Every 15 seconds (by default), the Router forwards the current (in-memory) data to the Distributor Admin Workstation, where it is stored in a number of real-time tables in the local AW databases. Old real-time data is constantly overwritten by new real-time data.

Real-time data is stored in tables in data fields that reflect four time increments, as described below.

- **Half**

  Half values contain a value for the current half-hour. The current half-hour is defined as the time period falling between xx:00:00 and xx:29:59, or xx:30:00 and xx:59:59. When a new half-hour begins, at time (xx:00:00 or xx:30:00), the database element is reset to zero.

- **Now**

  Now contains a snapshot of the activity at a particular instant (the last check).

- **To 5**

  The To5 values track data on a rolling five-minute basis. The rolling five-minute data employs a “sliding” five-minute window. The To5 data is updated every three seconds. When the oldest To5 three-second interval expires, a new three-second interval is added. In this manner, the window is always placed on the current five-minute interval.

- **Today**

  To arrive at values for Today, Unified ICM software adds the values at the end of each half-hour interval since midnight. It also counts the values for the current half-hour. At the
end of each half hour, half-hour data (for example CallsOfferedHalf) is summed into the Today data. At midnight, the real-time Today count is cleared in the database. Midnight is defined using the time of the peripheral.

The Unified ICM Historical Data Server (HDS)

The Historical Data Server (HDS) is required for historical reports. It contains only historical data and call detail data forwarded from the Logger.

This historical data is not accessed directly, but rather through views that exist in the AW database. To retrieve information for historical reports, Unified IC connects to the Admin Workstation where the HDS resides.

About Half Hour Data

Unified ICM software stores historical information in half-hour summaries. The CallRouter sends these records to the Logger, which in turn writes them to the Central Database.

A process on the Logger replicates its database tables to corresponding Half_Hour database tables on the Historical Data Server. These replicated HDS records are used for WebView historical reporting.

Half-hour data is populated in the database only for completed half-hour intervals. The historical data fields are stored in the database with the extension "ToHalf" (for example, Skill_Group_Half_Hour.CallsHandledToHalf).

These elements contain a value for a completed half-hour interval. The completed half-hour interval is the time period falling between xx:00:00 and xx:29:59, or xx:30:00 and xx:59:59.

The Archiver Database

The Archiver provides a location for customers to integrate their data into a data warehouse.

The Archiver database is published as two separate databases.

One database holds the common tables and Archiver management objects. The second database stores the Cisco extended data.

For details and the Archiver schema tables, see the Cisco Unified Intelligence Suite Archiver User Guide.

Archiver also has its own data sources, such as Unified ICM/CCE Admin Workstation.

Database Backups

The Cisco processes do not perform database backups.
It is the responsibility of the customer to maintain the health of the databases and to ensure that proper backup and recovery processes are in place.

It is highly recommended that you schedule regular backups of the Unified IC and Archiver databases using the Microsoft SQL Server backup tools or other 3rd party product.

Do not store backups on the Unified IC or the Archiver servers.

Backups should be scheduled so that they do not interfere with the table load processes and should use external backup devices (tape or network drive).

Cisco assumes no responsibility for data loss resulting from issues with backups. Data loss might occur if the backing up of files is not managed appropriately.
Part 2: Installation and Configuration

Chapters in Part 2 document:

Installation/Configuration Checklists (page 23)

Installation (page 28)

Creating Internal Users (page 32)

Configuring the Unified IC Database (page 37)

Configuring the Intelligence Web Server (page 40)

Configuring the Archiver (page 46)

Licensing (page 50)

Upgrading to a Maintenance Release (page 52)

Initial Actions for the Administrator after Installation and Configuration (page 55)

See also Troubleshooting Configuration (page 290).
Chapter 5

Installation and Configuration

Installation and Configuration are separate processes with different prerequisites.

You must install Unified IS before you configure its components.

This chapter contains the following topics:

- Checklist for a Simple Deployment, page 23
- Checklist for a Standard or Scaled Deployment, page 25
- Installation, page 28
- Internal Users, page 32
- Configuration, page 35
- Licensing, page 50
- Upgrading to a Maintenance Release, page 52

Checklist for a Simple Deployment

These checklist tables list the tasks to perform for a simple deployment—when both the Unified IC web server and the Unified IC database are on one machine.

The tables list the required software but do not specify the versions and service packs. For current software versions and updates, refer to the Hardware & System Software Specification (Bill of Materials) for Unified ICM/CCE and the The Cisco Unified Intelligence Suite 7.5(x) Bill of Materials.

<table>
<thead>
<tr>
<th>Before the Installation</th>
<th>Required for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ensure access to a Unified ICM/CCE Admin Workstation with an AW/HDS.</td>
<td>Data source for reports</td>
</tr>
<tr>
<td>Ensure the Unified IC server meets Cisco hardware requirements.</td>
<td>Installation</td>
</tr>
<tr>
<td>Install the Microsoft Windows Standard Edition operating system on the Unified IC server.</td>
<td>Installation</td>
</tr>
</tbody>
</table>
### Checklist for a Simple Deployment

#### Before the Installation

<table>
<thead>
<tr>
<th>Required for:</th>
<th>Required for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note: If you intend to use Korean, Chinese, Japanese, or Russian templates, install on a localized server or an English Window server with the MUI language pack applied. See Localization. (page 93)</td>
<td>Configuration tool and web application</td>
</tr>
<tr>
<td>Install the Microsoft .NET Framework on the Unified IC server.</td>
<td>Web application</td>
</tr>
<tr>
<td>Enable Microsoft Internet Information Services on the Unified IC server.</td>
<td>Export to Excel functionality</td>
</tr>
</tbody>
</table>

#### Installation

<table>
<thead>
<tr>
<th>Required for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install Unified IC on the Unified IC server. See Installing Unified IS (page 29).</td>
</tr>
</tbody>
</table>

#### Before Configuration

<table>
<thead>
<tr>
<th>Required for:</th>
<th>Required for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install Microsoft SQL Server Database Engine and Workstation Components. Select Latin1_General_BIN collation. Note: If you intend to use Russian, Korean, Japanese, or Chinese templates, see Localization. (page 93) In Components to Install, select all. On Service Account screen, select to start SQL Server Agent. Verify that TCP/IP connectivity is enabled.</td>
<td>Hosting the Unified IC database</td>
</tr>
<tr>
<td>If the Unified IC server and the Unified ICM/CCE Admin Workstation (AW/HDS) are in the same domain: • Create a Windows domain user for the Unified IC User. • On the Unified ICM/CCE Admin Workstation, use SQL Server Management Studio to add the Windows domain Unified IC User as a new security login and set with db_datareader access to the AW and HDS databases. See Internal Users (page 32).</td>
<td>Configuration</td>
</tr>
<tr>
<td>If the Unified IC server and the Unified ICM/CCE Admin Workstation (AW/HDS) are not in the same domain: • Create a Windows local user account for the Unified IC User on the Unified IC server. • Create a Windows local user account for the Unified IC User on the United ICM Admin workstation.</td>
<td>Configuration</td>
</tr>
</tbody>
</table>
Checklist for a Standard or Scaled Deployment

These checklist tables list the set up procedures for standard and scaled deployments. In these deployments, the Unified IC web application is on the Unified IC server(s). The Unified IC database(s) and the Archiver are on the Archiver server.

The tables list the required software but not the current versions and service packs. For current software versions and updates, refer to the Hardware & System Software Specification (Bill of Materials) for Unified ICM/CCE and the The Cisco Unified Intelligence Suite 7.5(x) Bill of Materials.

### Before Installation

<table>
<thead>
<tr>
<th>Steps</th>
<th>Required for</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ensure access to a Unified ICM/CCE Admin Workstation with an AW/HDS.</td>
<td>Data source for reports</td>
</tr>
<tr>
<td>Ensure the Unified IC server(s) and the Archiver server meet Cisco hardware requirements.</td>
<td>Installation</td>
</tr>
</tbody>
</table>

### Checklist for a Standard or Scaled Deployment

**Before the Installation**

<table>
<thead>
<tr>
<th>Task</th>
<th>Required for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install the Microsoft Windows Standard Edition operating system on all servers.</td>
<td>Installation</td>
</tr>
<tr>
<td><strong>Note:</strong> If you intend to use Korean, Chinese, Japanese, or Russian templates, install on a localized server or an English Window server with the MUI language pack applied. See <a href="#">Localization</a>.</td>
<td></td>
</tr>
<tr>
<td>Note that the Unified IC server and the Archiver server require different editions. Refer to <em>The Cisco Unified Intelligence Suite 7.5(x) Bill of Materials</em> for details.</td>
<td></td>
</tr>
<tr>
<td>Install the Microsoft .NET Framework on all servers.</td>
<td>Configuration tool and web application</td>
</tr>
<tr>
<td>Enable Microsoft Internet Information Services on the Unified IC Web Server.</td>
<td>Web application</td>
</tr>
<tr>
<td>Ensure access to Microsoft Excel on the system from which the web browser is launched</td>
<td>Export to Excel functionality</td>
</tr>
</tbody>
</table>

**Installation**

<table>
<thead>
<tr>
<th>Task</th>
<th>Required for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install Unified IC on the Unified IC servers and the Archiver server.</td>
<td>Configuration</td>
</tr>
<tr>
<td>See <a href="#">Installing Unified IS</a> (page 29).</td>
<td></td>
</tr>
</tbody>
</table>

**Before Configuration**

<table>
<thead>
<tr>
<th>Task</th>
<th>Required for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install Microsoft SQL Server Database Engine and Workstation Components. Select Latin1_General_BIN collation.</td>
<td>Hosting the Unified IC database</td>
</tr>
<tr>
<td><strong>Note:</strong> If you intend to use Russian, Korean, Japanese, or Chinese templates, see <a href="#">Localization</a>.</td>
<td></td>
</tr>
<tr>
<td>In Components to Install, select all.</td>
<td></td>
</tr>
<tr>
<td>On Service Account screen, select to start SQL Server Agent.</td>
<td></td>
</tr>
<tr>
<td>Verify that TCP/IP connectivity is enabled.</td>
<td></td>
</tr>
<tr>
<td>If the Unified IC servers, the Archiver server, and the Unified ICM/CCE Admin Workstation (AW/HDS) are in the same domain:</td>
<td>Configuration</td>
</tr>
<tr>
<td>• Create a Windows domain user for the Unified IC User.</td>
<td></td>
</tr>
<tr>
<td>• Create a Windows domain user for the Archiver User.</td>
<td></td>
</tr>
<tr>
<td>• On the Archiver server, use SQL Server Management Studio to add the Windows domain Unified IC User as a new security login and set with db_datareader access to the three Archiver databases.</td>
<td></td>
</tr>
<tr>
<td>• On the Unified ICM/CCE Admin Workstation, use SQL Server Management Studio to add the Windows domain Unified IC User as a new security login and set with db_datareader access to the AW and HDS databases.</td>
<td></td>
</tr>
</tbody>
</table>
### Before Configuration

<table>
<thead>
<tr>
<th>Required for</th>
<th>Required for</th>
</tr>
</thead>
<tbody>
<tr>
<td>• On the Unified ICM/CCE Admin Workstation, use SQL Server Management Studio to add the Windows domain Archiver User as a new security login and set with db_datareader access to the AW and HDS databases.</td>
<td>Configuration</td>
</tr>
<tr>
<td><strong>See Internal Users (page 32).</strong></td>
<td></td>
</tr>
<tr>
<td>If the Unified IC server, the Archiver server, and the Unified ICM/CCE Admin Workstation (AW/HDS) are not in the same domain:</td>
<td></td>
</tr>
<tr>
<td>• Create a Windows local user account for the Unified IC User on the Unified IC server(s) and the Archiver server.</td>
<td></td>
</tr>
<tr>
<td>• Create a Windows local user account for the Archiver on the Archiver server.</td>
<td></td>
</tr>
<tr>
<td>• On the Archiver server, use SQL Server Management Studio to add the Windows local Unified IC User as a new security login and set with db_datareader access to the three Archiver databases.</td>
<td></td>
</tr>
<tr>
<td>• Create a Windows local user account for the Unified IC User on the United ICM Admin workstation.</td>
<td></td>
</tr>
<tr>
<td>On the Unified ICM/CCE Admin Workstation, use SQL Server Management Studio to add the Windows local Unified IC User as a new security login and set with db_datareader access to the AW and HDS databases.</td>
<td></td>
</tr>
<tr>
<td>• Create a Windows local user account for the Archiver User on the United ICM Admin workstation.</td>
<td></td>
</tr>
<tr>
<td>On the Unified ICM/CCE Admin Workstation, use SQL Server Management Studio to add the Windows local Archiver User as a new security login and set with db_datareader access to the AW and HDS databases.</td>
<td></td>
</tr>
<tr>
<td><strong>See Internal Users (page 32).</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Download the Microsoft Visual C++ 2005 SP1 Redistributable Package</strong></td>
<td>Reading the license.</td>
</tr>
</tbody>
</table>

### Configuration

<table>
<thead>
<tr>
<th>Required for</th>
<th>Required for</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Configure the Unified IC database(s) on the Archiver server.</strong></td>
<td>Creating the Unified IC database</td>
</tr>
<tr>
<td><strong>See Configuring the Unified IC Database (page 37).</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Configure the Unified IC Web Server on the Unified IC server(s).</strong></td>
<td>Creating the web server.</td>
</tr>
<tr>
<td><strong>See Configuring the Intelligence Web Server (page 40).</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Configure the Archiver on the Archiver server.</strong></td>
<td>Creating the Archiver databases</td>
</tr>
<tr>
<td><strong>See Configuring the Archiver (page 46).</strong></td>
<td></td>
</tr>
</tbody>
</table>

---

### After Configuration

<table>
<thead>
<tr>
<th>Action</th>
<th>Required for</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Windows user accounts to the web server user group: CUISLocalUserGroup.</td>
<td>User logins</td>
</tr>
<tr>
<td>See Adding Unified IC Users (page 62).</td>
<td></td>
</tr>
<tr>
<td>Obtain your license and copy it to server.</td>
<td>Running the web application</td>
</tr>
<tr>
<td>See Licensing (page 50).</td>
<td></td>
</tr>
<tr>
<td>Open the browser and log in using the local administrator account.</td>
<td>Installing stock report templates and value lists; assigning user roles and creating user groups.</td>
</tr>
<tr>
<td>See Logging In (page 55).</td>
<td></td>
</tr>
</tbody>
</table>

### Installation

The installation copies all files to the server on which you perform the installation.

For Unified IS, the installation simply lays down install files. The configuration tool completes the setup and installs the databases.

The installation for Unified Intelligence Center (Unified IC) is identical to the installation for the Archiver.

What distinguishes the server on which you perform the installation as an Archiver (and not a Unified IC) server are:

- The configuration tool that you run
- The server hardware requirements

Installation and Configuration are separate processes with different prerequisites.

You must install Unified IS before you configure its components.

**Note:** Cisco Security Agent is not installed with this release of Unified IS.

### Installation Prerequisites

Before you proceed with the installation, consider the following requirements and recommendations:

- **Hardware and Software**

  The servers on which you install the Unified IC and the Archiver must comply with the hardware and software specifications outlined in the *The Cisco Unified Intelligence Suite 7.5(x) Bill of Materials* and the *Hardware & System Software Specification (Bill of Materials) for Unified ICM/CCE*.
• **Installation by Admin**

    The Unified IS installer must be run by a user with Administrator credentials.

• **Remove or rename previous install files**

    Unified IS cannot be installed to directories where it was previously installed if data exists in those directories. See Uninstalling / Reinstalling Unified IS (page 30).

• **Required disk space**

    The servers on which you install Unified IC and the Archiver must have sufficient free space, as documented in the The Cisco Unified Intelligence Suite 7.5(x) Bill of Materials and the Hardware & System Software Specification (Bill of Materials) for Unified ICM/CCE.

### Installing Unified IS

For a simple deployment, perform the installation once on the Unified IC server.

For standard and scaled deployments, install the software once on each Unified IC server and once on the Archiver server.

The installation is a simple InstallShield wizard that copies all files. Most windows have a **Back** button. Installation takes a maximum of ten minutes.

**Step 1**

Insert the installation DVD into the tray.

The installation checks for the following prerequisites and displays messages if they are not met:

• The user has Administrator credentials.

• The supported Microsoft Windows operating system is installed.

• Microsoft .NET is installed.

• Unified IC is not already installed on the server.

**Step 2**

Select the Install option.

This launches the installer. You see a splash screen, a preparation screen, and then the Welcome window.

**Step 3**

Click **Next** at the Welcome window to display the Copyrights window.

**Step 4**

Click **Next** at the Copyrights window to open the License window.

**Step 5**

At the License window:
a. Select the button for *I accept the terms of the license agreement*.

b. Click **Print** if you want a printout of the license.

c. Click **Next** to open the Choose Destination Location window.

### Step 6

At the Choose Destination Location window,

a. Accept the default location, `\%CUIS_HOME\%`, or click **Change** to locate and select another location. You can install to any directory as long as that directory does not already contain data and the directory name ends with `Cisco\CUIS`.

b. Click **Next** to open the Ready to Install the Program window, where you have the option to go Back, to Cancel, or to Install.

### Step 7

Click **Install** to proceed with the installation.

A progress bar indicates the progression as files are copied to your machine. When the installation is complete, an Installation Complete window displays.

### Step 8

Click **Finish** at the Installation Complete window.

Verify that the Windows Explorer shows new folders similar to this:

*Figure 6: Folders added by Installation*

```
- Cisco
  - CUIS
    - bin
    - conf
      - CuisScheduler
    - CuisSqlScripts
    - CuisWeb
      - license
      - logs
    - perl
      - resource
  - CiscoUtils
    - SQLSecurity
```

### Uninstalling / Reinstalling Unified IS

To uninstall Unified IS, use either of these two methods:

1. **From the Control Panel:**
   1. Go to **Start > Settings > Control Panel > Add or Remove Programs**.
   2. Locate CUIS and click **Remove**.
(2) From the DVD:

1. Insert the Unified IS Installation DVD.

2. Locate and double-click the `setup.exe` file.

   This opens a Modify, Repair, Remove window.

   The Modification and Repair options are not supported in this release.

3. Click Remove.

The uninstallation removes all files that the installer copied to the machine.

*It does not remove* any files that were added or modified outside of the scope of the installation. For example, the uninstall does not remove any log files that were created in `%CUIS_HOME%\logs` after the initial installation.

Before you reinstall the software, you must back up, move, or delete any files that the uninstaller did not remove. A fresh installation requires an empty `\Cisco\CUI` directory.

Install and Uninstall Logs

The installation process creates a log file containing version, date and time of install, warning and error information, the list of components and/or packages installed, packages uninstalled, and other helpful informational messages.

There is one log for both install and uninstall events. It is saved to the `c:\temp` directory as `CiscoUnifiedCUIInstall.log`.

Disabling the usage of extra memory (Applicable only for systems that has a memory of more than 16 GB)

During the installation of the Archiver, the installation program adds a `/3Gb` and `/PAE` entry in the `boot.ini` to allow the SQL server instance to access and make use of the extra memory installed on the system. However, the `/3Gb` switch is not recommended for systems with more than 16 GB of memory and this should be manually removed from the `boot.ini` file.

Perform the following steps after the Archiver installation is completed successfully.

1. Right-click **My Computer** and select **Properties**. The **System Properties** dialog box appears.

2. Click the **Advanced** tab.

3. In the Startup and Recovery area, click **Settings**. The **Startup and Recovery** dialog box appears.

4. In the System startup area, click **Edit**. The system opens the Windows `boot.ini` file in a text editor.
5. Find the word `/3Gb` in the same startup line that includes the `/fastdetect` switch and delete it.

6. Save the changes and close the `boot.ini` file.

7. Click **OK** to close all the open dialog boxes, and then restart the computer for the changes to take effect.

## Internal Users

Depending on the deployment model, you must create one or two internal Windows users. These are service accounts with special privileges.

Do not use the user names and passwords of these internal users to run the Configuration Tool or to log in to Unified IC and run reports.

**The Unified IC User:**

- Runs the reporting Scheduler service.
- Runs the Unified IC web server.
- Accesses the Unified IC database and the real time data in the AW database on the Unified ICM/CCE Admin Workstation.
- Accesses the three Archiver databases.

**The Archiver User** accesses the historical data in the HDS on the Unified ICM/CCE Admin Workstation and runs SQL Server Agent jobs such as scheduled loads.

Because you specify these users during the configuration, and the configuration tool verifies them, you need to create them **before you perform the configurations**.

**Note:** The Configuration Tool does not administer remote servers. The Unified ICM DBA is responsible for setting up the Unified ICM databases for access by the Unified IC User and the Archiver User.

## Internal User Properties

You can create any user name you like, but it must comply with your network security and must have a strong password. See **Passwords (page 16)**.

Uncheck **User must change password at next login** and check **Password never expires**.
Domain or Local?

**Domain or Local Users:** If all three servers are in the same domain, these internal users can be Domain users. If the servers are not in the same domain, they must be Local Users. Unified IS does not support machines in different (separate) domains.

The Unified IC User in a Simple Environment

In a simple deployment, create Local or Domain Internal Unified IC users to allow the Unified IC web server to read and write to its own database and to read the AW/HDS databases for reports.

**Create Local Users as follows:**

- Create the Local User on the Unified IC server.
- Create the Local User on Unified ICM/CCE Admin Workstation server with the *exact same user name and password*.
- On the Unified ICM/CCE Admin Workstation, using SQL Server Management Studio, add this Local User to the two Unified ICM database instances (_awdb and _hds) as a new security login with read-only permission.

**Create a Domain User as follows:**

- Create the Domain User.
- On the Unified ICM/CCE Admin Workstation, using SQL Server Management Studio, add this Domain User to the two Unified ICM database instances (_awdb and _hds) as a new security login with read-only permission.

The Unified IC User and Archiver User in a Standard or Scaled Environment

In a standard or scaled deployment, create Local or Domain Internal Unified IC users and Local or Domain Archiver Users to allow the Unified IC web server to read and write to its own database, to read the Archiver database, and to read the AW/HDS databases for reports.

Archiver User should be mapped to both _awdb and _historical databases.

**Create Local Users as follows:**

- Create the Local Unified IC User on the Unified IC server.
- Create the Local Unified IC User on the Archiver server *exact same user name and password*.
- On the Archiver server, using SQL Server Management Studio, add this Local Unified IC User *to all three Archiver databases* as a new security login with read-only permission.
• Create the Local Unified IC User on Unified ICM/CCE Admin Workstation with the *exact same user name and password*.

On the Unified ICM/CCE server, using SQL Server Management Studio, add this Local Unified IC User to both the _awdb and _hds databases as a new security login with read-only permission.

• Create the Local Archiver User on the Archiver server.

• Create the Local Archiver User on Unified ICM/CCE Admin Workstation with the *exact same user name and password* as the Archiver User on the Archiver server.

On the Unified ICM/CCE Admin Workstation, using SQL Server Management Studio, add this Local Archiver user to both the _awdb and _hds databases as a new security login with read-only permission.

• The Archiver configuration tool expects that the ArchiverUser will run SQL services such as scheduled events.

If your organization mandates that a prescribed user must run SQL services such as scheduled events, then it is necessary to add the customer-specifed user that runs the scheduler to the Unified ICM DB as a user with read-only access.

*Figure 7: Local Users in a Standard Deployment*

Create a Domain User as follows:

• Create the Unified IC Domain User.
- Create the Archiver Domain User.

- On the Archiver server, using SQL Server Management Studio, add this Domain Unified IC User to all three Archiver databases as a new security login with read-only permission.

- On the Unified ICM/CCE Admin Workstation, using SQL Server Management Studio, add this Domain Unified IC User to both the _awdb and _hds databases as a new security login with read-only permission.

- On the Unified ICM/CCE Admin Workstation, using SQL Server Management Studio, add this Domain Archiver user to both the _awdb and _hds databases as a new security login with read-only permission.

Figure 8: Domain Users in a Standard Deployment

The Configuration Tool is a free-standing application that is installed with Unified IC. It is located in the %CUIS_HOME%/bin/CuisConfigTool directory.
You use this tool to perform two (or three) separate configurations, depending on your deployment model.

For a simple deployment, on the Unified IC server, you configure, in this sequence:

- The Unified IC Intelligence Database (page 37)
- The Unified IC Web Server (page 40)

For standard and scaled deployments, you configure, in this sequence:

- The Unified IC Intelligence Database(s) (page 37) on the Archiver server
- The Unified IC Web Server(s) (page 40) on the Unified IC server
- The Archiver (page 46) on the Archiver server

See also Troubleshooting Configuration (page 290).

Configuration Prerequisites

Before you proceed with the configurations, consider the following requirements and recommendations:

- **Hardware and Software**

  The servers on which you configure the Unified IC database, the Unified IC web server, and the Archiver must comply with the hardware and software specifications outlined in the *Cisco Unified Intelligence Suite 7.5(x) Bill of Materials*.

- **Unified IC and Archiver Users created**

  Before you can proceed with the configuration of the Unified IC database, you must create a Windows local or domain user for Unified IC.
Before you can proceed with the configuration of the Archiver database, you must create a Windows local or domain user for Archiver.

See Internal Users (page 32).

- **Configuration by Admin with SQL Server Permission**

  The Configuration Tool must be run by a user with Administrator credentials.

  This user must also have administrative privileges in SQL Server and be mapped to SQL Server as a 'sysadmin' login.

  **Note:** Do not log in with the User ID/Password of the Windows local or domain Unified IC User or Archiver User to run the Configuration Tool.

- **Required disk space**

  The Configuration Tool verifies the available disk space before a configuration can proceed. Refer to the *The Cisco Unified Intelligence Suite 7.5(x) Bill of Materials* and the *Hardware & System Software Specification (Bill of Materials) for Unified ICM/CCE* for sizing requirements.

- **Configuration Tool**

  The configuration tool determines if CUIC web or database configuration options should be disabled or enabled. When all the configuration options for the Archiver and CUIC are disabled, the system displays the reason why they are disabled on the screen.

  However, if only a particular option/s are disabled, the system does not display the reasons for this action on the screen. You must open the log file to view the failed requirements that resulted in disabling these options.

- **Archiver Database Sizing**

  Archiver configuration requires you to select the size of the Archiver database: Small or Large. Refer to the *The Cisco Unified Intelligence Suite 7.5(x) Bill of Materials* and the *Hardware & System Software Specification (Bill of Materials) for Unified ICM/CCE* for sizing information.

### Configuring the Unified IC Database

You must configure the Unified IC database on the server where it will be created.

For a simple deployment, perform this configuration at Unified IC server.

For standard and scaled deployments, perform this configuration at the Archiver server.

| **Step 1** | Navigate to the folder where the configuration tool is installed. By default, this is `%CUIS_HOME%\bin\CuisConfigTool`. |
**Step 2**  
Double-click `CuisConfigTool.exe`.  
The Welcome to Cisco Unified Intelligence Suite Config Tool window displays.

**Step 3**  
Select *I would like to configure: Cisco Unified Intelligence Center.*

**Step 4**  
Click Next.  
The Components Selection window opens.

**Note:** Although you can check both boxes, this document treats each configuration separately and documents the Unified IC Intelligence Database Server configuration first.

**Step 5**  
Check *Intelligence Database Server*. Then click **Next** to open the User Information window.  
See **Internal Users (page 32)**.

**Step 6**  
At the User Information window, enter values as explained below:

*Figure 10: Configuring Unified IC Database: Components Selection Window*

*Figure 11: Configuring Unified IC Database: User Information*
Select the type of Windows user that Unified IC will use to run its applications: Local or Domain.

If you selected Domain as Type of User, enter the domain name. If you selected Local as Type of User, enter the local machine name.

Enter the name of the Windows domain or local Unified IC User that will run the applications.

Enter the password of the Windows domain or local Unified IC User.

Click Next to display the Servers Information window.

**Step 7**

Complete fields on the Servers Information window as explained below:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Web server information</strong></td>
<td>Enter the Hostname or IP Address of the Unified IC Server exactly as the user will enter in their browser.</td>
</tr>
<tr>
<td><strong>Database server information</strong></td>
<td>In a simple deployment, enter the Hostname or IP of the Unified IC Server. In standard and scaled deployments, enter the Hostname or IP of the Archiver Server.</td>
</tr>
<tr>
<td><strong>Database server information</strong></td>
<td>Leave this field blank if your SQL Server does not use named Instances. If your SQL Server uses named Instances, enter the name of the Instance where the database will be created.</td>
</tr>
<tr>
<td><strong>Database server information</strong></td>
<td>This field autopopulates to cuic_data_&lt;web server Hostname or IP&gt;</td>
</tr>
</tbody>
</table>

Figure 12: Configuring Unified IC Database: Servers Information
**Step 8** Click Next.

The tool checks for a valid connection to the Microsoft SQL Server.

If there are no errors, the Configuration window appears.

In the event of an error, click OK to continue to the Configuration window.

**Step 9** At the Configuration Window, click Configure.

The following actions take place in this order:

- The Unified IC database is created.
- A login is created for the Unified IC User.
- The Windows Unified IC user is mapped as a Microsoft SQL Server user.
- The Windows Unified IC user is given a 'dbcreator' server role in SQL Server.

You see a progress bar showing the status of the configuration and the task being performed. When the configuration completes, the Configuration is successfully completed window displays.

In the event of an error, a message displays advising you to open the CuisConfigTool.log file. If this occurs, click Exit.

**Step 10** At the Configuration is successfully completed window, click Restart and then click Finish.

**Note:** Restarting the server ensures that licences are applied, services are started, and environmental variables are set.

---

**Configuring the Intelligence Web Server**

For all deployments, perform this configuration at the Unified IC server.

**Note:** Unified IS displaces IIS and any existing web services on port 80. Please see the troubleshooting tip on the Port 80 error. (page 292)

**Step 1** After you configure the Unified IC database and restart the machine, navigate to the Configuration Tool in %CUIS_HOME%\bin\CuisConfigTool.

**Step 2** Double-click CuisConfigTool.exe.

The Welcome to Cisco Unified Intelligence Suite Config Tool window displays.

**Step 3** Select I would like to configure Cisco Unified Intelligence Suite. Then click Next to open the Components Selection window.

**Step 4** At the Components Selection window, select Intelligence Web Server.
This opens the User Information window.

**Step 5**
Complete the User Information window as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type of User</strong></td>
<td>Select the type of Unified IS Service user that Unified IC will use to run its applications: Local or Domain. See <a href="#">Internal Users</a> (page 32).</td>
</tr>
<tr>
<td><strong>Domain</strong></td>
<td>If you selected Domain as Type of User, enter the domain name. If you selected Local as Type of User, enter the local machine name.</td>
</tr>
<tr>
<td><strong>Username</strong></td>
<td>Enter the name of the Windows domain or local Unified IC User that will run the applications.</td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>Enter the password of the Windows domain or local Unified IC User.</td>
</tr>
</tbody>
</table>

Click **Next** to display the Servers Information window.

**Step 6**
Complete the Servers Information window as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Web server information</strong></td>
<td>Enter the Hostname or IP Address of the Unified IC Server exactly as the users will enter it in their browser.</td>
</tr>
<tr>
<td><strong>Database server information</strong></td>
<td>In a simple deployment, enter the Hostname or IP of the Unified IC Server. In standard and scaled deployments, enter the Hostname or IP of the Archiver Server</td>
</tr>
<tr>
<td>Hostname/IP</td>
<td>Leave this field blank if your SQL Server does not use named Instances. If your SQL Server uses named Instances, enter the name of the Instance where the database will be created.</td>
</tr>
<tr>
<td><strong>Database server information</strong></td>
<td>This field autopopulates to <strong>cuic_data_&lt;web server Hostname or IP&gt;</strong>.</td>
</tr>
</tbody>
</table>

**Step 7**
Click **Next** to open SMTP Proxy Server Settings window.

Because you have the option to deliver scheduled reports by e-mail, the Web Server Configuration includes two windows where you specify your SMTP Proxy Server (if you use one) and the SMTP Server settings. See also [Creating Report Schedules](#) (page 135).

If you do not intend to send automatic e-mail notification for scheduled reports, skip to Step 11.

**Step 8**
At the SMTP Proxy Server Setting Window:

a. If you do not use an SMTP Proxy Server, leave this window blank.

b. If you use an SMTP Proxy Server, complete this window as follows:
<table>
<thead>
<tr>
<th>Force proxy server</th>
<th>Check this if you use a proxy server to reach your SMTP server.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email proxy server hostname</td>
<td>Enter the Hostname or IP address of the proxy server used to reach the SMTP server.</td>
</tr>
<tr>
<td>Email proxy server port</td>
<td>Enter the port the Unified IC will use to connect to the SMTP proxy server. This defaults to 80.</td>
</tr>
<tr>
<td>Email proxy server protocol</td>
<td>This defaults to http (the only supported protocol) and is protected.</td>
</tr>
</tbody>
</table>

**Step 9**
Click Next.

The Config Tool pings the Hostname or IP address to perform a simple data validation. Then the SMTP Server Settings window opens.

**Step 10**
Complete the SMTP Server Settings window as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMTP Server Hostname/IP:</td>
<td>Enter the Hostname or IP address of the SMTP Server. Leave this field blank if you do not have an SMTP server.</td>
</tr>
<tr>
<td>Authenticate to SMTP Server:</td>
<td>Check this if your SMTP server expects to receive username/password credentials.</td>
</tr>
<tr>
<td>SMTP Server Username:</td>
<td>If you check the Authenticate checkbox, enter the username that is to be authenticated.</td>
</tr>
<tr>
<td>SMTP Server Password:</td>
<td>If you check the Authenticate checkbox, enter the password that is to be authenticated.</td>
</tr>
<tr>
<td>Send E-mails From:</td>
<td>Enter the e-mail address that is to appear in the From field of emails sent by the Scheduler.</td>
</tr>
</tbody>
</table>

**Step 11**
Click Next.

Unified IC attempts to send an email to check for open connections.

If there are errors, you see a message, and the Configuration log file is updated with details.

If there are no errors, the Scheduler service settings window opens. This window sets the frequency with which the Scheduler checks the Unified IC database and runs any scheduled reports that are due.

**Step 12**
At the Scheduler service settings window, keep the default (5 minutes) or change it up to a maximum value of up to 1140 minutes (one day).

Click Next to open the web application settings window.

**Step 13**
Complete the web application settings window as follows:
<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>User files path</td>
<td>Leave this field blank to use the default directory. If you choose to configure it, you must create a directory with a subdir structure identical to %CUIS_HOME%\CuisWeb\UserFiles.</td>
</tr>
<tr>
<td>Temporary directory</td>
<td>Keep the default of c:\temp, or change to the directory where you want temporary information stored.</td>
</tr>
<tr>
<td>Enable user activity logging</td>
<td>Check this box if you want Unified IC to keep track of users’ activity. This activity displays in the User History tab (page 69).</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>• User Activity Logging can generate high loads on the database for large deployments. An optimized option can be used in place of true for the UserActivityLoggingEnabled parameter in the web.config file. You must specify this parameter manually by editing the web.config file. You must also select debug as the value for TracingEnabled parameter to enable this feature. These two options force the system to capture the user activity externally and reduces the stress on the database for large/busy deployments. However, if TracingEnabled parameter is set to True, then this behavior changes and the system continues to save the user activity logs in the database. Hence it is recommended to set the value for TracingEnabled parameter and UserActivityLoggingEnabled parameter as True only if you want to capture the tracing data and the user activity data in the database itself.</td>
</tr>
<tr>
<td></td>
<td>• Starting with Unified IS Release 7.5.4 ES4, the system does not purge the Useractivity table automatically. You must set this up as part of the daily database cleanup activity for your Unified IS deployment.</td>
</tr>
<tr>
<td>Activity log storage in days</td>
<td>Keep the default of 10 days, or enter a value up to 365 to set the number of days that user activity is retained.</td>
</tr>
<tr>
<td>Saved reports image limit</td>
<td>Keep the default of 500 or enter a value between 1 and 500 to define the maximum images (individual copies) that can be saved for a report.</td>
</tr>
<tr>
<td>Row limit</td>
<td>Keep the default of 3000 or enter a value up to 3000 to define the maximum rows of data a report can contain.</td>
</tr>
<tr>
<td></td>
<td>The default value of 3000 is best for most environments. See the Troubleshooting Tip for Row Limit (page 293).</td>
</tr>
</tbody>
</table>
Click Next to open the Configuration file encryption settings window.

**Step 14**  
At the Configuration file encryption settings window, enter a Key string and an IV string. Then click Next to open the web server support settings window.

You can type any string.

These strings are used as input to an algorithm that encrypts all sensitive information in the configuration files.

See Encryption (page 15).

**Step 15**  
Complete the web server support settings window as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query timeout in seconds</td>
<td>Keep the default of 999 seconds or specify a value between 1 second and 3540 seconds, to define the time that the system waits for the query to run. Once the specified limit elapses, the system abruptly terminates the query irrespective of whether the query string is syntactically correct or not.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>Use this field to enter your Customer name.</td>
</tr>
<tr>
<td>Tracing enabled</td>
<td>Select debug, True, or blank to set the tracing for the web application. Note: Select tracing to option 'True' to populate the Error Message - Detailed Report. See Error Reports (page 122). Selecting debug option for Tracing enabled field in conjunction with setting the debug option for UserActivityLoggingEnabled parameter in the web.config file, allows the system to capture the user activity externally and hence does not cause any load issues on the database</td>
</tr>
<tr>
<td>Enable error logging</td>
<td>Check this box to have the Unified IC web server log all error messages to the Unified IC database. This data populates Error Report.</td>
</tr>
<tr>
<td>Enable profiling</td>
<td>Check this box to log SQL queries to the CUIS database so that user reporting patterns can be analyzed. Use this only in situations where administrators are unable to monitor user behavior directly and need the application to log it automatically. Warning: Profiling is a very expensive function on the server and decrease performance drastically. Cisco does not recommend using this option if you are using the debug option for the UserActivityLoggingEnabled</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>-------</td>
<td>-------</td>
</tr>
<tr>
<td></td>
<td>parameter in the <strong>web.config</strong> file. Enable this option only when directed by Cisco Support.</td>
</tr>
</tbody>
</table>

Click **Next** to open the Configuration window.

**Step 16**

At the Configuration Window, click **Configure**.

The following actions take place:

- The Scheduler service is installed.
- IIS is configured, and the Unified IC web application is deployed to it.
- The CUISLocalUserGroup is created.
- Folder permissions are set for the CuisWeb folder.
- The Unified IC system user is made a member of the IIS_WPG group, which allows the Unified IC application pool in IIS to run with its credentials.
- Configuration files are created. All user input is stored. The InstallUtil.exe and Scheduler.exe files are updated with the contents of the web application configuration file.

You see a progress bar showing the status of the configuration and the task being performed.

If an error occurs, a message display directing you to the Configuration Log. Click **Exit**.

If no errors occur, the Configuration is successfully completed window displays.

**Step 17**

At the **Configuration is successfully completed window**, select **Yes** to restart your computer, and then click **Finish**.

When the server restarts, navigate to **My Computer > Manage > Local Users and Groups > Groups** to verify the creation of the CuisLocalUserGroup.

This is the group to which the Unified IC Admin must add Windows users so that they can log in to the Unified IC Web Application. See **Adding Unified IC Users (page 62)**.
Then navigate to **My Computer > Manage >Services and Applications > Internet Information Services** to verify the creation of the web site.

**Figure 14: CUIS Website**

---

**Configuring the Archiver**

Archiver Configuration prerequisites are as follows:

- You must configure the Archiver on a server where Unified IS has been installed. The server must meet the hardware requirements listed in the *The Cisco Unified Intelligence Suite 7.5(x) Bill of Materials* and the *Hardware & System Software Specification (Bill of Materials)* for Unified ICM/CCE.

- The Configuration Tool must be run by a user with Windows administrator credentials. This user must be mapped as a SysAdmin security login on the local Archiver SQL Server.

- The local or domain Archiver user must be created and must be added to the Administrator Group in order to have administrative privileges in SQL Server.
• Using SQL Server Management Studio, this Windows local or domain user must be added as a SQL Server security login. This user should have read access to the _awdb and _hds databases.

---

**Step 1**
Navigate to the folder where the configuration tool is installed. By default, this is %CUIS_HOME%\bin\CuisConfigTool.

**Step 2**
Double-click CuisConfigTool.exe.

The Welcome to Cisco Unified Intelligence Suite Config Tool window displays.

**Step 3**
Select *I would like to configure: Cisco Archiver*.

The Cisco Archiver radio button is enabled only when the server meets the configuration requirements.

**Step 4**
Click *Next*.

The Archiver - Product Selection window opens. This window currently has only one option to configure. It is *not* checked by default.

*Figure 15: Configuring Archiver: Product Selection*

**Step 5**
Check Cisco Unified Contact Center Enterprise and then click **Next** at the Product Selection window.

This opens the Archiver - User Verification window.

**Step 6**
Complete the User Verification window as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Database Information</strong></td>
<td><strong>Use named instance?</strong></td>
</tr>
<tr>
<td><strong>Database Information</strong></td>
<td><strong>Instance name</strong></td>
</tr>
<tr>
<td>Check this if your database uses named instances. If the checkbox is unchecked (default), the default SQL Server instance will be used for the Archiver.</td>
<td></td>
</tr>
<tr>
<td>Enter the name of the local SQL Server instance on which to configure the Archiver.</td>
<td></td>
</tr>
</tbody>
</table>
Step 7
Click Next.

The configuration tool performs the following actions:

• Checks that the current Windows user can log in as an Administrative user.

• Checks that TCP/IP is enabled.

• Verifies that the Windows login is correct. If the user is not mapped as a SysAdmin security login on the local Archiver SQL Server, then creates that mapping.

• If conditions are not met, presents an error message and an Exit button.

• If conditions are met, opens the Archiver - Database Size window.

Step 8
At the Archiver - Database Size window, select the disk layout and file size for the database: Small or Large. Refer to the *The Cisco Unified Intelligence Suite 7.5(x) Bill of Materials* and the *Hardware & System Software Specification (Bill of Materials) for Unified ICM/CCE* for sizing data.

Step 9
Click Next.

If no supported database sizes are available, the configuration presents an error message and an Exit button.

If the supported database size is verified, the Archiver - Linked Server window opens.

Step 10
Complete the Archiver - Linked Server window as follows to identify the Unified Admin Workstation from which the Archiver is to retrieve reporting data:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linked server name</td>
<td>Enter the connection name that is the unique identifier for the linked server.</td>
</tr>
<tr>
<td>Linked server address</td>
<td>Enter the Hostname or IP address of the Unified ICM/CCE Admin Workstation.</td>
</tr>
<tr>
<td>Linked server database</td>
<td>Enter the name of the main AW/HDS database.</td>
</tr>
</tbody>
</table>
From the dropdown, select the time zone where the Unified ICM/CCE Admin Workstation is located.

**Step 11** Click **Next** to open the Archiver - Configuration window.

**Step 12** At the Archiver - Configuration window, click **Configure**.

You see a progress bar showing the status of the configuration and the task being performed.

The Archiver configuration manages the following:

- Adds the appropriate operating system switches to the boot.ini file.
- Sets up the common database directories based on the database size selection.
- Sets the database user role for the Archiver User (sysadmin).
- Runs the common Archiver database script to create the archiver and archiver_data databases.
- Sets the Archiver User’s default database to archiver.
- Sets the Archiver User mapping to be a db_owner for the archiver and archiver_data databases.
- Sets up the Archiver User as the login to start the Microsoft SQL Server Agent service.
- Creates the Archiver linked server to the Unified ICM/CCE Admin Workstation.
- Runs the Unified ICM product-specific database script.
- Runs the Perl security hardening script to disabled mixed-mode authentication for the local Microsoft SQL Server.

If an error occurs, a message display directing you to the Configuration Log. Click **Exit**.

If no errors occur, the Configuration is successfully completed window displays.

**Note:** The CUIS configuration tool does not administer remote servers. The Unified ICM DBA is responsible for setting up the Unified ICM databases for Archiver. See Internal Users (page 32).

**Step 13** At the Configuration is successfully completed window, select **Yes** to restart your computer, and then click **Finish**.

Use the SQL Server Management Studio to verify that the Archiver database was configured.
Configuration Log

The Unified IS Configuration Tool creates a log file containing version, date and time of runtime, warning and error information, processes data, and other helpful informational messages.

The Config Tool log file(s) are saved to the %WINSYSDISK%\temp directory or to C:temp if WINSYSDISK cannot be determined.

The filename is CuisConfigTool.Log.

Licensing

Of the two main components of the Cisco Unified Intelligence Suite, Unified IC requires a license. Archiver does not.

Licenses are Node-locked and tied to the MAC address.

License format:

```
INCREMENT <FEATURE> cisco <version> <expiration_date> uncounted \ 
VENDOR_STRING=<Count>userCount</Count> HOSTID=<MAC_address> \ 
NOTICE="<LicFileID>licenseId</LicFileID><LicLineID>1</LicLineID> \ 
<PAK></PAK>" TS_OK SIGN=<SIGNATURE>
```

There are three types of licenses:

- **DEMO**
  
  Unlimited number of concurrent users. 60 days duration.

- **NFR/LAB**
Five concurrent users. Unlimited duration.

- ENTERPRISE

Unlimited number of concurrent users. Unlimited duration.

Licenses are acquired as follows:

1. Upon receipt of your PAK (Product Authorization Key), identify the MAC address of the Unified IC Web server using: `ipconfig /all`.

2. Using Cisco's website, enter your PAK, MAC address (with no dashes), and contact information.

   You receive the license file by e-mail.

3. Follow the instructions in the e-mail to save the license to a temporary folder.

4. Copy the license file to the CUIS license folder:

   Figure 17: License Folder

   ![License Folder](image)


   This tool installs runtime components that enable the Unified IC web server to recognize the license file.

   If you do not run this tool, you see a browser error when you attempt to log in to Unified IC.

See also Troubleshooting Licensing (page 295).
Upgrading to a Maintenance Release

Unified IS Maintenance Releases and their Release Notes are available for download from cisco.com.

To download a Maintenance Release

2. Click Support. Then click Download Software.
3. Scroll to select Voice and Unified Communications.
4. Log in using your Cisco credentials. Accept the Security Alert to enter the website.
5. Expand the Customer Contact folder. Then expand the Cisco Unified Contact Center Products folder.
7. Expand folders to navigate to the executable file for maintenance release you want to download.
9. Select the executable file; then click Download Now.
10. Click Agree to accept the download rules.
11. Click Save and browse to the location(s) where you want to save the installer file.

This image shows the upgrade page for Release 7.5.3.
Click and download the Release Notes file for the procedure to install the Maintenance Release, the new features (if any) it contains, and the list of defects that it resolves.
Chapter 6

Initial Actions for the Administrator after Installation and Configuration

The first user to log into the Unified IC web server when the installation completes is automatically configured as the Unified IC Admin User (page 71).

That user performs initial setup and creates other users.

This chapter contains the following topics:

- Logging In, page 55
- Editing the Default Data Sources, page 56
- Configuring and Refreshing Stock Values Lists, page 58
- Importing and Configuring Stock Reporting Templates, page 60
- Adding Unified IC Users as Members of the CuisLocalUserGroup, page 62

Logging In

Step 1  Open the browser and enter the address of the Unified IC web server, exactly as entered on the Configuration window. (page 41).

Step 2  At the login dialog box, enter your user name. If necessary for your environment, prepend it with the Active Directory domain name or the machine name. Then enter your password.
Step 3  Click OK.

Unified IC opens to the initial interface (page 93).

See also Troubleshooting Login (page 296).

Editing the Default Data Sources

At installation, the Data Sources window is populated by default with the names of two data sources: Unified IC and Unified ICM\UCC.

The Unified IC data source is configured by default. The Unified ICM\UCC data source is not. The Admin User needs to:

• Verify that the Unified IC data source is configured correctly.

• Configure the Unified ICM\UCC data source and/or the Informix data source.
### Step 1
Select **Administrative > Data Sources** to open the Manage Data Sources window.

### Step 2
Select **CUIC** and click **Edit**. This is the Unified IC database that populates Error Reports.

### Step 3
Verify that the Edit Data Sources window for the Unified IC database looks correct.

**Note:** In a scaled deployment that has more than one CUIC data source, the timezone and configuration must be the same for all CUIC data sources.

### Step 4
Click **Test Connection** to verify that the database is online.

### Step 5
Click **Save** to return to the Data Sources window.

### Step 6
Select **Unified ICM\UCC** and click **Edit**. This is the data source for the AW and HDS databases that populate the reports from stock templates.

The Edit Data Sources window displays.

### Step 7
Complete the Edit Data Sources window for the Unified IC database as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Source Name</td>
<td>Enter the name of the data source server. <strong>Note that</strong> the Manage Data Source dialog provides only one field for Database Name.</td>
</tr>
<tr>
<td></td>
<td>If you add a Data Source for the Archiver, enter the archiver-data on this dialog box. On the Archiver server, use the SQL Server</td>
</tr>
<tr>
<td></td>
<td>Management Studio to add the Windows domain Unified IC User as a new security login and set with db_datareader access to all three</td>
</tr>
<tr>
<td></td>
<td>Archiver databases</td>
</tr>
<tr>
<td>Server (IP or DNS: port)</td>
<td>Enter the IP address or DNS name for the server. <strong>Append the port for an Informix database. Port is not typically needed for SQL Server.</strong></td>
</tr>
<tr>
<td>Type</td>
<td>From the dropdown, select Informix or SQL Server database server.</td>
</tr>
<tr>
<td>Database name</td>
<td>Enter the database name</td>
</tr>
<tr>
<td>Instance</td>
<td>Only used for Informix, specify the instance name of the database you are connecting to.</td>
</tr>
<tr>
<td>Locale</td>
<td>Only currently used for Informix database. Specify the database locale; for example en_US.UTF8.</td>
</tr>
<tr>
<td>Windows Integrated Authentication</td>
<td>If you use SQL with Windows Authentication (preferred), then check this.</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>If you connect to an Informix database or to older version of SQL, such as a Unified ICM 7.2 database, then leave this unchecked</td>
<td></td>
</tr>
<tr>
<td>Database User ID</td>
<td>Defaults if Windows Integrated Authentication is checked. Enter Database User ID if Windows Integrated Authentication is unchecked.</td>
</tr>
<tr>
<td>Password and Confirm Password</td>
<td>Enter and confirm the password for the database user.</td>
</tr>
<tr>
<td>Timezone</td>
<td>Select the correct timezone for the server. Timezone information is critical in order to normalize date/time data.</td>
</tr>
<tr>
<td>Workstation ID</td>
<td>Leave blank</td>
</tr>
</tbody>
</table>

**Step 8**  
Click **Test Connection** to verify that the database is online.

**Step 9**  
Click **Save** to return to the Data Sources window.

When the Data Sources are configured and online, you can configure the stock Value Lists and import the stock templates.

See **About Value Lists** (page 80) and **Stock Report Templates** (page 121).

### Configuring and Refreshing Stock Value Lists

A Value List is a list containing all items of the same type, for example, all agents or all skill groups, and is used to display the filter criteria for a report.

Unified IC is installed with stock Value Lists.

The Admin user needs to access each stock Value List, verify that it is associated with the Data Source for the Unified ICM/CCE Admin Workstation, and refresh the values.

**Step 1**  
Select **Administrative > Value Lists/Collections** to open the Manage Collections dialog box.

**Step 2**  
Select the first Value List and click **Edit**.
Figure 21: Configuring Stock Value Lists 1 of 3

The Edit Value List window opens.

Figure 22: Configuring Stock Value Lists 2 of 3

**Step 3**  Ensure that the Data Source is populated. Then click **OK** to return to the Manage Collections dialog box.

**Step 4**  With the same Value List highlighted, click **Values** to open the Value List dialog box.
Step 5  Click **Refresh Dynamically** to populate the list from the Data Source. Then click **Close**.

Step 6  Repeat steps 2 – 5 for each Value List.

Step 7  Click **Close** after you have populated all stock Value Lists.

With the Value Lists updated, you are ready to import and configure the stock report templates.

**Importing and Configuring Stock Reporting Templates**

The Admin user needs to import the stock reporting templates and to associate them with the Data Source for the Unified ICM/CCE Admin Workstation.

These are templates built from data from the Unified ICM/CC database.

**Step 1**  Select **Report Admin > Import Reports** to open the Import Report window.

This window has a panel for importing specific files and a panel for importing the stock Cisco report templates that were installed with Unified IC.

**Step 2**  To import the stock Cisco report templates click **Continue** in the bottom panel.
Figure 24: Importing Reports

**Import Report**

Import a file on your computer:

![Import Report dialog box]

- [ ] Continue

Import the reports that were shipped with your Intelligence Center installation

- [ ] Continue

The Import Report dialog box opens.

**Step 3**

At the Import Report dialog box:

*Figure 25: Import Report Dialog Box*

- Check the box to reset the report data sources to the one selected below.

  - [ ] Check to reset the report data sources to the one selected below

  - Data Source: CUCI

    - ICU2
    - AgentSkillGroup_AllFields_RT
    - AgentTeam_HA
    - AgentTeam_StateCounts_RT
    - Agent_AllFields_RT
    - AgentAllFields_RT

  - [ ] Import

a. Check the box to reset the report data sources to the one selected below.

b. From the Data Source dropdown, select the data source for the Unified ICM/CCE databases.

c. Click **Import**.

You see a message that the import is successful.

d. Click **OK**.

**Step 4**

To verify that the reports have been imported, select **Report Admin > Report Manager**.
Adding Unified IC Users as Members of the CuisLocalUserGroup

Before users can log in to the Unified IC web application, they must be Windows Local or Domain Users and they must be added as members of the CuisLocalUserGroup.

**Note:** If you have an existing Windows User Group, for example, for WebView Users, you can add that entire group to the CuisLocalUserGroup.

This procedure explains adding Windows Local users and then adding them to the CuisLocalUserGroup. The process for adding Domain users is similar.

**Step 1** Add the user to the Windows User List as follows:

a. From the Windows desktop, right-click **My Computer** and select **Manage**.

b. Select **Local Users**. Then right-click **Users**.
c. Select **New User** to open the New User dialog box.

Figure 28: Adding Users 2 of 2

![New User dialog box](image)

- d. Enter the User Name. Enter and confirm the password.

- e. Disable **User must change password at next login** and check **Password never expires**.

- f. Click **Create**. Then click **Close**.

**Step 2**

Make the new user a member of the CuisLocalUserGroup as follows:

- a. From **Local Users and Groups > Users**, right-click the new user and select **Properties**.

- b. From the Properties dialog box, click the **Member of** tab. Then click **Add**.

- c. In the Select Groups dialog, enter **CuisLocalUserGroup**. Then click **OK**.

**Step 3**

To verify the new user is a member of the CuisLocalUser Group, select **Local Users and Groups > Groups**. Right-click CuisLocalUserGroup and select **Properties**.

Until you assign User Roles, users who are members of CuisLocalUserGroup can log in to Unified IC with the user role of **Restricted Viewer** (page 72).
As an Admin User, you can assign User Roles (page 70) and set up Dashboards (page 100).
Part 3: Unified IS Administration

Sections in Part 3 include:

Administering Users and User Groups (page 67)

Administering Value Lists and Collections (page 79)

Administering Data Sources (page 87)
Administering Users and User Groups

Any users whose Active Directory authentication allow them to do so can sign in to Unified IC with Restricted Viewer rights and view a limited User Interface.

Only when a user has been assigned a User Role and given access to reports, data, collections, and dashboards is he or she able to view and work with reports and dashboards.

This chapter contains the following topics:

- The User List, page 67
- Editing User Roles, page 70
- User Groups, page 73
- Fake a User, page 75
- Setting Permissions in the Security Center, page 76
- Adding or Deleting Access to a Shared Report, page 76

The User List

The User List displays all users in the system and provides the ability to quickly locate users and group users, to edit existing users, and to add new users.

Locating a User

To access the User List, select Security > User List.

To quickly locate a user, you can change the default view or reorder the column headings.

By default, the User List shows all users. Select the checkbox at the top of the list to see only those users who have been active in the last ten minutes.

The User List has an Edit column and eleven columns of information.
• To rearrange the columns, select the heading and drag it to a new location.

• To widen or narrow a column, click and drag the line between the heading rows.

• To sort a column, click in the column heading.

Adding Users and Editing User Information

Users that you add within the Unified IC interface must also be added as Windows Local Users and be added as members of the CuisLocalUserGroup.

Step 1
Add the user to the Windows User List as follows:

a. From the Windows desktop, right-click My Computer and select Manage.

b. Select Local Users. Then right-click Users.

c. Select New User to open the New User dialog box.

d. Enter the User Name. Enter and confirm the password.

e. Disable User must change password at next login and check Password never expires.

f. Click Create. Then click Close.

Step 2
Make the new user a member of the CuisLocalUserGroup as follows:

a. From Local Users and Groups > Users, right-click the new user and select Properties.

b. From the Properties dialog box, click the Member of tab. Then click Add.

c. In the Select Groups dialog, enter CuisLocalUserGroup. Then click OK.

d. To verify the new user is a member of the CuisLocalUserGroup, select Local Users and Groups > Groups. Right-click CuisLocalUserGroup and select Properties.

Step 3
From Unified IC, access the User List by selecting Security > User List.

Step 4
To add a new user, click New User. To edit information for an existing user, locate and select the user and click Edit...

The Edit User window opens to the User Profile tab (page 69).

Step 5
Complete the fields in the tab.

Step 6
Make sure that you check User is Active. Inactive users cannot log in.

Note: It is not possible to delete users in this release.
User Profile Tab

All users can access this tab from the Profile menu to view and edit their own preferences, such as for name, phone number, time zone and style sheet preferences.

Admin and Security Admin users can access all User Profile tabs to edit information.

Click **Submit** to save changes on this tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>The domain and username of the user. This field is disabled in edit mode.</td>
</tr>
<tr>
<td>User is Active</td>
<td>If this box is checked, the user is active and available to log in. If it is unchecked, the user is not able to log in.</td>
</tr>
<tr>
<td>Show Welcome Screen</td>
<td>Check or uncheck to control whether the Welcome screen appears as the initial view at login.</td>
</tr>
<tr>
<td>First Name</td>
<td>The user's first name.</td>
</tr>
<tr>
<td>Last Name</td>
<td>The user's last name.</td>
</tr>
<tr>
<td>Company</td>
<td>The company name or other descriptive text to be associated with the user such as region or Line of Business.</td>
</tr>
<tr>
<td>Email</td>
<td>Informational field to store the user's email address.</td>
</tr>
<tr>
<td>Contact Phone</td>
<td>Informational field to store a phone number for the user. This can be the user's personal phone number or an emergency contact.</td>
</tr>
<tr>
<td>Style Sheet</td>
<td>Specify the style sheet that will be used for the application interface 'look and feel' for this user.</td>
</tr>
<tr>
<td>Timezone</td>
<td>The timezone used to display interval data for reports that were created with the 'Normalize Date/Time to user's local time zone' option checked. This option can be found on the data source tab of the field properties dialog. See Report Wizard Field Properties (Field Map Tab) (page 152). Changing a user's time zone will override any settings inherited from membership in a group.</td>
</tr>
<tr>
<td>Default User Group</td>
<td>The default user group assigned to the user. If no settings are specified in the user's profile for time zone, then settings from the user's default user group will be used. New users are automatically added to the default user group.</td>
</tr>
</tbody>
</table>

User History Tab

Users can access this tab from the Profile menu to review their own system activity.

Admin and Security Admin users can access all User History tabs.
By default, the tab shows the last 50 pages a user has visited. To adjust this value, enter another number and click **Refresh**.

**Columns:** The tab displays the user's activity in two columns: Operation and OperationDateTime.

- To reverse the column order, select the column heading and move it.
- To resize a column, click and drag the column divider.
- To sort the contents of a column, click the blue triangle in the heading.

### Grouping Users

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Access the User List by selecting <strong>Security &gt; User List</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Select the column heading by which you want to group the users.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Drag that column header into the wide band directory above the column headings. For example, to group by Last Name, drag the LastName column up into that area. The window refreshes to show users grouped by that column.</td>
</tr>
<tr>
<td>Step 4</td>
<td>To ungroup, drag the header back into the grid area.</td>
</tr>
</tbody>
</table>

### Editing User Roles

The role or roles assigned to each user control the menus he or she is able to access.

To edit a user's role, locate that user and select (check) the role or roles that are to apply.

Users cannot change their own roles.

A non-admin user cannot edit the roles of admin users.

Some user roles can be combined. The possible user roles and combinations are as follows:

- Admin
- Security Admin
- Report Designer
- Restricted Viewer
- Report Designer AND Restricted Viewer
- Report Designer AND Security Admin
Admins and Report Designers have access to the Report Context Menu (page 128) and can perform any of the actions on that menu. These include View (running the report) as well as Edit, Clone, Change Default Filters, View Report Info, Schedule, Rename, Delete, Edit XML, and Export.

Restricted Viewers have access to the Reports Menu (page 97) and can View (run) reports.

Restricted users can save as (clone) the reports that they view. Once a report is saved and renamed as a personal report, a user can run it and can use any of the options on the Report Interface (page 111). These include Simple Wizard, Chart, Simple Filter, Modify Report Filtering, and Print.

Admin Role

This role provides full privileges to all areas of the interface and to all reports, dashboards and options.

Admin Users have the ability to impersonate another user by using the Security Menu -> Fake a User feature. In this mode, all actions are logged as if the 'faked' user performed them.

Administrators can edit and delete public reports and dashboards designed by other users. They cannot, however, see personal reports and dashboards except their own.

Admin users have access to these menus:

- Reports (page 97)
- Value Lists (page 80)
- Administrative (page 97)
- Report Admin (page 97)
- Security (page 97) with Fake a User option.
- Profile (page 98)
- Help

Report Designer Role

Users assigned to this role can view all reports and public dashboards, clone existing reports, and create new public reports. They can edit and delete reports created by other users.

They cannot see personal reports and dashboards except their own.

Report Designer users have access to these menus:

- Reports (page 97)
• Value Lists (page 80)

• Report Admin (page 97)

• Profile (page 98)

• Help

This role can be combined with the Restricted Viewer role to limit access to reports and data.

This role can also be combined with the Security Admin role.

Restricted Viewer Role

Members assigned to this role have access only to reports, public dashboards, and data specifically shared with them or assigned to them through user and group permissions in the Security Center.

Until dashboards are shared or reports are assigned, Restricted Viewers see no dashboards or reports.

Restricted Viewers cannot edit or delete reports.

**Restricted Viewer** users have access to these menus:

• Reports (page 97)

• Profile (page 98)

• Help

This role can be combined with the Report Designer role.

Security Admin Role

Users in this role give access to other users and have the ability to restrict the reports, data, and dashboards a user can access.

They do not have the ability to edit or delete reports.

They cannot see personal reports and dashboards except their own.

**Security Admin** users have access to these menus:

• Reports (page 97)

• Security (page 97) with no **Fake a User** option.

• Profile (page 98)
• Help

This role can be combined with the Report Designer role.

User Groups

The Manage User Groups window shows the list of available user groups and provides functions for adding, removing, and editing a User Group.

One User Group (All Users) appears on the Manage User Groups window by default. It is installed with the product as an example. You may remove it. If you choose to use this default group, an Administrator or Security Admin can assign users to it.

Creating User Groups expedites the process of provisioning users when multiple users need the same access to dashboards and reports.

User Groups have no impact on routing decisions or on how data is stored in the database. They are used only for determining which reports and dashboards are visible to the users.

If a user belongs to more than one group and the privileges are contradictory, the highest level of access applies.

Privileges given to users as individuals take precedence over privileges inherited from group membership.

Adding a User Group (page 73)

Editing a User Group (page 74)

Removing a User Group (page 75)

Adding a User Group

**Step 1**
Select Security > User Groups.

The Manage User Groups window opens. Unless Groups have been added, it lists only the default All Users group.

**Step 2**
Click New Group to open the New Group dialog.

**Step 3**
Enter a Group Name.

**Step 4**
Click Create.

You return to the Manage User Groups dialog, which now displays the new group name.

**Step 5**
Select the new group and click Edit to edit its properties.
Editing a User Group

**Step 1** Select Security > User Groups.

The Manage User Groups window opens.

**Step 2** Select the group and click **Edit**.

The Edit User Group window displays.

**Step 3** Change the Group Name, if necessary.

**Step 4** Select the Style Sheet for the default presentation for the group.

The Style Sheet controls the 'look and feel' of the user interface for the group members. Experiment with the choices to find a stylesheet you prefer.

If you add your own .css file to the CuisWeb\Stylesheets folder, it will appear in the dropdown.

**Note:** An individual user's choice of Style Sheet on his or her **User Profile (page 69)** overrides the User Group Style Sheet.

Options are:

- None Selected
- Default.css
- Gradients.css
- HighContrast.css
- StaticGroup.css (only used for grouped grids)
- UIStyle.css
- TextFile.txt

**Step 5** Select the default Timezone for members of the Group.

This timezone will apply to all group members for whom this is the default User Group, unless a user has selected a different time zone in his or her **User Profile (page 69)**.

Time zone preferences are applied to any report having the **Normalize Date/Time to users local time zone** setting enabled on the **Report Wizard Field Properties (Field Map Tab) (page 152)**.

**Step 6** Select the Logo URL.

This sets a custom logo for the user group and is typically used for outsourcers where a user group is made for a client or group of people with their own logo.
If this field is populated, the default version information on the home page is replaced with the image specified. The URL specified must include the "http://" prefix in the URL. For example, if you have a custom logo you want to use, enter it as a URL: `http://localhost/images/OurLogo.gif`.

**Step 7** Select group members from the Available Users panel and move them into the Current Users panel.

You can:

- Add All (>>)
- Remove All (<<)
- Add selected users (>)
- Remove selected users (<)

**Step 8** Click **Submit** to save the changes and close the window.

---

### Removing a User Group

**Step 1** To remove a User Group, click **Remove** from the Manage User Groups window.

**Step 2** Click **OK** at the message to verify your action.

You return to the Manage User Groups dialog, which no longer displays the group.

You can remove only one group at a time.

---

### Fake a User

The Fake a User option on the Security menu is visible to Admin Users only. It allows an administrator to impersonate another user.

When the administrator selects a user to impersonate, he or she is limited to the actions and permissions accorded to that user.

Use the Fake a User function to ensure that the security set up for a user is working properly and that the user dashboard(s) appears the way you intend them to.

**To Fake a User:**

- Select **Security > Fake a User** to open the Fake Being a User dialog box.
- Locate and select the user you want to impersonate.
Setting Permissions in the Security Center

The Security Center (Security > Security Center) is the interface where Admins and Security Admins assign permissions to control access to reports and to the data available in those reports. This is done by granting privileges to specific reports and specific data collections for individual users or user groups.

In the Group panel at the left of the Security Center window, expand the User Groups or the Users section.

- **Note:** By default, the window opens with the User Groups section expanded. Click on the Users section to collapse User Groups.

The expanded section shows all User Groups or all Users. Only one section can be expanded at a time.

Once a User Group or User is selected, the Shared Reports and Shared Collections panel on the right of the window display reports and data collections that are currently shared with that User Group or User.

Adding or Deleting Access to a Shared Report

**Step 1** Select Security > Security Center to open the Security Center window.

The expanded section shows all User Groups or all Users. Only one section can be expanded at a time.

**Step 2** Select a User Group or a User.

The Shared Reports and Shared Collections panel on the right of the window display reports and data collections that are currently shared with that User Group or User.

**Step 3** To add or delete shared reports, click the Edit... button at the top right of the Shared Reports panel. The Shared Reports dialog box opens. It shows all reports, arranged in hierarchy of folders.

To stop faking a user, click the **Stop Faking It** button.

**Note:** You can fake only one level of user. An Admin cannot fake User A and, as "User A," then fake User B.
a. To add a report for this User Group or User, locate and select (check) the report. Then click Close.

b. To remove a report for this User Group or User, locate and deselect (uncheck) the report. Then click Close.

**Step 4** Click **Done** to close the Security Center window.
Setting Permissions in the Security Center
Managing Value Lists and Collections

Select **Administrative > Value Lists/Collections** to display the Manage Collections window.

When this window opens, the panel on the left shows the stock Value Lists that are installed with Unified IC.

The Collections panel on the right appears only *after you select a Value List.*

- **Value Lists** (page 80)
- **Adding a Value List** (page 81)
- **Editing a Value List** (page 81)
- **Displaying and Refreshing Values** (page 82)
- **Deleting a Value List** (page 82)
- **Collections** (page 82)
- **Adding a Collection** (page 83)
- **Editing a Collection** (page 81)
- **Deleting a Collection** (page 84)
- **Adding or Deleting Access to a Shared Collection** (page 84)
Value Lists

A value list is a list containing all reportable items of the same type, for example, all agents or all skill groups, and is used to display the filter criteria for a report.

Admin Users and Report Designers can select Value Lists when they generate reports. Restricted Users cannot select Value Lists, but they can select Collections if they have been given permission to do so.

You can create or modify Value Lists from Administrative > Value Lists/Collections.

Unified IC is installed with stock value lists, and you can create new ones.

The stock value lists that are assigned to key values on the stock reports are as follows:

- Agent
- Agent Team
- Call Type
- Enterprise Services
- Enterprise Skill Groups
- Services
- Skill Group
- Trunk Groups

Value Lists are based on SQL Queries that provide a query (or Key) value and a display (text) value (in that order). The display value is shown in the list box and the query value is used to retrieve data for the report.

It is recommended that you create Value Lists based on indexed query values. Providing filters on non-indexed columns could have an adverse affect on the performance of the system.

Once defined, Value Lists are kept as static snap shots in the database. They remain exactly as defined until the cache expires or the list is manually refreshed. After configuration changes, you must refresh any Value Lists affected so the new values will be displayed in the list. See Displaying and Refreshing Values (page 82).

You can assign Value Lists to any column, using the Field Properties from the Field Map tab (page 152) in the Report Wizard.
Adding a Value List

You can create value lists to hide or show objects. For example, a list of Real Time Skill Groups could include current skill groups, while a list of Historical Skill Groups might include groups that have been deleted.

Step 1 Select Administrative > Value Lists/Collections to open the Manage Collections dialog box.

Step 2 Click New... to open the New Value List dialog box.

Step 3 **Value List Name:** Enter a name for the value list. Use a name that indicates what the values represent.

Step 4 **Data Source:** From the dropdown, select the data source that will populate the value list.

Step 5 **List Data Type:** Select the data type of the query value sent to the database when populating the report. In general, Value Lists should contain two values, a description value that will show up in the list box, and a query value that will be used to retrieve data from the database. The use of non-indexed query values is not recommended as it may have adverse affects on the performance of the system.

Step 6 **Value List Refresh Query:** Enter the query to populate the Value List. The stock value lists return all values in the configuration tables using the EnterpriseName and the primary key for the table as the description and query values respectively.

Step 7 **Collection Refresh Query:** Enter an optional query to limit the values returned based on a value provided for the Data Collection.

Step 8 Click OK to save the new value list and close the dialog box.

This saves the new value list and closes the New Value List dialog box.

Step 9 From the Manage Collections dialog box, select the new value list and click Values.

This displays the Values List dialog box.

Step 10 Click Refresh Dynamically to refresh the values.

Editing a Value List

Follow this procedure to edit a Value List:

Step 1 Select Administrative > Value Lists/Collections to open the Manage Collections dialog box.

Step 2 Select a Value List and click Edit... to open the Edit Value List dialog box.
Managing Value Lists and Collections

**Step 3** Make changes to Value List Name, Data Source, List Data Time, Value List Refresh Query, and Collection Refresh Query.

**Step 4** Click **OK** to save the changes and close the dialog box.

---

### Displaying and Refreshing Values

**Step 1** Select *Administrative > Value Lists/Collections* to open the Manage Collections dialog box.

**Step 2** Select the value list for which you want to see values.

**Step 3** Click **Values**.

This displays the Values List dialog box.

**Step 4** Click **Refresh Dynamically** to refresh the values.

---

Note that Value Lists display values that are obsolete; for example, Agents who are no longer on staff. These values are retained for historical reports. In the event that an agent left the call center and was subsequently rehired, that agent would appear on the list twice—one with her new ID and once with her original (obsolete) ID. For a real time report, you would select that agent by her new ID.

### Deleting a Value List

You cannot delete Cisco Stock Value Lists.

**Step 1** Select *Administrative > Value Lists/Collections* to open the Manage Collections dialog box.

**Step 2** Select the Value List you want to remove, and click **Delete**.

**Step 3** Respond to the confirmation message.

---

### Collections

Collections are subsets of Value Lists that can be used to control the amount of data shown to users and user groups.

Value Lists typically contain *all* the items in the enterprise (for example, all skill Groups) whereas Collections are used to narrow the scope of data returned in the selection list.

For example, you could create a Collection of Skill Groups that would display only the Skill Groups in a region or line of business.
Restricted Users cannot select Value Lists when they generate a report. They can, however, select Collections if they have been given access to do so. See Adding or Deleting Access to a Shared Collection (page 84).

Adding a Collection

Follow this procedure to add a collection.

**Note:** You cannot use the same collection name more than once in a single Value List.

**Step 1** Select Administrative > Value Lists/Collections to open the Manage Collections dialog box.

**Step 2** Select the value list for which you want to define a collection.

The Collection panel displays to the right of the Value List panel.

**Step 3** Click New... to open the Collection dialog box.

The Collection dialog box has two tabs: General and Values.

**Step 4** Complete the General tab as follows:

a. **Collection Name:** Required. Enter the display name for the Collection. The name should indicate what the values represent (for example, Skills or Agents) and the criteria applied to create the subset (SW_CustSvc_Skills).

b. **Collection Description:** Enter a description for the data collection. For example, *All Skill Groups assigned to the South West regional customer service queue*.

c. **Collection Identifier:** If a Collection Refresh Query was defined for the Value List and it references the [CollectionIdentifier] variable, then the value given here will be substituted for that variable when populating the Collection. For instance, if you needed to create Collections on the Agent Value list for each supervisor, you could enter their SupervisorSkillTargetID in this field to populate the Collection from the awdb configuration tables.

d. **Wildcard:** The query specified will populate the Value List. The stock value lists return all values in the configuration tables using the EnterpriseName and the primary key for the table as the description and query values respectively.

e. Click **OK** to save the changes.

**Step 5** Complete the Values tab as follows:

a. Select the values to include in the collection.

b. Click **OK**.
Editing a Collection

Follow this procedure to edit a collection:

**Step 1** Select **Administrative > Value Lists/Collections** to open the Manage Collections dialog box.

**Step 2** Select the value list for which you want to edit a collection.

The Collection panel displays to the right of the Value List panel.

**Step 3** Click **Edit...** to open the Edit Collection dialog box.

**Step 4** To edit the collection, make any necessary changes on the General tab and click **OK**.

**Step 5** To edit the values for the collection, click the Values tab, make changes. Then click **OK**.

Deleting a Collection

Follow this procedure to delete a collection:

**Step 1** Select **Administrative > Value Lists/Collections** to open the Manage Collections dialog box.

**Step 2** Select the value list for which you want to delete a collection.

The Collection panel displays to the right of the Value List panel.

**Step 3** Select a collection and click **Delete**.

Adding or Deleting Access to a Shared Collection

**Step 1** Select **Security > Security Center** to open the Security Center window.

The expanded section shows all User Groups or all Users. Only one section can be expanded at a time.

**Step 2** Select a User Group or a User.

The Shared Reports and Shared Collections panel on the right of the window display reports and data collections that are currently shared with that User Group or User.

**Step 3** To add or delete shared collection, click the **Edit...** button at the top right of the Shared Collections panel. The Shared Collections dialog box opens. It shows all collections, arranged in folders.
a. To add a collection for this User Group or User, locate and select (check) the collection. Then click Close.

b. To remove a collection for this User Group or User, locate and deselect (uncheck) the collection. Then click Close.

**Step 4** Click Done to close the Security Center window.

---

### Viewing Diagnostics

Select Administration > Diagnostics to open a page that displays the current metrics and status for:

- **Active Users** - Lists the users who ran reports, that caused data to be loaded from the database, in the past one hour.

  Note: The report name may appear blank if the user performed some administrative tasks after loading the report.

- **Active Administrators** - Lists the Administrative Users who were active in the past one hour.

- **User Distribution by Server** - Lists the Users who were active (performing administrative tasks or running reports) in the past one hour.

- **Biggest Reports Run Today** - Lists the 5 biggest reports run in the past 24 hours.

- **Report Diagnostics** - Lists reports that match the following parameters:
  - Historical report configured with post-query filtering on key criteria field
  - Real-time report that return more than 50 rows
  - Historical report that return more than 8000 agents
  - Historical report that return more than 4000 rows

- **Active Reports** - Lists the reports that caused data to be loaded from the database in the past one hour.

In addition to these tables, the Diagnostics page also allows you to view the load on the system in terms of the ideal user specified in the Bill of Materials. To recalculate this value, click Recalculate.

The information on this page is not refreshed automatically. You need to close the page and reopen it.
Figure 29: Diagnostics Page 1 of 3

Figure 30: Diagnostics Page 2 of 3

Figure 31: Diagnostics Page 2 of 3
Administering Data Sources

Controlling Report Data Sources

Data Sources (page 87)
Adding a Data Source (page 88)
Editing a Data Source (page 89)
Deleting a Data Source (page 90)
Data Source Status (page 90)

Data Sources

A Data Source represents a database against which reports can be run.
In this release, Unified IC supports the SQL and Informix data source types.
From the Data Sources window, you can add, edit, and remove a data source.
At installation, the Data Sources window is populated by default with the names of two data sources: Unified IC and Unified ICM/UCC.
The Unified IC data source is configured by default. The Unified ICM/UCC data source is not.
See:
Adding a Data Source (page 88)
Editing a Data Source (page 89)
Adding a Data Source

Follow the steps below to add a Data Source.

**Step 1** Select **Administrative > Data Sources** to open the Manage Data Sources window.

**Step 2** Click **Add** to open the Add Data Source window.

**Step 3** Complete this window as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Source Name</td>
<td>Enter the name of the data source server.</td>
</tr>
<tr>
<td></td>
<td><strong>Note that</strong> the Manage Data Source dialog provides only one field for Database Name.</td>
</tr>
<tr>
<td></td>
<td>If you add a Data Source for the Archiver, enter the archiver-data on this dialog box. On the Archiver server, use the SQL Server Administration to add the Windows domain Unified IC User as a new security login and set with db_datareader access to all three Archiver databases.</td>
</tr>
<tr>
<td>Server (IP or DNS: port)</td>
<td>Enter the IP address or DNS name for the server.</td>
</tr>
<tr>
<td></td>
<td>Append the port for an Informix database. Port is not typically needed for SQL Server.</td>
</tr>
<tr>
<td>Type</td>
<td>From the dropdown, select Informix or SQL Server database server.</td>
</tr>
<tr>
<td>Database name</td>
<td>Enter the database name</td>
</tr>
<tr>
<td>Instance</td>
<td>Only used for Informix, specify the instance name of the database you are connecting to.</td>
</tr>
<tr>
<td>Locale</td>
<td>Only currently used for Informix database. Specify the charset for the database locale.</td>
</tr>
<tr>
<td>Windows Integrated Authentication</td>
<td>If you use SQL with Windows Authentication (preferred), then check this.</td>
</tr>
<tr>
<td></td>
<td>If you connect to an Informix database or to older version of SQL, such as a Unified ICM 7.2 database, then leave this unchecked</td>
</tr>
<tr>
<td>Database User ID</td>
<td>Defaults if Windows Integrated Authentication is checked.</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enter Database User ID</td>
<td>Enter Database User ID if Windows Integrated Authentication is unchecked.</td>
</tr>
<tr>
<td>Password and Confirm Password</td>
<td>Enter and confirm the password for the database user.</td>
</tr>
<tr>
<td>Timezone</td>
<td>Select the correct timezone for the server.</td>
</tr>
<tr>
<td>Workstation ID</td>
<td>Leave blank</td>
</tr>
</tbody>
</table>

**Step 4**  Click **Test Connection**.

If the status is not Online, review the error message to determine the cause and edit the data source accordingly. Repeat the steps until the data source is Online.

**Step 5**  Click **Save**.

The Add Data Source window closes. You return to the Data Sources window. The new data source appears on the list.

**Editing a Data Source**

**Step 1**  Select **Administrative > Data Sources** to open the Data Sources window.

**Step 2**  Select the data source and click **Edit** to open the Edit Data Source window.

**Step 3**  Change fields as necessary.

**Note:** In a scaled deployment, with more than one CUIC database, the data source for all CUIC databases must have the same configuration and the same timezone.

**Step 4**  Click **Test Connection**.

If the status is not Online, review the error message to determine the cause and edit the data source accordingly. Repeat the steps until the data source is Online.

**Step 5**  Click **Save**.

The Edit Data Source window closes. You return to the Data Sources window.

**Step 6**  Select **Administrative > Data Source Status** to verify that the edited data source shows an Online status.

If the status is not Online, make sure that the IP address is correct. Also, review any error messages to determine the cause and edit the data source accordingly until the it shows the Online status.
Deleting a Data Source

**Step 1** Select **Administrative > Data Sources** to open the Data Sources window.

**Step 2** Select the data source and click **Remove** to open the Edit Data Source window.

**Step 3** Click OK at the *Are you sure?* message.

Data Source Status

This screen displays the status of the data sources you have added.

From this window, you can:

- Refresh the connection.
- Encrypt the database connection string.

**Note:** You will not be able to edit the connection string after you encrypt it.
Part 4: The Cisco Unified IC Web Application

Chapters in Part 4 explain:

The User Interface (page 93)

Working with Dashboards (page 99)

See also Troubleshooting the User Interface (page 297).
Chapter 10

The Unified Intelligence Center Interface

This chapter contains the following topics:

- Initial View at Login, page 93
- Localization, page 93
- Menus and Menu Access, page 96

Initial View at Login

The menus and features you see when you log in to Unified Intelligence Center depend on your user role, on your user profile, and on the dashboards that are shared with you.

By default, a successful login opens to the Welcome tab with the Cisco logo. You can change this by editing your user tab (Profile > User Profile) to uncheck Show Welcome Screen. When the Show Welcome Screen is unchecked, your initial view shows any dashboard(s) that have been shared with you.

Localization

Cisco Unified Intelligence Suite has been tested as an English-only application. The user interface is not localized. Only the online help for the report templates has been localized, as noted below.

Unified IC provides localized report templates and localized online help for these languages:

- Chinese - zh_CN (Simplified, Taiwan)
- Chinese - zh_TW (Traditional, China)
- Danish - da_DK (Denmark)
- Dutch - nl_NL (Netherlands)
• French - fr_FR (France)
• French - fr_CA (Canada)
• German - de_DE (Germany)
• Italian - it_IT (Italy)
• Japanese - ja_JP (Japan)
• Korean - kp_KR (South Korea)
• Portuguese - pt_BR (Brazil)
• Russian - ru_RU (Russia)
• Spanish - es_ES (Spain)
• Swedish - sv_SE (Sweden)

See Importing New and Localized Templates from Cisco.Com (page 143)

SQL Server Collation for Localization

The installation and configuration checklists instruct you to select Latin1_General_BIN collation during the SQL Server installation. This collation is appropriate for most languages.

For the following languages, use the indicated collation:

• To view Japanese templates, select the Japanese SQL Collation designator.
• To view Chinese Simplified, select Chinese_PRC.
• To view Chinese Traditional, select Chinese_Taiwan_Stroke.
• To view Korean, select Korean_Wansung.
• To view Russian, select Cyrillic_General.

Changing the Collation

If SQL Server 2005 is already installed on CUIC server with Latin1_General collation selected, and if you intend to view Korean, Russia, Japanese, or Chinese templates, you must change the SQL collation to match the language.

Doing this does not affect the display of the English-language User Interface screens.

Follow this procedure to convert SQL collation from Latin1_General_BIN:
1. Perform a full SQL backup of the Unified IC database using the Microsoft SQL Backup and Restore Utility.

If there are any other custom databases on this system, you must back them up as well. SQL Server 2005 deletes all custom databases during this process.

2. Remove the SQL database engine.

To do this:

- From Control Panel > Add/Remove Programs, remove Microsoft SQL Server 2005.
- At the Component Selection interface, check MSSQLSERVER: Database Engine only
- Click Next to continue and to remove the database engine.


To do this:

- At the Components to Install screen, check SQL Server Database Server only.
- At the Collation Settings screen, click Collation Designer and Sort Order.
- Select the collation designator you need, and select Binary sort order.
- Continue with the installation.


5. Restore your database using SQL Backup and Restore Utility.

Multilingual User Interface

Before you download and install Unified IS, make sure that the Windows operating system (OS) language is compatible with the Unified IS reporting template language.

If the Windows OS is in English, and if you require Japanese, Chinese, Korean, or Russian templates, please use localized Windows 2003 servers or use the Multilingual User Interface (MUI) option to install the intended language in the Windows 2003 server.

If the OS and template language usage is not compatible, you may not be able to read the reports.

Note: MUI is not downloadable from Microsoft web page. It is sold to the corporation as an option of Windows 2003. Not all Windows 2003 owners have it.
This table gives a brief description of each item on the Unified IC navigation menu, notes when a menu item is restricted to a specific user role, and points you to the section that details the menu.

The menus you can access depend on how your user role is edited.

<table>
<thead>
<tr>
<th>This Menu</th>
<th>Available to</th>
<th>Enables Users To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reports</td>
<td>All Users</td>
<td>Browse, view, and generate reports to which they have been given access.</td>
</tr>
<tr>
<td>Administrative</td>
<td>Admin Users</td>
<td>Define a new data source. Edit an existing data source.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Check the status of defined data sources.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Define Value Lists and Collections.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Flush the Global Cache.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View Diagnostics.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See Administrative Menu (page 97).</td>
</tr>
<tr>
<td>Report Admin</td>
<td>Admin Users</td>
<td>Create and manage dashboards.</td>
</tr>
<tr>
<td></td>
<td>Report Designer Users</td>
<td>Create new reports.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Manage existing reports.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Import report templates.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Review and manage scheduled reports.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See Report Administration Menu (page 97).</td>
</tr>
<tr>
<td>Security</td>
<td>Admin Users</td>
<td>Add users and user groups.</td>
</tr>
<tr>
<td></td>
<td>Security Admin Users</td>
<td>Review and edit existing users and user groups.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Provision user roles and permissions.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See Security Menu (page 97).</td>
</tr>
<tr>
<td>Profile</td>
<td>All Users</td>
<td>View and edit your profile where you can set time zone and style sheet preferences.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See Profile Menu (page 98).</td>
</tr>
<tr>
<td>Help</td>
<td>All Users</td>
<td>Access online help.</td>
</tr>
</tbody>
</table>
Reports Menu

The Reports Menu is available to all users. It displays only the reports that the logged on user is authorized to view and launch.

Administrative Menu

Users with the Admin (page 71) can access this menu to work with:

- Data Sources (page 87)
- Value Lists (page 80) and Collections (page 82)
- Viewing Diagnostics (page 85)
- Flushing the Cache (page 148)

Report Administration Menu

Users with the Admin (page 71) and Report Designer (page 71) roles can access this menu to control advanced reporting features, such as:

- Adding a New Dashboard (page 100)
- Working with the Report Wizard (page 149)
- Opening Report Manager (page 127)
- Importing Reports (page 142)
- Working with Scheduled Reports (page 135)

Security Menu

Users with the Admin and Security Admin roles can access options on the Security menu to control user administration.

For Admin Users, the Security Menu has five options. For Security Admins, it has four items.

- User List (page 67)
- Edit User Roles (page 70)
- User Groups (page 73)
Profiles Menu

The Profile menu gives every user access to his or her own profile and the history of their activity in the system.

Note: Admins and Security Admins can access any user profile from the Security menu by selecting Security -> User List, locating the user, and clicking Edit.

See User Profile Tab (page 69) and User History Tab (page 69).
Chapter 11

Working with Dashboards

Dashboards

About Dashboards (page 99)

Adding a New Dashboard (page 100)

The Dashboard Menu (page 100)

Creating a Dashboard Item (page 101)

Sharing a Dashboard (page 104)

Editing Dashboard Properties (page 104)

Using Dashboard Design Mode (page 105)

About Dashboards

The Unified IC interface is organized by dashboards, which are accessed by tabs across the home page, below the menubar.

Figure 32: Dashboards
Dashboards are “home pages” that can display reports, report lists, and web-based corporate and reporting elements relevant to specific workflows and responsibilities.

Administrators and Reporting Designers are authorized to create dashboards and to add items to them and can customize, name, and share them for a specific user or user group.

Unless dashboards have been created for you or shared with you by an administrator, only one dashboard is available to you when you first log in. This is the dashboard with the tab named Welcome.

Adding a New Dashboard

To create a dashboard, select **Report Admin > New Dashboard**.

**Note:** Only users with the role of Admin or Report Designer can create dashboards and can modify, edit, delete, or share them with others.

**Step 1**
Select **Report Admin > New Dashboard** to open the New Dashboard dialog box.

**Step 2**
Enter the name to display on the tab of the new dashboard, using a maximum of 40 characters.

**Step 3**
Select whether the dashboard is Public or Personal.

*Public* dashboards are visible to all users in the Admin, Security Admin and Report Designer Roles. They are visible to Restricted Viewers only when the owner shares them.

*Personal* dashboards are not visible to any users or groups unless shared by the owner of the dashboard.

See [Sharing a Dashboard](page 104).

**Step 4**
Click **OK** at the message that the dashboard has been created.

The screen refreshes to display the new dashboard tab on your home page.

Dashboards appear in numeric and then alphabetical order. Use the > button at the right of the panel to scroll to see dashboards that do not fit on the page.

The Dashboard Menu

The Dashboard menu has six icons and a checkbox.

<table>
<thead>
<tr>
<th>Dashboard Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slideshow mode</td>
<td>Opens a new window that cycles through all the items in the dashboard, creating a slideshow.</td>
</tr>
<tr>
<td></td>
<td>To exit slideshow mode, press Esc.</td>
</tr>
</tbody>
</table>
### Dashboard Menu Item

<table>
<thead>
<tr>
<th>Dashboard Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a New Dashboard Item</td>
<td>Allows you to add a new dashboard item.</td>
</tr>
<tr>
<td>Save this Dashboard</td>
<td>Saves the current state of the dashboard.</td>
</tr>
<tr>
<td>Share this Dashboard</td>
<td>Allows you to share the dashboard with other users.</td>
</tr>
<tr>
<td>Delete this Dashboard</td>
<td>Permanently deletes the dashboard.</td>
</tr>
<tr>
<td>Edit this Dashboard</td>
<td>Allows you to change the dashboard name and to change its properties (Public or Personal).</td>
</tr>
<tr>
<td>Dashboard Design mode checkbox</td>
<td>Click this checkbox to open the dashboard in Design Mode, where you can move and resize dashboard items.</td>
</tr>
<tr>
<td></td>
<td><strong>Click Save</strong> to save changes.</td>
</tr>
<tr>
<td></td>
<td>This checkbox is only visible after you have added items to the dashboard.</td>
</tr>
</tbody>
</table>

### Creating a Dashboard Item

A new dashboard is a blank canvas. You can customize it by adding items to it.

After you add items, you can rearrange and delete them in dashboard design mode.

See also:

- Adding a Report to a Dashboard (page 102)
- Adding a Report List to a Dashboard (page 102)
- Adding a Scheduled Report to a Dashboard (page 102)
- Adding a Widget to a Dashboard (page 103)
- Adding a URL Frame to a Dashboard (page 104)
- Using Dashboard Design Mode (page 105)
Adding a Report to a Dashboard

Step 1  From the dashboard menu, click the Create a New Dashboard Item Type icon to open the New Dashboard Item dialog box.

Step 2  From the Item Type dropdown, highlight Report. Then click Select to open the list of reports.

Step 3  Locate and highlight the report you want to add. You can add only one report at a time.

Step 4  Click Submit.

A message displays indicating that the report will be added to the left of the dashboard and that it may overlap other items.

Step 5  Click OK to close the message.

Step 6  Check the Dashboard Design checkbox to move the new item. Then click Save.

Note: New items are placed in the top left corner of the dashboard so as not to cover previously-configured items. After adding an item, you might need to enter dashboard design mode to move or resize the new item.

Adding a Report List to a Dashboard

Step 1  From the dashboard menu, click the Create a New Dashboard Item Type icon to open the New Dashboard Item dialog box.

Step 2  From the Item Type dropdown, highlight Report List and click Submit.

A message displays indicating that the report will be added to the left of the dashboard and that it may overlap other items.

Step 3  Click OK to close the message.

Step 4  Check the Dashboard Design checkbox to move the new item. Then click Save.

Note: New items are placed in the top left corner of the dashboard so as not to cover previously-configured items. After adding an item, you might need to enter dashboard design mode to move or resize the new item.

Adding a Scheduled Report to a Dashboard

Step 1  From the dashboard menu, click the Create a New Dashboard Item Type icon to open the New Dashboard Item dialog box.
Step 2  From the Item Type dropdown, highlight **Scheduled Report**. Then click **Select**.

This opens a list of scheduled reports.

Step 3  Locate and highlight the scheduled report you want to add.

**Note:** You can add only one scheduled report at a time.

Step 4  Click **Submit** twice.

A message displays indicating that the report will be added to the left of the dashboard and that it may overlap other items.

Step 5  Click **OK** to close the message.

Step 6  Check the Dashboard Design checkbox to move the new item. Then click **Save**.

**Note:** New items are placed in the top left corner of the dashboard so as not to cover previously-configured items. After adding an item, you might need to enter dashboard design mode to move or resize the new item.

Adding a Widget to a Dashboard

This is an advanced feature that should be used by those familiar with web development.

Unified IC is not installed with any canned widgets, but you can copy them from online sources such as Widgetbox.com.

Step 1  Locate the widget you want to add and copy the widget code to the Windows Clipboard.

Step 2  From the dashboard menu, click the **Create a New Dashboard Item Type** icon to open the New Dashboard Item dialog box.

Step 3  From the Item Type dropdown, highlight **Widget**.

Step 4  Paste the widget code in the Content box.

Step 5  Click **Submit**.

A message displays indicating that the report will be added to the left of the dashboard and that it may overlap other items.

Step 6  Click **OK** to close the message.

Step 7  Check the Dashboard Design checkbox to move the new item. Then click **Save**.

**Note:** New items are placed in the top left corner of the dashboard so as not to cover previously-configured items. After adding an item, you might need to enter dashboard design mode to move or resize the new item.
Adding a URL Frame to a Dashboard

This feature allows you to add framed URLs to a dashboard which provides the ability to embed any Web-based content to a dashboard.

Some pages might not display properly if they contain advanced animation components.

Step 1
From the dashboard menu, click the Create a New Dashboard Item Type icon to open the New Dashboard Item dialog box.

Step 2
From the Item Type dropdown, highlight URL Frame.

Step 3
Enter the URL in the Content field. Then click Submit.

A message displays indicating that the report will be add to the left of the dashboard and that it may overlap other items.

Step 4
Click OK to close the message.

Step 5
Check the Dashboard Design checkbox to move the new item. Then click Save.

Note: New items are placed in the top left corner of the dashboard so as not to cover previously-configured items. After adding an item, you might need to enter dashboard design mode to move or resize the new item.

Sharing a Dashboard

The Share this Dashboard icon is enabled on the dashboard for the dashboard owner.

To share a dashboard:

1. Click the Share This Dashboard icon on the dashboard menu to open the Manage Access dialog box. This shows the list of the available users and user groups.

2. Check the boxes in the status column to the left of each group or user with which you want to share your dashboard.

3. Click Submit.

Note: Restricted Users can view reports that they could otherwise not access when Admins and Report Designers add those reports to a dashboard and share the dashboard.

Editing Dashboard Properties

The Edit this Dashboard icon is enabled on the dashboard menu for the dashboard owner.
Click the Edit this Dashboard icon to:

- Change the dashboard name.
- Change the dashboard property (Public or Personal).

Using Dashboard Design Mode

After you have added items to a dashboard, you can customize the way they appear by entering design mode.

In design mode, the appearance of the dashboard changes.

<table>
<thead>
<tr>
<th>To Enter Design Mode</th>
<th>Check Dashboard Design Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To Move an Item</strong></td>
<td>Select the item.</td>
</tr>
<tr>
<td></td>
<td>Click in the header, and drag the item.</td>
</tr>
<tr>
<td><strong>To Resize an Item</strong></td>
<td>Select the item.</td>
</tr>
<tr>
<td></td>
<td>Place your cursor on the sides or corner of the item to enlarge or reduce the size.</td>
</tr>
<tr>
<td><strong>To Delete an Item</strong></td>
<td>Select the item.</td>
</tr>
<tr>
<td></td>
<td>Click the Close button (the red x) and respond Yes to the 'Are You Sure' message.</td>
</tr>
<tr>
<td><strong>To Exit Design Mode</strong></td>
<td>Click the Save icon and exit after adding or deleting an item.</td>
</tr>
</tbody>
</table>
Part 5: Cisco Unified IC Reporting

Unified IC is a web-based reporting interface that is installed with stock reporting templates. It provides tools for managing the data sources and selection values for the stock templates as well as tools for modifying and customizing them.

**Note:** Your Cisco Support Provider can assist you with stock templates only.

Chapters in Part 5 document:

- Basic Reporting (page 109)
- Advanced Reporting (page 127)
- Maintaining Reports (page 141)
- Caching (page 147)
- Report Wizard (page 149)
- Charts and Gauges (page 159)
- Reporting Concepts (page 167)

See also Troubleshooting Reporting (page 298).
Basic Reporting

This section explains how to create reports and how to work in the report interface.

This chapter contains the following topics:

- Generating a Report, page 109
- Simple Filter Dialog Box, page 110
- The Report Interface, page 111
- Report Categories and Subcategories, page 119
- Report Fields, page 119
- Report Field Data Source, page 120
- Report Summaries, page 121
- Cisco Stock Report Templates, page 121

Generating a Report

The basic procedure to run a report is as follows:

**Step 1**

Locate and select the report you want to run.

You can do this by:

- Selecting the report from the Reports menu (page 97).
- Selecting the report from the Report Manager (page 127) or the Report List (page 127) on the dashboard and then selecting View.

What you see next depends on how the report was designed.

- If the Report Designer or Admin saved the report to bypass the filter option, the report opens directly. For details on bypassing the filter, see Saving Reports (page 113).
- If the Report Designer did not bypass the filter, the simple filter dialog box (page 110) opens.

**Step 2** Complete the simple filter dialog box.

**Step 3** Click **Run**.

The report displays in a new window as a grid, a chart, or both, depending on how it is configured.

---

**Simple Filter Dialog Box**

Use the simple filter dialog box to specify the data used to populate the report.

The fields you see on this dialog box differ slightly for Historical and for Real Time reports.

For both Historical and for Real Time, you filter for values. For an Historical report, you also filter for the date/time range.

**Note:** For two reports, Agent Historical All Fields and Agent Not Ready, the simple filter contains a Value List, a **From:** date field and a **To:** date field. These reports use Anonymous Blocks as the data source, and From: and To: have been added as parameters. See Report Wizard Parameters Tab (page 154).

---

**Step 1** If you selected an Historical report template, the simple filter dialog box has an Historical Filtering panel.

*Figure 33: Historical Filter Panel*

<table>
<thead>
<tr>
<th>Historical Filtering <em>All times are in the timezone of the data source</em></th>
</tr>
</thead>
<tbody>
<tr>
<td>☑ Relative Range ☑ Explicit Range</td>
</tr>
<tr>
<td><strong>Today</strong></td>
</tr>
<tr>
<td><strong>All Day</strong> □ Only Within a Certain Timespan</td>
</tr>
<tr>
<td>□ Every Day □ Only Certain Days</td>
</tr>
</tbody>
</table>

a. Select **Relative Range** to filter for Today, Yesterday, This Week, Last Week, This Month, Last Month, Year to Date, or Last Year.

b. Select **Explicit Range** to enter a starting and ending date range.

c. Select **All Day** to report on a 24-hour period, or select **Only Within a Certain Timespan** to enter a starting and ending time range.

d. Select **Every Day** to report on all days of the week, or select **Only Certain Days** to display Sun through Sat checkboxes.
Step 2

**If:** you are an Admin or a Report Designer

**Then:** select one or more values in the Available Values column and move them to the Selected Values column.

**If:** you are a Restricted User who has access to Collections

**Then:** choose the Collection and then select values in the collection

Values, similar to *Items* in WebView reports, are valid filters for the report. For example, when you create a Call Type report, you see a list of Call Type values.

Report designers can limit the values that appear on the Simple Filter dialog box. See Managing Users' Value Lists and Collections (page 79).

Restricted Users must be given access to collections. See Adding or Deleting Access to a Shared Collection (page 84).

Step 3

Click **Run** to generate the report.

Step 4

Click **Refresh Values** to update the items on this panel. Do this, for example, so that new values appear on the list after configuration changes.

Value Lists are kept as static snapshots in the database and remain exactly as defined until the list is manually refreshed.

Once the report opens, you can use the Simple Filter icon on the report interface (page 111) to change your selections for date/time range and values.

The Report Interface

A generated report displays in a new web page and has the following interface:

- A report **title**.
- The total **record count** represented in the report (top left corner).
- A tabular **grid**, showing the data returned by the filter (All stock templates display as tables. There are no default charts or gauges in this release.)
- **Rows** of data, grouped according to settings in the Report Wizard Formatting Tab (Grouping Definition) (page 156).

The maximum number of rows returned in a report is set during Configuration.

- Column **headers**. (Click a header to sort the data by that field.)
- Field **footers** that show summary data if the report has been configured to provide it.
• **Icons**

A row of icons displays across the top of the report grid. Depending on your user role, you can see some or all of these icons.

From left to right, the icons are **Save, Simple Wizard, Chart, Refresh, Export, Simple Filter, Advanced Filter, Print, Help, and SQL**.

• **A list of parameters** at the bottom of the report, showing values selected as part of the filter.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>Click this icon to open the dialog that gives you the option to Save (page 113) or to Save As (page 113).</td>
</tr>
<tr>
<td>Simple Wizard</td>
<td>Click this icon to open the Simple Wizard (page 114), where you can personalize the report content by showing and hiding columns, changing column names and column order, and setting thresholds.</td>
</tr>
<tr>
<td>Chart</td>
<td>Click this to display the default chart for this report. If no chart has been defined for this report, this action opens the Charting and Graphing (page 159) interface where you can create a chart or gauge.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Click this icon to requery the database for fresh data. Typically this is used only for real-time reports.</td>
</tr>
<tr>
<td>Export</td>
<td>Click this icon to export the report to Microsoft Excel. See Exporting Data (page 115).</td>
</tr>
<tr>
<td>Simple Filter</td>
<td>Click this icon to reopen the Simple Filter (page 110), where you can change your initial filters and rerun the report.</td>
</tr>
<tr>
<td>Modify Report Filtering</td>
<td>This icon is visible only to Admins. Click it to open the Advanced Filter (page 117) dialog box.</td>
</tr>
<tr>
<td>Print</td>
<td>Clicking this icon opens a printable version of the report and automatically attempts to print the report to your default printer. Wide reports print in successive pages.</td>
</tr>
<tr>
<td>Help</td>
<td>Click this icon to open online help.</td>
</tr>
<tr>
<td>SQL Button</td>
<td>This button is visible only to Admins and Report Designers. It displays a read-only view of the SQL query used to generate the report. This is useful for troubleshooting.</td>
</tr>
</tbody>
</table>
Save

Clicking the **Save** icon from a report opens a dialog box that asks if you are performing a Save or a Save As operation.

Selecting **Save** saves the report and displays a message saying that you may need to refresh the report to see the change.

In most cases, it is best to select Save As.

Do not save changes to a stock report template. Your Support Provider cannot assist you in troubleshooting altered stock reports. Keep the stock reports unchanged, and make any changes to cloned (Save As) copies of them.

Report Types:

- A Personal report, that only you can use or share.
- A Public report, that other users can use.
- An Administrative report, that only Admin users can use. Save a report as Administrative, for example, when you have not finished designing it or when you want to test it before making it a Public report.

Restricted Viewers can save Personal Reports only.

Admins and Report Designers can save all reports.

Save As

Clicking the **Save** icon from a report opens a dialog box that asks if you are performing a Save or a Save As operation.

Selecting **Save As** displays the Save Report dialog box.

Use Save As to clone a stock report template and to save a new copy of a report in its current format. The saved report will include any changes you have made with the Simple Wizard (page 114).

Restricted Viewers can save Personal Reports only.

Admins and Report Designers can save all reports.

Complete the Save As dialog box as follows:

<table>
<thead>
<tr>
<th><strong>Report Name</strong></th>
<th>Enter a new name for the report.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> Names containing more than 100 characters are truncated.</td>
<td></td>
</tr>
</tbody>
</table>
Options are to save as:

A Personal report, that only you can use or share.

A Public report, that other users can use.

An Administrative report, that only Admin users can use. Save a report as Administrative, for example, when you have not finished designing it or when you want to test it before making it a Public report.

Options are to save as:

A Real Time report

An Historical report

**Note:** Saving a Real Time report as an Historical report, or vice versa, is not advisable.

If you save a Real Time as an Historical, the Date/Time filters are greyed out, but the report does not run unless you access the Report Wizard Data Settings Tab (page 155) and edit the Key Criteria and Historical Key Criteria fields.

Check this box so that users can run this report directly, without the option to filter.

If you do this, filter the report first to limit the items that are returned. If you do not filter before checking this option, Unified IC selects all items to process for the report.

Select the category or subcategory in which you want to save the report. See Report Categories (page 119).

Click **OK** to save the report with a new name and type.

**Simple Wizard**

Click the Simple Wizard icon to open the Simple Wizard dialog box.

This dialog box has two panels: **Hidden** and **Visible**.

There are two buttons under the Visible panel: **Rename...** and **Thresholds...**

Use this dialog box as follows:

<table>
<thead>
<tr>
<th>To:</th>
<th>Do This:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hide/Show Fields</strong></td>
<td>Select and move fields from Hidden to Visible status, or vice versa. Then click <strong>Submit</strong> to refresh the report.</td>
</tr>
</tbody>
</table>
Do This:

<table>
<thead>
<tr>
<th>To:</th>
<th>Do This:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reorder Visible Fields</td>
<td>Select Visible fields and use the up and down arrows to change the order in which those fields (columns) display in the report. Then click Submit.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You cannot reorder the field(s) on the list if they are defined as grouped fields in the Report Wizard Formatting Tab (Grouping Definition) (page 156).</td>
</tr>
<tr>
<td>Rename Fields</td>
<td>Select a Visible field and click Rename to change the name that displays in the report. Then click Submit to refresh the report.</td>
</tr>
<tr>
<td></td>
<td>To rename a hidden field, first move it to the Visible panel.</td>
</tr>
<tr>
<td>Create Thresholds</td>
<td>Select a Visible field and click Thresholds to display the Edit Thresholds dialog box. See Thresholds (page 133).</td>
</tr>
</tbody>
</table>

For more on Visible and Hidden reports, see Report Fields (page 119).

Exporting a Report to Excel using the Export command

You can export report data in .xls format to open locally with Microsoft Excel.

The report grid is exported exactly as it is displayed in Unified IC, with thresholds applied.

The only exception is integer data shown as HH:MM:SS. The report designer has the option of exporting this data as integer values so that it can be used in Excel formulas. If that option was not selected, the data will be exported as a string in HH:MM:SS string format.

**Microsoft Excel must be installed on the computer from which you launch the browser.**

Click the Export icon.

<table>
<thead>
<tr>
<th>If Excel is not installed on the system from which you launched the browser to sign in to Unified IC.</th>
<th>Then You see an error message.</th>
</tr>
</thead>
<tbody>
<tr>
<td>If Excel 2003 is installed on the system.</td>
<td>The Excel report document opens in a new browser window.</td>
</tr>
<tr>
<td>If Excel 2007 is installed on the system.</td>
<td>A dialog box opens, giving the option to Open or Save.</td>
</tr>
<tr>
<td></td>
<td>Click Open to open the Excel report document in a new browser window.</td>
</tr>
</tbody>
</table>
Then

If

Click **Save** and follow prompts to download and save the file.

Exporting a Report to Excel using Permalinks

You can also export real-time reports and reports that have filtered embedded, to Excel using the report permalinks. For more information on permalinks, see **Report Permalinks (page 129)**.

Before you perform this task:

1. Create a CUIS report and run it for a filtered and relative date range, usually for a specific set of Skill Groups or Call Types for say *This Week*.
2. Save a copy of this report with the filters intact and then follow the steps below.

<table>
<thead>
<tr>
<th><strong>Step</strong></th>
<th><strong>Action</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong></td>
<td>Open the <strong>Reports Manager</strong>.</td>
</tr>
<tr>
<td><strong>2</strong></td>
<td>Right-click the report that you want to export to Excel and select <strong>Report Info</strong>.</td>
</tr>
<tr>
<td><strong>3</strong></td>
<td>In the <strong>Report Info</strong> dialog box, copy the URL from the <strong>HTML Grid Permalink (Copy &amp; Paste)</strong> field to your clipboard.</td>
</tr>
<tr>
<td><strong>4</strong></td>
<td>Open <strong>Microsoft Excel</strong> and from the Data menu, choose <strong>Import</strong>.</td>
</tr>
<tr>
<td><strong>5</strong></td>
<td>In the <strong>New Web Query</strong> dialog box, paste the URL that you copied from the Report Info dialog box in the Address field.</td>
</tr>
<tr>
<td><strong>6</strong></td>
<td>Press <strong>Go</strong>. Excel displays the report preview.</td>
</tr>
<tr>
<td><strong>7</strong></td>
<td>Click <strong>Import</strong>. Excel prompts you to choose the insertion point for the imported data.</td>
</tr>
<tr>
<td><strong>8</strong></td>
<td>Select the cell in the Excel spreadsheet that you want to make the top left corner of your new report.</td>
</tr>
<tr>
<td><strong>9</strong></td>
<td>Click <strong>OK</strong>. The CUIS Report data is imported into Excel.</td>
</tr>
</tbody>
</table>

You can now filter or format the report to your requirements.
Advanced Filter

The Advanced Filter dialog box available to Admin and Report Designer users from the icon on the report grid and from the Edit Default Filters option on the Report Context menu (page 128).

Use it to change the filter criteria defined for the report.

Until you add parameters, the only field visible on this dialog box for real time reports is the ID (for example, Skill Group or Agent). The only fields visible for historical reports are Historical Date Field and the ID.

- Working with Advanced Filters (page 117)
- Adding a Value to an Advanced Filter (page 117)

Working with Advanced Filters

There are two panels on the Advanced Filter dialog box.

The panel on the left is the data type to be filtered.

The panel on the right changes dynamically to reflect parameters relevant to filtering the selected data type.

For example:

- If you select Historical Date, the panel on the right offers fields for date filters.
- If you select a percentage field, the panel on the right offers fields for filtering values.

Note: The %, time, and Average fields are all in integer values. For example, the time 00:01:20 must be entered as 80.

As you add each filter, click Apply.

The bottom of the dialog box shows the values added:

Click OK to refresh the report with the Advanced Filter selections.

Adding a Value to an Advanced Filter

The Advanced Filter dialog box available to Admin and Report Designer users from the icon on the report grid and from the Edit Default Filters option on the report context menu.

Fields must be flagged on the Report Wizard Field Properties (Field Map) tab (page 152) before they appear on the advanced filter.
To add a field to the Advanced Filter:

**Step 1**
Right-click a report and select **Edit Report** to open the Report Wizard.

**Step 2**
Click the Field Map tab.

**Step 3**
Right-click the field you want to add to the Advanced Filter.

**Step 4**
Select **Field Properties...**

*Figure 34: Thresholds*

![Field Properties](image)

This opens the Edit Field dialog box.

**Step 5**
On the General tab, check **Avail in advanced filtering dialog**.

**Step 6**
Click **Save and Close**.

**Step 7**
The field will now appear in the Advanced Filter dialog box.

*Figure 35: Field Added to Advanced Filter*

![Field Added to Advanced Filter](image)

**Caution:** It is possible to define filters on non-indexed columns in the tables, so care should be taken when defining a report to ensure the application of the filter does not adversely affect other reporting users.

See also **Working with Advanced Filters** (page 117).
Report Categories and Subcategories

When reports are created they are assigned to a category. Categories appear as folders in the Report List.

Users who are Admins and Report Designers can create categories and sub-categories in the Report Manager and can then drag-and-drop reports into them.

To create a category within Report Manager:

1. From the report list, right click a report folder and select Create Sub-Category.

   This opens a dialog box for the category name.

2. Type the category name and click OK.

3. Check Show Empty Categories and click the Refresh icon.

4. Drag and drop reports from other categories into the new category.

To delete a category:

1. Right click the category folder and select Delete Category.

2. Respond to the prompt (Are you sure: Yes | No).

Report Fields

Fields in report templates have the following characteristics:

<table>
<thead>
<tr>
<th>REPORT FIELD</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>DATABASE VALUE FROM QUERY</td>
<td>Report values for some fields are derived from the database directly.</td>
</tr>
<tr>
<td></td>
<td>This is indicated by a field description similar to that for the Queue Now</td>
</tr>
<tr>
<td></td>
<td>field in the Call Type Real Time All Fields Report: Derived from:</td>
</tr>
<tr>
<td></td>
<td>Call_Type_Real_Time.RouterCallsQNow.</td>
</tr>
<tr>
<td>FORMULA</td>
<td>Report values for some fields are derived from a calculation using one or</td>
</tr>
<tr>
<td></td>
<td>more fields in one or more tables.</td>
</tr>
<tr>
<td></td>
<td>This is indicated by a field description similar to that for the ASA5 fields</td>
</tr>
<tr>
<td></td>
<td>in the Call Type Real Time All Fields Report: Derived from:</td>
</tr>
</tbody>
</table>
Report fields can be either **Visible** or **Hidden**.

For each report, the Simple Wizard (page 114) displays panels of visible and hidden fields and has an interface that allows you to move fields from one panel to the other.

The online help topic for each report lists the fields that are visible by default for that report and the fields that are hidden. The list of visible and hidden fields for each report, and the datasource for each field is also available on the Report Wizard Field Map Tab (page 152).

Some hidden fields are necessary for calculations, filtering, or drilldowns but might not be useful as visible columns in the generated report.

An example are the hidden fields for DOW, DOY, Week, Month, and Year.

Hidden fields appear in the Simple Wizard in the query order. You can filter a long list of hidden fields by typing the first letter of the field name.

![Figure 36: Filtering Hidden Fields](image)

See also Report Field Data Source. (page 120).

### Report Field Data Source

Find the data source for any report field as follows:

**Step 1** Right-click the report from Report Manager.

**Step 2** Select **Edit Report** to open the Report Wizard.

**Step 3** Click the Field Map tab.

**Step 4** Locate and right-click the report field.
Step 5
Select Field Properties.

Step 6
Click the Data Source tab.

The Data Clause field displays the table name and table column; for example: 
AgentSkillGroup.FullName.


Report Summaries

Many reports have one or several Summary fields.

<table>
<thead>
<tr>
<th>For Columns that show:</th>
<th>The Summary is:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Counts</strong>, such as number of calls abandoned</td>
<td>A total</td>
</tr>
<tr>
<td><strong>Times</strong>, such as the average length of time associated with Ringing/offered tasks that were abandoned</td>
<td>An average</td>
</tr>
<tr>
<td><strong>Percentages</strong></td>
<td>An average</td>
</tr>
<tr>
<td><strong>Non metric or null data</strong></td>
<td>Blank</td>
</tr>
<tr>
<td>This is the case, for example, when a summary metric is not applicable or it is illogical to summarize the value when the data is null, and for intervals in certain call type reports, which are configured values.</td>
<td></td>
</tr>
<tr>
<td><strong>Custom formulas</strong></td>
<td>Calculated values added in the Formula tab of the Report Wizard Field Properties (page 152).</td>
</tr>
</tbody>
</table>

Cisco Stock Report Templates

This release of Cisco Unified Intelligence Suite is packaged with 19 stocktemplates. The stock templates are installed to %CUIS_HOME%\CuisWeb\InitialSetupReports. In addition, there are two Error Reports (page 122) and one Archiver Call Type Daily All Fields Report (page 125).

There are stock Unified ICM/CCE templates for:

- Agent (includes Agent Team)
- Call Type
- Service
Cisco Stock Report Templates

- Skill Group (includes Agent Skill Group)
- Trunk Group/IVR

These templates become available in the Unified IC interface when the Admin imports them (Report Admin > Import Report(s)) and sets the data source. See Importing Reports (page 142).

Report templates are well-formed XML files that contain all the information about the report including the SQL statement, field formatting, and Value List filter options.

The Unified IC stock report templates are based on the WebView All Fields templates. The online help topic for each template identifies its corresponding WebView template.

Unified IC offers extensive flexibility that allows you to customize these templates such that they are relevant and useful to your particular environment.

For example, you can move and rename fields, add your own fields, create drilldowns, and reconfigure tabular reports to open in a graphical format.

Although there is no mechanism in place to prevent it, do not change a stock template and save it with the same name. ALWAYS select Save As to save modified stock templates with new names or clone them before making changes to them. See Save As (page 113).

Note: All changes made to stock templates are recorded as Audit events in the ErrorLog table in the Unified IC database.

In the event that your changes to a stock template make the template unusable, you can:

- Reimport it.
- Request assistance from your Support Provider in reviewing the ErrorLog table in the Unified IC database.

Data for all templates are derived from real time data and from database views administrative workstation database (AW database) and the Historical Data Server (HDS). The Admin User must create a link to the datasource before reports are populated. See Data Sources (page 87).

System Error Reports

The installation creates a CuisReports folder in %CUIS_HOME\Cisco\CUI\CuisWeb. It contains two error report templates: Error Messages and Error Message Detailed Report.

Reports generated from these templates populate with report data from the Unified IC database table (ErrorLog).

Run these reports to monitor errors and to see when and by whom a report or a dashboard was added, modified, or deleted.

You need to import these templates as follows:
1. Select **Report Admin > Import Reports** to open the Import Reports dialog box.

2. At the Import Reports dialog box, click **Browse**, and navigate to 
   \%CUIS\_HOME\Cisco\CUIS\CuisWeb\CuisReports.

3. Select Error_Msg.xml and click **Open** to return to the Import Reports dialog box.

4. Click **Continue** to display the Data Source dialog box.

5. For Data Source, select Unified IC.

6. Repeat Steps 1 through 5 for the Error_Msg_Detail.xml.

**Error Messages Report (page 123)**

**Error Message - Detailed Report (page 124)**

**Error Messages Report**

The Error Messages report has the following columns, in this default order:

- DateTime
- User Name
- Report ID
- Server
- Referrer
- Build Number
- Administrator
- Restricted View
- Possible Resolution
- Behavior
- Able to Reproduce
- Other Information
- Exception
- Inner Exception

You can use the Simple Filter to hide, rename or move any of these columns.
Figure 37: Error Messages Report 1 of 3

<table>
<thead>
<tr>
<th>DateTime</th>
<th>User Name</th>
<th>Report ID</th>
<th>Server</th>
<th>Referrer</th>
</tr>
</thead>
<tbody>
<tr>
<td>7/14/2008 2:22:57.51</td>
<td>CCBU-DOC-AD\addmsl</td>
<td>ccbo-doc-137</td>
<td><a href="http://localhost/View">http://localhost/View</a></td>
<td></td>
</tr>
<tr>
<td>7/15/2008 2:52:41.9</td>
<td>CCBU-DOC-AD\addmsl</td>
<td>ccbo-doc-137</td>
<td><a href="http://localhost/View">http://localhost/View</a></td>
<td></td>
</tr>
<tr>
<td>7/15/2008 2:52:42.2</td>
<td>CCBU-DOC-AD\addmsl</td>
<td>ccbo-doc-137</td>
<td><a href="http://localhost/View">http://localhost/View</a></td>
<td></td>
</tr>
<tr>
<td>7/15/2008 3:03:34.9</td>
<td>CCBU-DOC-AD\addmsl</td>
<td>ccbo-doc-137</td>
<td><a href="http://localhost/View">http://localhost/View</a></td>
<td></td>
</tr>
<tr>
<td>7/15/2008 3:03:35.2</td>
<td>CCBU-DOC-AD\addmsl</td>
<td>ccbo-doc-137</td>
<td><a href="http://localhost/View">http://localhost/View</a></td>
<td></td>
</tr>
<tr>
<td>7/15/2008 3:03:42.4</td>
<td>CCBU-DOC-AD\addmsl</td>
<td>ccbo-doc-137</td>
<td><a href="http://localhost/View">http://localhost/View</a></td>
<td></td>
</tr>
<tr>
<td>7/15/2008 3:03:42.8</td>
<td>CCBU-DOC-AD\addmsl</td>
<td>ccbo-doc-137</td>
<td><a href="http://localhost/View">http://localhost/View</a></td>
<td></td>
</tr>
</tbody>
</table>

Figure 38: Error Messages Report 2 of 3

<table>
<thead>
<tr>
<th>Build Number</th>
<th>Administrator</th>
<th>Restricted View</th>
<th>Possible Resolution</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>3097</td>
<td>True</td>
<td>False</td>
<td>The ASP.NET application</td>
<td></td>
</tr>
<tr>
<td>3097</td>
<td>True</td>
<td>False</td>
<td>The ASP.NET application</td>
<td></td>
</tr>
<tr>
<td>3097</td>
<td>True</td>
<td>False</td>
<td>The ASP.NET application</td>
<td></td>
</tr>
<tr>
<td>3097</td>
<td>True</td>
<td>False</td>
<td>The ASP.NET application</td>
<td></td>
</tr>
<tr>
<td>3097</td>
<td>True</td>
<td>False</td>
<td>The ASP.NET application</td>
<td></td>
</tr>
</tbody>
</table>

Figure 39: Error Messages Report 3 of 3

Error Message - Detailed Report

This report shows data only if the Admin configured Tracing Enabled to True.

Reports generated from this template populate with report data from the Unified IC database table (ErrorLog).

The Error Message Detailed report has the following columns, in this default order:

- DateTime
- Report ID
- Message Level
You can use the Simple Filter to hide, rename or move any of these columns.

**Archiver Call Type Daily All Fields Report**

The installation creates an ArchiverReports folder in `%CUIS_HOME%\CuisWeb`. It contains the Call Type Daily All Fields report template.

This template is identical to the Call Type Historical All Fields report template.

This template populates with report data from the Archiver database, if you have deployed it.

You need to import this template as follows:

1. Select **Report Admin > Import Reports** to open the Import Reports dialog box.
2. At the Import Reports dialog box, click **Browse**, and navigate to `%CUIS_HOME\Cisco\CUIS\CuisWeb\ArchiverReports`.
3. Select `CallType_AllFields_Daily.xml` and click **Open** to return to the Import Reports dialog box.
4. Click **Continue** to display the Data Source dialog box.
5. For Data Source, select the source that was added for the Archiver.

**Archiver Reports and Unified IC Reports**

Historical reports using the data source Unified AW (HDS) are half-hour reports.

Archiver rolls up the half-hour data and creates daily reports showing aggregated data.
Chapter 12: Basic Reporting

Cisco Stock Report Templates
Chapter 13

Advanced Reporting

This chapter contains the following topics:

• Report Manager, page 127
• Scheduled Reports, page 135

Report Manager

Select Report Admin > Report Manager to open the list of reports.

From Report Manager, Admins and Report Designers can use the Report Context menu (page 128) to access report functionality.

Report List (page 127)
Report Context Menu (page 128)
Report Info (page 129)
Report Permalinks (page 129)
Drilldowns (page 130)
Thresholds (page 133)

Report List

Admins and Report Designers can add a Report List to the dashboard. See Adding a Report List to the Dashboard (page 102).
Figure 40: Report List

The Report List shows all the reports that are available to you.

The Report List allows for more control than the Report Menu, through the Report Context Menu (page 128).

Report Context Menu

Admin and Report Designer users see a report context menu when they right-click a report name in Report Manager or on the Report List.

The Management item on this context menu has its own submenu.

Figure 41: Report Context Menu

This table briefly explains each item on the Report Context menu and the Management submenu and points you to more information.
**Menu Item** | **Description**
--- | ---
**View** | Click this to launch the report. This might open Simple Filter dialog box (page 110), or it might open the report directly.

**Edit Report** | Click this to open the Report Wizard (page 149).

**Clone Report** | Click this to open the Report Wizard (page 149).

**Edit Default Filters** | Click this to open the Advanced Filter (page 117).

**Report Info** | Click this to open the Report Info (page 129) dialog box.

**Schedule** | Click this to open a filter dialog box. This is the first of a series of dialog boxes that lead you through setting up a schedule. See Scheduling Reports (page 135).

**Management** submenu

- **Rename Report** | Click to open a dialog box for Renaming a Report (page 144).
- **Delete Report** | Click to open the dialog box for Deleting a Report (page 145).
- **Edit XML** | Click to open a dialog box that displays the XML source for the report. See Editing Report XML (page 145).
- **Export** | Click to open the report XML in a browser window. See Exporting Report XML (page 145).
- **Report Security** | Not available in the current release.

### Report Info

This dialog box opens from the Report Context Menu and from the Schedule Context Menu.

Report Info is a read-only dialog box that shows:

- The data source for the report.
- The names and data type of all fields in the report.
- The URLs for the report's permalinks, which you can copy and paste to the clipboard.

### Report Permalinks

Report permalinks can be used to provide direct permanent content links to reports either through Excel or an HTML page.

The types of permalinks are:
• XML - used to generate XML data to be used by downstream processes rather than a web page or to populate a spreadsheet.

• HTML Grid permalinks - used for Excel Automation

• Interactive Grid - provide a direct link to the interactive grid thereby bypassing the main interface.

• WebQuery - used to pass dynamic parameters into a URL string to pull data into another tool such as a CRM

Permalinks allow you to embed a report so that it can be accessed directly. The person accessing it does not log in to the Unified IC application.

However, that user must already exist as a member of the CuisLocalUserGroup.

Drilldowns

Drilldowns allow you to create links from one report to another so that you can launch a sub-report from within the current report window.

Create drilldowns in cloned (Save As) reports and not in the Cisco stock template reports.

Any two reports can be linked with drilldowns, as long as they share common fields and those fields are visible in both reports.

Any field in a report can have a drilldown associated with it, and there is no limit to the number of drilldowns you can define for a field.

Once you launch a drill-down report, you can save it as a separate report.

Things to keep in mind before you create a drilldown:

• Be familiar with the report you are drilling down from and the report that is to open from the drilldown.
  – Are there matching fields?
  – Are the fields visible in both reports?
  – Is there a business reason to drill down from one to the other? Unified IC imposes no restrictions, and allows you, for example, to drill down from an Agent Team Real Time report to an IVR Ports Performance report, but doing so is unlikely to be helpful.

• Not all reports can be used as a drill-down report. Reports which have an SQL query that cannot be used as a sub-query to another report cannot be used as drill down reports. For this reason, the stock reports, Agent Real-time All fields reports and Agent Team Real-time All fields reports cannot be specified as drill down reports.

• You cannot drill down from a grouped field.
To determine if a field is grouped:

- Access the Grouping Definition by clicking Default Grouping from the Report Wizard Formatting tab (page 156).

- If necessary, remove grouping from the report so you can use a grouped field.

To create and maintain drilldowns, you begin at the Report Context Menu, Report Manager, or a Report List.

To access the drilldown interface:


- Click the Field Map tab.

- Right-click the field from which you want to drill down.

  This opens the Edit Drilldowns dialog box

  - Select Drilldowns...

  ![Figure 42: Drilldowns](image)

  **Note:** There is no limit to the number of drilldowns that be defined for a field.

  This opens the Edit Drilldowns dialog box.

  Use this dialog box as follows:

  - To **add** a drilldown, click **New** at the Edit Drilldown dialog box.

  - To **edit** a drilldown, right-click the drilldown name on the Edit Drilldowns dialog box list and click **Edit**.

    Adding and Editing open the Edit Drilldown dialog box. See Editing or Adding a Drilldown (page 132).

  - To **remove** a drilldown, right-click the drilldown name on the Edit Drilldowns dialog box list and click **Delete**.
Editing or Adding a Drilldown

Complete the Edit Drilldown dialog box as follows.

Adding a drilldown for an historical report requires that you specify the Historical Date Range as well as the field from which you want to drill down.

Adding a drilldown from a real time report requires only that you specify the field from which you want to drill down.

---

**Step 1**  
In the **Caption** field, enter a name for the drilldown. This will display to reporting users in the drilldown menu and will also appear on the list in the Edit Drilldowns dialog box.

**Step 2**  
In the **Drilldown Type** field, select how the drilldown will appear.

Options are New Window (drilldown will open in a new browser window) and Second Window Pane (drilldown will open in the lower half of the report).

**Step 3**  
In the **Report to Drill Into** field, select the report that will be launched by the drilldown.

Although the software imposes no restrictions, select a report that has a logical relationship to the report from which you are drillling down.

**Step 4**  
Click **Edit Drilldown Filter**.

This opens the Drilldown Filter (page 132) dialog box where you edit the filter that connects the two reports.

---

Drilldown Filter

Complete the Drilldown Filter dialog box as follows.

Adding a drilldown for an historical report requires that you specify the Historical Date Range as well as the field from which you want to drill down.

Adding a drilldown from a real time report requires only that you specify the field from which you want to drill down.

---

**Step 1**  
If you are drilling down from a Real Time report, skip to step 6.

**Step 2**  
If you are drilling down from an Historical Report, select Historical Date field in the Parameters and Fields panel on the left.

**Step 3**  
In the panel on the right, click the button for specify the date range for which you want the reports to correspond; for example: Last Month.

**Step 4**  
Select the radio button for **Match field in the originating report**.
Step 5: Click Apply.

Step 6: In the Parameters and Fields panel on the left, scroll to select the field in the originating report from which you want to drill down.

This is the same field you selected on the Field Map tab.

Step 7: In the panel on the right:

a. In the top dropdown, select Match Field.

b. In the Field to Match dropdown, select the matching field name.

Step 8: Click Apply and then OK.

This returns you to the Edit Drilldown dialog box.

Step 9: Click OK, then Close, then Save.

Step 10: To verify the drilldown, launch the originating report. The field you selected appears as a hyperlink that launches the drilldown report.

Figure 43: Drilldown Created

Thresholds

Unified IC allows unlimited thresholds on any field.

You can define a threshold such that the field's text color and background change when the condition is met. The threshold can also trigger a text replacement or image substitution for the field.

Create thresholds in cloned (Save As) reports not in the Cisco stock template reports.
Thresholds can be applied to both numeric and text fields. For numeric fields, thresholds are calculated only for the actual value in the database and not on the formatted value. For text fields, the threshold value must exactly match the value of the field.

You can set and maintain thresholds from the Simple Wizard (page 114) dialog box. To do this, click **Threshold** under the Visible fields panel.

You can also set and maintain thresholds from the Report Context menu. To do this:

- Right-click a report and select **Edit Report** to open the Report Wizard.
- Click the Field Map tab.
- Right-click the field for which you want to set a threshold.
- Select **Thresholds...**

Both actions open the Edit Thresholds dialog box. Use this dialog box as described below.

**Step 1** To add a threshold, click **Add** at the Edit Thresholds dialog box.

**Step 2** To edit a threshold, select it from the list on the Edit Thresholds dialog box and click **Edit**.

Both adding and editing open the Edit Threshold dialog box. See **Editing or Adding a Threshold** (page 134).

**Step 3** To remove a threshold, select it from the list on the Edit Thresholds dialog box and click **Remove**.

---

**Editing or Adding a Threshold**

Complete the Edit Threshold dialog box as follows:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Threshold Type</strong></td>
<td>Select the type of condition that must be met in order for the threshold to be applied</td>
</tr>
<tr>
<td></td>
<td>For threshold types other than Always, enter a value in the second field this field to specify the value that must be compared.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> To set a threshold on a % field, such as %Not Active or %Reserved, enter a decimal value in the threshold value field. (Enter .25 and not 25%).</td>
</tr>
</tbody>
</table>
### Scheduled Reports

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Font</strong></td>
<td>Check Bold or leave it unchecked.</td>
</tr>
<tr>
<td><strong>Text Color</strong></td>
<td>Click <strong>Change...</strong> to open a color palette.</td>
</tr>
<tr>
<td><strong>Background Color:</strong></td>
<td>Click <strong>Change...</strong> to open a color palette.</td>
</tr>
<tr>
<td><strong>Text Substitute:</strong></td>
<td>To mask the field value with some other text when the threshold condition is met, enter that text here.</td>
</tr>
<tr>
<td><strong>Image Substitute URL:</strong></td>
<td>To mask the value of the field with an image instead of text, enter the image URL here, prefixed with &quot;http://&quot;.</td>
</tr>
</tbody>
</table>

#### Creating Report Schedules (page 135)

#### Managing Scheduled Reports (page 137)

#### RSS Feeds for Scheduled Reports (page 138)

### Creating Report Schedules

You can automate the generation of reports on a regular and recurring basis by setting up a schedule.

You can configure Scheduled reports to run at predetermined times, to be automatically sent to e-mail recipients, to be added to a dashboard, and to be used to publish new content in an RSS feed.

Scheduling report to:

- Automatically distribute prefiltered reports to users by email, at predetermined times
- Run large dataset reports once to be sent to, and viewed by, many users

See also

- Managing Report Schedules (page 137)
- Adding a Scheduled Report to a Dashboard (page 102)
- RSS Feeds for Scheduled Reports (page 138)

**Step 1**  
From the **Report Context Menu** (page 128), click the report name and select **Schedule**.

This opens the **Advanced Filter** (page 117) dialog box.

**Step 2**  
Set the filters for the scheduled report. Click **OK**.
This opens the Report Distribution dialog box.

**Step 3** Complete the Report Distribution dialog box as follows:

a. **Report Name:** Keep the default or enter the name that will display in the Managing Scheduled Reports dialog box (Report Admin > Scheduled Reports).

b. **Email Subject:** Keep the default or enter the subject the recipients will see for the delivered email.

c. **Email Distribution List:** Click **Add** to enter the email address for each recipient. Select a name and click **Remove** if necessary.

**Note:** Scheduled reports run on the dashboard whether or not they are e-mailed.

d. Click **Continue** to open the Edit Scheduled Report dialog box.

**Step 4** Complete the Edit Schedule Report dialog box to establish when and how often you want to generate and distribute the report.

**Step 5** **Occurs:** Select the occurrence as described below.

<table>
<thead>
<tr>
<th>Occurrence</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Once</td>
<td>The report will be generated on the date and time specified.</td>
</tr>
<tr>
<td>Daily</td>
<td>Executes the schedule every 1 to n days according to the value provided for at the time or frequency (10:00 AM or Every 8 Hours) specified.</td>
</tr>
<tr>
<td></td>
<td>You can specify an exact time for execution (i.e. 4:00 AM) or you can execute the job repeatedly every hour.</td>
</tr>
<tr>
<td></td>
<td>You can also limit the amount of time each day that the schedule will be executed by entering a start and end time. For Example, Every 1 hour from 8:00 AM to 5:00 PM.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The maximum frequency with which you can schedule a report is once every five minutes.</td>
</tr>
<tr>
<td>Weekly</td>
<td>Executes the schedule every 1 to n weeks and on the days checked.</td>
</tr>
<tr>
<td></td>
<td>The schedule will be executed at the specific time or frequency (10:00 AM or Every 8 Hours) selected.</td>
</tr>
<tr>
<td></td>
<td>Selecting a specific time will execute the job once (i.e. 4:00 AM) or you can execute the job repeatedly every hour.</td>
</tr>
<tr>
<td></td>
<td>To limit the number of times each day that the schedule will be executed, enter a start and end time. For Example, Every 1 hour from 8:00 AM to 5:00 PM.</td>
</tr>
</tbody>
</table>
Executes the schedule the 1 to nth day on every 1 to n months. For example, on Day 10 of every 3rd month.

Select the day of the month and the frequency of execution. For example, Day 1 every 4 months will produce a report on the first day of the month after the end of a quarter.

**Step 6**  
**Daily Frequency:** For the occurrence indicated, select the time of day.

**Step 7**  
**Duration:** Use the calendars to select the dates the schedule will begin and end. To continue the report indefinitely, select No End Date.

**Step 8**  
Click **Continue** to see a message indicating that the schedule is created.

**Step 9**  
Click **Close** to close the message.

---

**Managing Scheduled Reports**

Select **Report Admin > Scheduled Reports** to see the list of scheduled reports.

This is the interface for viewing and working with existing scheduled reports. See **Creating Report Schedules (page 135)** for the procedure to create a schedule for a report.

Complete this dialog box as follows:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show all scheduled reports for all users</td>
<td>This checkbox is available to Admin users. Check it to see the scheduled reports for all users.</td>
</tr>
<tr>
<td>Reports</td>
<td>Navigate the hierarchy of report folders to locate the report for which you want to review and manage schedules.</td>
</tr>
</tbody>
</table>

---

**Schedule Context Menu**
Scheduled Reports

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable / Disable</td>
<td>Enables a disabled schedule or disables an enabled schedule.</td>
</tr>
<tr>
<td>Schedule Info</td>
<td>Opens an informational window about the last and next schedule.</td>
</tr>
<tr>
<td>Edit Schedule</td>
<td>Edit the attributes of the schedule, starting with the Advanced Filter dialog. See Scheduling Reports (page 135).</td>
</tr>
<tr>
<td>Delete Schedule</td>
<td>Permanently deletes the schedule.</td>
</tr>
<tr>
<td>RSS Feed</td>
<td>Opens a new window with the RSS information for this report. See RSS Feeds for Scheduled Reports (page 138).</td>
</tr>
<tr>
<td>Run Now</td>
<td>Executes the job immediately. Does not affect the scheduled job.</td>
</tr>
<tr>
<td>Edit Report</td>
<td>Opens the Report Wizard (page 149) for this report.</td>
</tr>
<tr>
<td>Report Info</td>
<td>Opens the Report Info (page 129) dialog box, which shows the columns in the report and any permalinks.</td>
</tr>
<tr>
<td>Edit Filters</td>
<td>Opens the Advanced Filter (page 117) dialog so that you can change the filter for the report.</td>
</tr>
</tbody>
</table>

Click the report to display a context menu.

**RSS Feeds for Scheduled Reports**

RSS feeds can be created from any scheduled report.

Selecting **RSS Feed** from the Schedule context menu opens a new window that contains the RSS information for this scheduled report in XML format.

To subscribe to this RSS feed, the content should be copied and pasted into your RSS reader.
The RSS reader will notify you when new content is available.

<?xml version="1.0" encoding="utf-8" ?>
- <rss version="0.92">
  - <channel>
    <title>Agent - Historical All Fields</title>
    <link>http://www.cisco.com</link>
    <description /></channel>
  <lastBuildDate>6/17/2008 1:47:55 PM</lastBuildDate>
  <managingEditor>WINDOWS-EJ90H1D\username</managingEditor>
  <webMaster>WINDOWS-EJ90H1D\username</webMaster>
</rss>
Maintaining Reports

Modify the Number of Rows to be Extracted

For reports that use Anonymous Blocks and Stored Procedures, changes that you make to the ROWLIMIT parameter during the Web Application Configuration are not automatically used during query execution. For such reports, you must manually update the query to restrict the number of rows, whenever the ROW LIMIT parameter is changed. If you do not update the number of rows to be extracted, the system extracts only the default number of records from the database, even if the database has more matching fields. The default number of rows that the report extracts is 3001.

Follow the steps below to modify the number of rows for stock anonymous block and stored procedure reports. (Agent not ready detail, Agent historical all fields):

Step 1
Note the value of ROW LIMIT that you specified in the Web Application Settings window while configuring the Intelligence Web Server.

Step 2
For a Stored Procedure, edit the stored procedure which is invoked by the report.

Step 3
For an Anonymous Block, do the following to edit it:

a. Open Report Manager.

b. Right-click the report that you want to edit and select Edit Report.

Step 4
Locate the SELECT query that returns the data from the block and edit the TOP clause of the SELECT statement.

For example, SELECT TOP 3001.

Note: For Unified IS release 7.5.4 or earlier, if this SELECT query is missing, you can manually add it to the Anonymous Block or Stored Procedure and follow the steps in this section to get the report to work as designed.
Step 5 Specify a value that is one more than the \texttt{ROWLIMIT} parameter specified in the configtool or web.config parameter file, as the value for the \texttt{TOP} clause.

For example, if you have specified 5000 as the value for \texttt{ROWLIMIT} in the configtool, then modify \texttt{SELECT TOP 3001} to \texttt{SELECT TOP 5001}

Step 6 Save the report template.

---

**Importing Stock Report Templates**

You import the Cisco stock report templates after a fresh install. You can also re-import the stock templates as a group or individually if necessary. You can import any report in XML format.

Step 1 Select \texttt{Report Admin > Import Report} to open the Import Report window.

This window has a panel for importing specific files and a panel for importing the stock Cisco report templates that were installed with Unified IC.

Step 2 To import the stock Cisco report templates click \texttt{Continue} in the bottom panel.

Step 3 To import a specific XML-formatted report on your local drive or network:
   a. Click \texttt{Browse} in the top panel.
   b. Navigate to the report file.
   c. Click \texttt{Continue}.

**IMPORTANT**: Set, validate, and save the data source for the imported report(s) before you use them. See [Data Source Tab - Report Wizard](page 149).

---

**Importing the Expert Advisor Report Templates (English)**

Before you can run the Expert Advisor report templates in the Unified IC reporting application, a Unified IC Administrator must download them, copy them to a Unified IC directory, and import them into Unified IC, and define the Data Source.

Step 1 Download the Expert Advisor report templates zip file from your Expert Advisor interface.

Step 2 Copy the downloaded zip file to your Unified Intelligence Center server.

Step 3 Extract the zip file.

This creates a folder named \texttt{EA761\_CUI\_templates} that has a subdirectory named \texttt{EA}.

Step 4 Move the \texttt{EA} folder to \texttt{C:\Cisco\CUIS\CuisWeb\InitialSetupReports}. 

---

Chapter 14: Maintaining Reports
Step 5  Log in to Unified Intelligence Center as an Admin or Report Designer user.

Step 6  Select **Report Admin > Import Report**.

This opens the Import Report window.

Step 7  Click **Browse** in the top panel.

Step 8  Navigate to C:\Cisco\CUIS\CuisWeb\InitialSetupReports\EA and then to the specific language subdirectory you want. For example for English-language templates, navigate to C:\Cisco\CUIS\CuisWeb\InitialSetupReports\EA\en_US.

The folder contains seven templates. They are .xml files.

Step 9  Select a template and click **Open**.

You return to the Import Reports window.

Step 10  Click **Continue** to open the Data Source window.

Step 11  Select the Informix Data Source you created for Expert Advisor. Then click **Next**.

Step 12  Click **OK** at the successful import message.

Step 13  Repeat Steps 6 - 11 to import all templates

Step 14  To verify that the reports have been imported, select **Report Admin > Report Manager**.

The Expert Advisor templates appear in Report Manager listed in alphabetical order.

---

**Importing New and Localized Templates from Cisco.Com**

When new templates and localized templates become available, you can access and download them and their online help from the Cisco Systems website.

Step 1  Point your browser to [http://tools.cisco.com/support/download](http://tools.cisco.com/support/download).

Step 2  Sign in.

Step 3  **If:** You want to download the Expert Advisor templates

**Then:** Open the 7.5(2) folder and select EA761_CUIC_templates.zip.

**If:** You want the localized stock Cisco templates

**Then:** Open the 7.5(3) folder and select EA761_CUIC_templates.zip.
Step 4  Click **Download**. Then click **Agree** to accept the download rules.

Step 5  Save the zip file.

Step 6  Extract the zip file to `%CUIS_HOME%\CuisWeb\InitialSetupReports`.

Step 7  Import the templates and set their data source. See **Importing Stock Report Templates (page 142)**.

---

**See also:** Localization. (page 93)

### Renaming a Report

Admins and Report Designers can rename reports.

Although the system allows you to do so, renaming a stock template is not advisable.

**Step 1**  Access the **Report List (page 127)** and right-click the report you want to rename.

This displays the **Report Context menu (page 128)**.

**Step 2**  Right click **Management** to display the Management sub-menu.

**Step 3**  Click **Rename Report** to display the Rename Report dialog box.

**Step 4**  Enter the new name in the Rename To field.

**Note:** Names containing more than 100 characters are truncated.
Step 5  Click the Rename button.

Deleting a Report

Admins and Report Designers can delete reports.

Although the system allows you to do so, deleting a stock template is not advisable.

Step 1  Access the Report List (page 127) and right-click the report you want to rename.

This displays the Report Context menu (page 128).

Step 2  Right click Management to display the Management sub-menu.

Step 3  Click Delete Report to display the Delete Report dialog box.

Step 4  Click Yes.

Working with Report XML

Editing Report XML (page 145)

Exporting Report XML (page 145)

Editing Report XML

Select Management > Edit XML to open a dialog box that allows you to edit the XML source for a report.

Make any changes you need to and click Save.

Caution: This feature is for advanced users and developers who are familiar with report XML schema. Randomly removing or editing the fields may cause unpredictable behavior when the report is loaded.

Exporting Report XML

Select Management > Export to open a browser window containing the XML source for a report.

Do this to export the report for troubleshooting or so that it can be archived or imported to another server in XML format.
You can automate the data export feature of Intelligence Suite and the Import Data feature of Excel to create a live data link between the two applications.

To do this:

1. Create a new workbook with a tab named IS_Data.

2. From the Unified IC Report List, select the report from which you want to export data. Then click that report to display the report context menu.

3. From the report context menu, select **Report Info**.

4. From the Report Info dialog box, select **Copy Web Grid Permalink to Clipboard**.

5. From the Excel menu, select **Data > Import External Data > New Web Query**.

6. Paste the URL from your clipboard into the address bar of the web dialog box and click the **Import** button on the bottom right.

   The data should be visible in the Excel web dialog

7. When the data is visible, click **Import** again and confirm or specify the upper left-most cell for the report data.

8. Click **Import** a third time to populate the data in the worksheet.

   Once the data is populated, you can link other worksheets to individual cells in this worksheet.
Caching

About Caching

The Unified IC data-caching mechanism requests data from the data source each time the data is refreshed, regardless of how many users are viewing the report.

Unified IC stores the following information in cache to improve performance:

- Data sources
- User profiles
- User groups
- Report folder structures
- Reports being edited
- Reports being viewed with custom filters
- Faked user identity
- Value lists and collections

Data is cached for the same duration as the refresh rate. If the refresh rate is 30 seconds, the data will remain cached for 30 seconds. At 31 seconds new data will be retrieved.

By default, the refresh rate for realtime reports is every 30 seconds. The refresh rate for historical reports is every 3,600 seconds. This is configurable on the Report Wizard Data Settings tab. (page 155)
The refresh rate for each report determines how often the database is queried for new data and is independent of the number of users viewing the report. For example, if a real-time report has a refresh rate of 30 seconds, the database is queried every 30 seconds irrespective of whether one person is viewing the report or 25 people are viewing the report.

When a report has requested data and the refresh rate has not yet elapsed, the previously retrieved report data is used, preventing a second database query.

This mechanism works separately for each unique report instance, which is defined as a cloned report spawned from the report menu for an ad-hoc report, a report created as a result of a drill-down, a report embedded in a dashboard, or a scheduled report.

Scheduled reports refresh their data based on their schedule, which is typically once a day or once every hour. Regardless of how many times the report is viewed, the scheduled report will only request fresh data according to its schedule. See also Managing Scheduled Reports (page 137).

Personal reports are not cached.

Flushing the Global Cache

Select **Administrative > Flush Global Cache** to clear the cache.

A message displays indicating the impact that flushing the cache will have on other users.

Click **OK** proceed or **Cancel** to abort the cache flush. the message.

Cache flushing should be used judiciously, and if multiple administrators are working on the system its use should be coordinated so as to avoid confusion.
About the Report Wizard

The Report Wizard is the main interface for building new reports and for advanced editing of existing reports. It is a multi-tabbed dialog where you specify the data source for the report and the options that will be provided for users in executing the report.

Topics in this section explain these tabs.

Users with the Admin (page 71) and Report Designer (page 71) roles can access this wizard.

- Report Wizard Data Source Tab (page 149)
- Report Wizard Field Map Tab (page 151)
- Report Wizard Field Properties (page 152)
- Report Wizard Parameters Tab (page 154)
- Report Wizard Data Settings Tab (page 155)
- Report Wizard Formatting Tab (page 156)
- Report Wizard Formatting Tab (Grouping Definition) (page 156)
- Report Wizard Help Tab (page 157)

Report Wizard Data Source Tab

This tab specifies the data source for the report.
Note that Unified IC uses an internal SQL Parser and requires that the syntax used in SQL Queries adhere to these guidelines:

- When defining SQL Queries, you cannot use the asterisk to return all columns from a table.
- Unified IC binds the column names from the queries to internal identifiers so that users can change column names. To do this, it must know the names and order of the columns that are being returned.

Complete the Data Source tab as follows:

**Step 1** To access the Data Source Tab, select **Report Administration > Wizard.**

**Step 2** Select the **Data source type.** Options are Database Query, RSS, HTML Post, Stored Procedure, and Anonymous Block.

Your choice repaints the screen.

**Step 3** **If you select Database Query,**

- Select the data source for the report from the **Query data source** dropdown. This dropdown shows all data sources that the Admin user has configured for Unified IC. See **Data Sources** (page 87).
- Click **Test Connection** to verify that the data source is online.
- **Query:** Use this box to review or edit the SQL query for an existing report or to build a SQL query for a new report.

You can type the query directly or paste a query you create in a Query Analyzer or similar tool.

- Check the connection options you prefer.
- Click **Validate** and then click **Save.**
- For new queries only, a successful validation enables the Next button. Click **Next** view a read-only window listing the input parameters and output fields found. Click **Submit** to bind the columns to values in the result set.

**Step 4** **If you select RSS,** or HTML Post, enter the URL for the RSS field and select the default XSLT Reader. Then click **Save.**

**Step 5** **If you select HTML Post,** enter the URL to post to. Then click **Save URL.**

**Step 6** **If you select Stored Procedure:**

- Select the data source for the report from the **Query data source** dropdown. This dropdown shows all data sources that the Admin user has configured for Unified IC. See **Data Sources** (page 87).
b. Enter a name for the Stored Procedure that you have already created and imported in your data source.

c. Check the connection options you prefer.

d. Click **Validate** and then **Save**.

**Step 7**  
**If you select Anonymous Block,**

**Note:** Anonymous Block is used for two default templates: Agent Historical All Fields and Agent Not Ready. It allows for additional customization through parameters.

a. Select the data source for the report from the **Query data source** dropdown. This dropdown shows all data sources that the Admin user has configured for Unified IC. See **Data Sources** (page 87).

b. Enter or paste the block.

c. Click **Save** to go to the next screen.

d. Click **Analyze** and then click **Submit**.

**Step 8**  
Click **Save** or **Save As** to open the Save Report dialog box. See **Saving Reports** (page 113).

---

**Report Wizard Field Map Tab**

Use this tab to add a new field that does not currently exist in the SQL statement or to modify an existing one.

**See also:**

- **Creating a New Field on the Field Map Tab** (page 151)
- **Modifying an Existing Field on the Field Map Tab** (page 152)

**Creating a New Field on the Field Map Tab**

Follow this procedure to create a new field for a report.

**Step 1**  
From the Field Map tab, click **Add New Field**.

This opens a New Field dialog box.

**Step 2**  
Select the type of field you want to create (Formula or Filter-Only) and click **OK**.

This opens the **Field Properties** (page 152) dialog box. This dialog box has four tabs for Formula fields. It has two tabs for Filter-Only fields.

A Formula field is created at run-time and uses data from other fields in a formula.
A Filter-only field is added to the WHERE clause and used to filter a report on a specific field.

New fields are displayed according to the color key below the Add New Field button. For example a new Filter-only field will have a green highlight.

Modifying an Existing Field on the Field Map Tab

Follow this procedure to modify an existing field in a report.

Step 1
From the Field Map tab, scroll to, and right-click, the field you want to modify.

This opens a context menu with three options: Field Properties, Thresholds, and Drilldowns.

Step 2
Select Field Properties to open the Field Properties (page 152)

Step 3
Click Thresholds to open the Edit Threshold dialog box. See Adding or Editing a Threshold (page 134).

Step 4
Click Drilldowns to open the Edit Drilldown dialog box. See Adding or Editing a Drilldown (page 132).

Report Wizard Field Properties (Field Map Tab)

The Field Properties interface is available as a result of these actions on the Field Map tab:

• When you create a new formula or filter-only field.

• When you right-click an existing field and select Field Properties.

Use Field Properties to specify properties for each field in the report.

Step 1
Click the General tab. This tab establishes general properties of the field.

Step 2
Complete the General tab as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visible in Grid (Formula field only)</td>
<td>Check this if the field is to be visible by default in the grid.</td>
</tr>
<tr>
<td>Allow users to show if hidden (Formula field only)</td>
<td>Check this if the field is to appear on the list of hidden values in the report. If this is unchecked, the field will not be listed in the Simple Wizard (page 114).</td>
</tr>
<tr>
<td>Avail in Advanced Filtering dialog</td>
<td>Check this to add the field to the Advanced Filter dialog box.</td>
</tr>
<tr>
<td>Field</td>
<td>Explanation</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Display Width in Grid (Formula field only)</td>
<td>Set the column width in pixels for this field in the report. The default is 125.</td>
</tr>
<tr>
<td>Display (Friendly) Name</td>
<td>Enter the name for the column header by which this field will appear on the report.</td>
</tr>
<tr>
<td>Belongs to Value List</td>
<td>From the dropdown, select the value list for this field. When a field belongs to a value list, report users can pick values from the list when filtering on this field. See About Value Lists. (page 80)</td>
</tr>
<tr>
<td>Description / Explanation</td>
<td>Document the field for future reference.</td>
</tr>
</tbody>
</table>

Click **Save** to save your entries and continue work on this tab. Or click **Save and Close** to return to the Field Map tab.

**Step 3**
Click the **Data Source tab**: This tab displays information about the dataset column bound to this report field. Typically, you will not need to change these values unless a column name or data type changes in the database. Changing these settings should only be done by advanced users.

**Step 4**
Complete the Data Source tab as follows:

a. **Data Type**: Identifies the type of data contained in the source field. This setting determines the options that will be displayed for this field on the Formatting Tab.

b. **Data Clause**: Identifies which column in the dataset has been bound to this field. The SQL Parser uses this value when retrieving data from the database.

Ensure that you modify the default value to one that matches with the dataset field name.

c. **Normalize date/time to users**: Formula fields only. Valid for date/time data types only. This setting adjusts the date/time values displayed on the report to the preferred time zone defined for the user or group. Adjustments are made after data has been retrieved. Parameters sent to the database are not adjusted.

d. **Filter Pre-Query**: Formula fields only. Used for caching. Check in this box to disable caching

Historical reports use pre-query filtering. The data is filtered when it is retrieved.

Real time reports use post-query filtering. The data is filtered after it is retrieved.

See also Queries: Pre-Filtered and Post-Filtered (page 173).

e. Click **Save** to save your entries and continue work on this tab. Or click **Save and Close** to return to the Field Map tab.

**Step 5**
Click the **Formula tab** (Formula fields only). Use this tab to modify the formula for the value of a field or when you are create a computed field that does not exist in the result set but uses the result of another calculated value.
Step 6 Complete the Formula tab as follows:

a. **Formula Field Checkbox:** Check this to use the formula in the textbox instead of the field value.

b. **Available Fields:** Select a field from the dropdown list to insert it into the formula textbox.

c. **Formula (Excel Syntax):** Enter the formula that will be used as the value of the field if the Formula Field checkbox is checked. All formulas must be in Excel syntax.

d. Click **Save** to save your entries and continue work on this tab. Or click **Save and Close** to return to the Field Map tab.

Step 7 Click the **Formatting tab** (Formula fields only). Use this tab to apply a formatting mask to the field; for example, for output to Microsoft Excel.

a. **Format Dropdown:** Provides a list of default formatting masks. The available formats depend on the data type of the field as set in the Data Source tab. For example, for numeric values, the dropdown offers all possible display formats for numeric values. Selecting (Custom) from this list will apply the format string supplied in the Custom Format String to the value returned.

b. **Custom Format String:** Format string (in Excel syntax) to apply to the field. This is only applicable if you selected (Custom) from the Format Dropdown.

c. **Footer Style:** The formula to use in the footer. If you select Custom Formula, you must supply the formula in the custom footer fields below.

d. **Default Custom Footer Formula:** If you selected Custom Formula as the Footer Style, enter the formula for the report.

e. **Group 1-3 Custom Footer Formula:** Enter the formula to use for each grouping.

f. **Export as hh:mm:ss string:** Check this if you have selected Minutes and Seconds from the Format dropdown.

g. **Auto-merge cells:** Check this to merge data. For example, if one agent belongs to five skill groups, the skill group names will appear in a group for that agent.

h. Click **Save** to save your entries and continue work on this tab. Or click **Save and Close** to return to the Field Map tab.

**Report Wizard Parameters Tab**

Use this tab to specify the parameters to be sent as input to a stored procedure, to edit parameters, and to reorder them.

This tab is applicable for reports that use Anonymous Block Text and Stored Procedures only.
By default, two reports use Anonymous Block Text: Agent Historical All Fields and Agent Not Ready. Edit either of those reports and click their Parameters tab to see how @agent_list, @start-date, and @end-date appears as Parameters to customize the Simple Filter Dialog Box (page 110).

The Edit button allows you to modify the way the parameter is presented to the user for input.

The Data Type button allows you to change the data type that is used to present the parameter and then pass it to the database for processing. Ensure that the data type you select matches with the data type of the value list, if any.

If you reorder the parameters, be sure to click the Save Order button before leaving the page or your changes will not be saved.

Report Wizard Data Settings Tab

Use this tab to establish or change data settings for the report template.

Complete this tab as follows.

Step 1 **Key Criteria Field:** For both real time and historical reports, from the dropdown, select the key criteria field for the report. This is the value filtering field used in the Simple Filter Dialog Box.

Step 2 **Historical Key Field:** For historical reports, enter or modify the historical key field for the report.

Historical reports will not run if this field is left blank.

Step 3 **Historical Data Timeframe:** For historical reports, select the timeframe represented by this report:

Options are:

- Daily: Used for Archiver data only.
- Half-Hour: The default.
- Transaction Detail: Used for Archiver data only.

Step 4 **Refresh Rate (seconds):** Enter the refresh rate for this report in seconds. This is the rate at which the report is automatically refreshed. The default refresh rate is every 3,600 seconds for historical reports and every 30 seconds for real time reports.

Step 5 **Has Interval ID:** Check this only for specially-formatted reports originating from Archiver.

Step 6 Click Save or Save As to open the Save Report dialog box. See Saving Reports (page 113).
Report Wizard Formatting Tab

Use this tab to control the appearance of the report.

Complete this tab as follows:

**Step 1**  **Default Grouping:** Click this to open the Group Definition dialog box. See Report Wizard Formatting Tab (Grouping Definition) (page 156).

**Step 2**  **Default Chart:** Click this to open the Chart Wizard. See Charting and Graphing (page 159).

**Step 3**  **Report Description:** Use this field to enter a description of the report.

**Step 4**  **XSLT File:** From the dropdown, select an XSLT file to apply to the report.

**Step 5**  **Default Display:** From the dropdown, select the default display.

Options are:

- **Grid:** The report displays as a grid.
- **Chart:** The report displays in a graphical format, based on the Default Chart you defined for it.
- **Chart and Grid:** The report displays as both a chart and a grid
- **XSLT:** The report displays as a static grid

**Step 6**  **Font Size:** Enter or edit the font size for the report.

**Step 7**  Click **Save** or **Save As** to open the Save Report dialog box. See Saving Reports (page 113).

---

Report Wizard Formatting Tab (Grouping Definition)

The Group Definition dialog box opens when you click Default Grouping at the Report Wizard Formatting Tab (page 156).

Use it to define how data is grouped, sorted, and summarized in a report. See Grouped Grids (page 171).

Complete this tab as follows:

**Step 1**  **Number of Groups:** Click a radio button to indicate if you want no groups or if you want one, two, or three groups.

**Step 2**  **Unique Value Vertical Alignment:** Select Top, Middle, or Bottom to specify where you want the name of the group to display in the report column.
Step 3  **Include Date/Time and User:** Check this to include the date/time value and the user in the footer.

Step 4  **Include Filter Summary:** Check this to include a filter summary in the footer.

Step 5  **Grouping:** From one to three grouping boxes appear, based on the number of groups you specified. Complete each as follows:

  a.  **Grouped By:** Select a value from the dropdown. The group will be organized by this value.

  b.  **Sorted By:** Select a value from the dropdown. The group will be sorted by this value.

  c.  **Show Summary:** Check this to include a summary row in the report for the grouping. For example, if you group by Agent Team and check Show Summary, there will be a row of summary data for each team.

Step 6  Click **OK** to save your changes and return to the Formatting tab.

---

**Report Wizard Help Tab**

If you have created your own online help for a new report, use this tab to define and associate the help with the report.

Complete this tab as follows:

---

**Step 1**  Create a help file and save it to a location on a web server where it will be available to other users.

**Step 2**  **Help Link:** Use this field to enter the path for the help file. Use a full URL in this field (for example, http://localhost/testhelp/testhelp.html).

**Step 3**  **Help Title:** Use this field to enter the title that will appear when the help file displays.

**Step 4**  Click **Save** or **Save As** to open the Save Report dialog box. See **Saving Reports (page 113)**.

When you run the report, the help button will link to the URL you use and the tooltip will be the Help Title.
Working with Charts and Gauges

About Charts and Gauges

Unified IC has extensive support for charting. All stock templates are, by default, grids. However, you can replace the grids with charts or gauges. You can also edit a report such that it opens as both a grid and a chart/gauge.

The Chart Wizard imposes no restrictions on creating charts and gauges, and some of your selections may produce no results or unusual results. Until you are comfortable with charting, it is best to design charts on a cloned copy of a report template.

<table>
<thead>
<tr>
<th>Charts</th>
<th>Gauges</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display multiple data points simultaneously</td>
<td>Display a single data point at a time</td>
</tr>
<tr>
<td>Cannot refresh without a round-trip to the server</td>
<td>Refresh in real-time without a round-trip</td>
</tr>
<tr>
<td>Allow for multiple data fields to be displayed in a single graphical image, such as a pie chart.</td>
<td>Allow for a single numeric data field to be displayed at a time, similar to a thermometer or a speedometer.</td>
</tr>
<tr>
<td>Chart types are not interchangeable.</td>
<td>Gauge styles are interchangeable.</td>
</tr>
<tr>
<td>Are far more complex than gauges and harder to configure</td>
<td>Are simpler to configure than charts.</td>
</tr>
</tbody>
</table>

The Chart Wizard opens from:

- The **Chart** button on a generated report. See *The Report Interface. (page 111)*
- *The Report Wizard Formatting Tab (page 156)*
- When you click the Chart icon from within the chart itself, once the report is generated.
Chart Wizard Appearance Tab

Use this tab to specify general properties of the chart's appearance.

This tab is available for both Charts and Gauges.

Complete this tab as follows.

**Step 1**  **Chart Type**: From the dropdown, select Chart or Gauge.

**Step 2**  **Total Width (in pixels)**: Enter a value for the total width of the graphic (between the outer right and left borders) with respect to the total screen real estate.

**Step 3**  **Total Height (in pixels)**: Enter a value for the total height (between the outer bottom and top borders) with respect to the total screen real estate.

**Step 4**  **Show Gauge Labels**: Visible for Gauge chart types only. Check this box if you want the title to appear on the gauge.

**Step 5**  **Chart Area Left Location %**: Enter a percentage value representing how far the left of the chart is placed from the total left side of the available space.

**Step 6**  **Chart Area Top Location %**: Enter a percentage value representing how far the top of the chart is placed from the top of the available space.

**Step 7**  **Chart Area Width %**: Enter a percentage value representing the width of the chart in relation to the total width of the space.

**Step 8**  **Chart Area Height %**: Enter a percentage value representing the height of the chart in relation to the total width of the space.

**Step 9**  Click **OK** to close tab. Then click **Save** at the Chart Wizard.

Chart Wizard Series Data Tab

Use this dialog box to add, edit, or remove series to the chart. This dialog box is available for Charts only.
A chart series represents a distinct group of data to be charted. Each distinct group (series) is charted separately. For example, each line in a line chart is a series.

Different chart types require different series configurations.

Some chart types (pie, doughnut) will only use one series.

You can create dynamic series by grouping common values.

---

**Step 1**  
**Add Series:** Click this button to display the [Edit Series (page 161)](Intelligence%20Center%20User%20Guide%20For%20Cisco%20Unified%20Intelligence%20Suite%207.5(4)) dialog box.

**Step 2**  
**Edit...:** Click this button to display the [Edit Series (page 161)](Intelligence%20Center%20User%20Guide%20For%20Cisco%20Unified%20Intelligence%20Suite%207.5(4)) dialog box.

**Step 3**  
**Remove...:** Click this to display a Confirm Remove message. Select Delete or Cancel.

**Step 4**  
Click **OK** to close tab. Then click **Save** at the Chart Wizard.

---

**Edit Series**

This dialog box displays when you click **Add Series** or **Edit Series ...** from the [Chart Wizard Data Series Tab (page 160)](Intelligence%20Center%20User%20Guide%20For%20Cisco%20Unified%20Intelligence%20Suite%207.5(4)).

Use it to define the type of chart you want and the data that is to display in the Legend.

**Step 1**  
**Series Name:** Enter a name to define how the series is labeled in the chart legend. The series name is used in the legend.

**Step 2**  
**Y (or Single) Value Member:** From the dropdown, select the field value that is bound to the Y axis for the series.

**Step 3**  
**X Value Member:** From the dropdown, select the field value that is bound to the X axis for the series.

**Step 4**  
**Chart Type:** From the dropdown, select the chart type used to render this series. This is useful if you want to chart several series together, one series could be a bar chart, the other a line chart.

**Step 5**  
**Group Data By:** From the dropdown, select the field by which the series will be grouped.

**Step 6**  
**Text Label Field (Grouped Only):** Enter text to use in the legend.

**Step 7**  
**Series Color (Ungrouped Only):** Click to display a color palette from which you can select the background color.

**Step 8**  
Click **OK** to close tab. Click **OK** again. Then click **Save** at the Chart Wizard.
Chart Wizard Gauge Data Tab

This dialog box is available for Gauges only. Use it to enter the type of gauge you want and the data that is to display in it.

You can create a gauge for numeric fields only.

**Step 1** Field to use for gauge data: From the dropdown, select the field that the gauge will represent.

**Step 2** Gauge Style: From the dropdown, select the type of gauge graphic you want to display. Options are Semi-Circular, Circular, Horizontal, Vertical, Thermometer, and Numeric Digital.

**Step 3** Use report footer value for this field (instead of first row): Check this box if you want the gauge to display the summary for the field instead of the first row.

**Step 4** Scale low value: Enter the minimum value for the gauge.

**Step 5** Scale high value: Enter the maximum value for the gauge.

**Step 6** Range low value: Each gauge can display a highlighted range within the low to high range. This value sets the bottom of the highlighted range.

**Step 7** Range high value: Each gauge can display a highlighted range within the low to high range. This value sets the top of the highlighted range.

**Step 8** Color scheme: From the dropdown, select a color scheme for the gauge graphic. Options are Default, Black and White, Blue, Gold, and LCD.

**Step 9** Click OK to close tab. Then click Save at the Chart Wizard.
Anatomy of a Gauge

- Scale
- Range
- Formatting

Chart Wizard Axes Tab

Use this tab to specify the titles for the X and Y chart axes of the chart series. This tab is available for Charts only.

Axes are not used for certain chart types (for example, they are not used for Pie charts).

Axes must be set to the correct data type. The minimum and maximum values must be set correctly. Axes have their own titles independent of the chart title.

Different types of charts have different types of axis requirements. For example, the step line requires that X-Axis is Time and Y-Axis is Numeric. For details, please refer to [this link](http://help.infragistics.com/Help/NetAdvantage/NET/2008.3/CLR2.0/html/Chart_Axis_Requirements_for_Composite_Charts.html).

**Step 1**

For both the X and the Y axes, enter values as described below:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Enter a title for the axis.</td>
</tr>
<tr>
<td>Minimum Value</td>
<td>Enter a minimum value for the low range of the axis.</td>
</tr>
<tr>
<td>Maximum Value</td>
<td>Enter a maximum value for the low range of the axis.</td>
</tr>
<tr>
<td>Label Format</td>
<td>Enter a character for the format, using the list to the left of the OK button as a reference (Currency: C; Decimal: D, and so forth).</td>
</tr>
<tr>
<td>Label Font Size</td>
<td>Select a font size for the label. The default is 8 point.</td>
</tr>
</tbody>
</table>
### Chart Wizard Legend Data Tab

Use this tab to customize the legend. This tab appears for Charts only.

**Step 1**  
**Legend is visible:** Check this to display the legend.

**Step 2**  
**Legend Left %** Enter the percentage by which the legend is placed from the left of the graphic.

**Step 3**  
**Legend Top %** Enter the percentage by which the legend is placed from the top of the graphic.

**Step 4**  
**Legend Width %** Enter the width percentage of the legend with respect to the graphic.

**Step 5**  
**Legend Height %** Enter the height percentage of the legend with respect to the graphic.

**Step 6**  
Click **OK** to close tab. Then click **Save** at the Chart Wizard.
Chart Wizard Chart Title Tab

Use this tab to create or edit the chart title. This tab appears for both Charts and Gauges.

**Step 1**  
**Title Text:** Enter the title for the report. The default is blank (no title appears for the chart).

**Step 2**  
**Title Top:** Charts only. Enter the distance in pixels that the title appears above the chart. Default is 50 pixels.

**Step 3**  
**Title Left:** Charts only. Enter the distance in pixels that the title appears to the left of the graphic. Default is 5 pixels.

**Step 4**  
**Title Rotation:** Charts only. Enter the If the chart is curved (is a pie chart or a doughnut), the value sets the degree of rotation by which the title curves over the graphic. Default is 0.

**Step 5**  
Click **OK** to close tab. Then click **Save** at the Chart Wizard.
Chapter 17: Working with Charts and Gauges

About Charts and Gauges
Abandoned Calls

A call is considered abandoned if the caller hangs up before being connected to an agent.

A high number of abandoned calls might be an indication that callers are waiting in the queue for too long.

Abandoned calls are reported against the following:
Agent States

- Service: Service reports provide cumulative statistics for all abandoned calls.
- Call Types: Call Type reports provide additional visibility on where calls are abandoning
- Skill Groups: Skill Group reports provide additional visibility on where calls are abandoning

**Note:** Calls that abandon before the Abandon Call Wait Time threshold are considered Short Calls (page 179). For example, if you configure the abandoned call wait time for 10 seconds, and a caller disconnects at nine seconds, that call is a short call and it is not considered offered or abandoned.

**Agent States**

The following states can appear reports. A state with an asterisk (*) is a voice media only state.

- Logged Off = 0
- Logged On = 1
- Not Ready = 2
- *Ready = 3
- *Talking = 4
- Work Not Ready = 5
- Work Ready = 6

An agent doing wrap-up work (post-call activities, such as completing paperwork or consulting with associates) is in either the Work Ready or the Work Not Ready state.

- Busy Other = 7
- Reserved = 8
- Unknown = 9
- *Hold (Calls On Hold) = 10
- Active = 11
- Paused = 12
- Interrupted = 13
- Not Active = 14
Call Types

A Call Type is a category of incoming call. Based on the Call Type, the Router selects the routing script that ultimately sends the call to an appropriate agent.

Each Call Type has a schedule that determines which routing script or scripts are active for that Call Type at anytime.

Call Types are the highest level of reporting entity and the first reporting entity for which Unified ICM captures data. They can be used to provide cradle-to-grave reporting under certain circumstances and can also be used to provide an enterprise view of applications in the call center.

Call Type Intervals

Call Type Intervals are specific time increments that allow you to see data for abandoned and answered calls.

A default set of intervals is provided at the system level, and you can configure call type intervals in relation to your service levels.

For example, if your service level threshold is 15 seconds and you want to see when callers are abandoning within that service level, you can set intervals of 5 seconds, 10 seconds, and 15 seconds.

If you do not configure intervals at the call type level, the system level intervals are used.

To configure call type intervals:

1. First use the Configuration Manager Bucket Interval configuration tool.

2. Then, using the Configuration Manager Call Type configuration tool for a given call type or the Configuration Manager System Information tool for system wide call types, assign intervals to individual call types.

Intervals are measured in minutes and seconds. The header time format is MM:SS.

Reports can show up to ten intervals. You can configure up to nine intervals with the tenth interval showing all the remaining data. Intervals not configured appear as blank intervals in the report and appear after the configured intervals.

No interval headers display if the report is run over a period of time when no data is present. This happens because the report interval headers depend on the data being present.
Error Count

The error count field increments when:

- Translation-routed calls are abandoned while on route to destination target.
- Calls with misconfigured labels use default routing. (In this case, the ICRDefaultRoutedToHalf field also increments.)
- Calls with misconfigured labels do not use default routing (for instance, when a default route has not been defined).

FTE

The full-time equivalent (FTE in reports) is the number of full-time agents that would be required to perform the work done during that interval for a skill group.

To calculate the FTE, Unified IC divides the total time that work was performed by the total time in the interval. For example, if agents spent a total of 3 hours (180 minutes) handling tasks during a half-hour interval (30 minutes), the FTE for task handling during the interval is 180 minutes/30 minutes, which equals 6 full-time persons. This means that if all agents handled tasks full-time, the work could have been done by 6 agents.

Handle Time

HandleTime is the time spent from the call being answered by the agent to the time the agent completed after-call work time for the call.

This includes any HoldTime, TalkTime, and WorkTime associated with the call (from the Termination_Call_Detail table).

The HandleTime value is counted when the after-call work time associated with the call (if any) is completed.

Handled

A handled call is:

- An incoming ACD call that was answered by an agent, and then completed.
- A call associated with Outbound Option that the agent answered, and then completed.
- A non-voice task that the agent started working on then completed.
A handled call/task is completed when the agent associated with the call/task finishes the wrap-up work associated with the call/task.

### Historical Data and Historical Reports

Unified I'M software stores historical information in half-hour summaries.

The Call Router sends these records to the Logger, which in turn writes them to the Central Database. A process on the Logger replicates its database tables to corresponding Half_Hour database tables on the Historical Data Server. These replicated HDS records are used for historical reporting.

Half-hour data is populated in the database only for completed half-hour intervals.

The historical data fields are stored in the database with the extension ”ToHalf” (for example, Skill_Group_Half_Hour.CallsHandledToHalf).

These elements contain a value for a completed half-hour interval. The completed half-hour interval is the time period falling between xx:00:00 and xx:29:59, or xx:30:00 and xx:59:59.

For example, if a call is offered at 15:47:00, it will be counted as an offered call in the 15:30:00 to 15:59:59 half-hour interval. Data for this half-hour interval is not written to the database until the interval is complete (for example 16:00:00). Therefore, the latest calls offered half-hour data is available for the previous completed half-hour interval (that is, the 15:00:00 to 15:29:59).

As a best practice, run large historical reports at off-peak hours. Take advantage of the Scheduled Reports feature to do this.

### Grouped Grids

By default, all reports from stock templates display in grids (tables).

In this release, all reports use a grouped grid - the grouped grid is the only grid available. Reports that formerly used the non-grouped grid are automatically converted to a grouped grid and will revert to a non-grouped setting only if you downgrade to Release 7.5(2).

Click the **Default Grouping** button on the Report Wizard Formatting tab to see or change report groupings.

<table>
<thead>
<tr>
<th>Reports with Grouped Grids</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support dynamic sorting.</td>
</tr>
<tr>
<td>Do not support drilldowns from the grouped columns.</td>
</tr>
<tr>
<td>Support thresholds.</td>
</tr>
<tr>
<td>Support summaries for up to three grouped columns in addition to a summary for the report as a whole.</td>
</tr>
<tr>
<td>Support rows per page</td>
</tr>
</tbody>
</table>
Media Routing Domain

A Media Routing Domain (MRD) is a collection of skill groups and services that are associated with a common media class.

Unified ICM uses Media Routing Domains (MRDs) to organize how requests for different media are routed.

Each skill group is assigned to a Media Routing Domain. Unified ICM software uses MRDs to route a task to an agent who is associated with a skill group and a particular medium.

Each Media Routing Domain belongs to a Media Class.

You can report on activity for all of the MRDs that you have configured in your system. When configuring your system, you first configure MRDs in Configuration Manager and then enable the appropriate MRDs on the Collaboration Server and E-Mail Manager applications. MRDs have unique IDs across the enterprise.

The Voice MRD is created by default for all deployments.

Overflow Out

The software keeps counts of the number of calls moved out of each service or route (overflowed out) and moved into each service or route (overflowed in).

Overflow Out is incremented when the one of the following occurs:

- The call type associated with the current call is changed through use of a Call Type or Requalify node.
- The call is sent to a label using a label node.
- The call is redirected.

When a call is redirected, the PIM no longer can receive events for the call and has no way of referencing or tracking the call.

For example, the call might have been redirected to a non-Unified ICM monitored device and then returned to the switch with a different call ID.

The Unified ICM generates the termination call detail record with only the data originally tracked for the call. Calls marked as Redirected are counted as Overflow Out calls in the Unified ICM service and route tables.

- The call was not default-routed, and the label was not a ring, busy, or announcement label.
• The call hit a release node

In Unified CCE, to more accurately reflect call status, CallDisposition is set to 15 (Redirected) instead of 4 (Abandon Delay) in the following cases:

When a call leaves a CTI route point to be sent to IVR.

When the agent transfers call to another skill group, no agent is available, and the call is sent to IVR

Percent Utilization

Percent utilization (% Utilization in reports) is computed by dividing the total time agents spend handling calls in a skill group by the total time agents were ready to handle tasks.

To calculate the time that an agent was ready, Unified IC subtracts the Not Ready time from the total time that agents were logged on. Percent utilization shows you how well agents are being utilized within a skill group. For example, if the agent spent 20 minutes of the log on duration handling calls and was available to handle calls for 40 minutes, the percent utilization is 50%.

Queries: Pre-Filtered and Post-Filtered

Historical reports use pre-query filtering. The data is filtered when it is retrieved.

Real time reports use post-query filtering. The data is filtered after it is retrieved. If a real time report presents a message that the data set is too large, you need to increase the maximum number of rows per page.

Each field in a report has a Filter Pre-Query flag.

This flag is a set by a checkbox in the Data Source tab. To access this tab:

• Edit the report to open Report Wizard.

• Locate and right-click the field.

• Select Field Properties.

• Click the Data Source tab.

As a best practice, fields in real-time reports should not have Filter Pre-query checked.

When Filter Pre-Query is not checked, all data is retrieved and is filtered at the query level. If two users launch the same report, they have access to the same data, and it is filtered at the time they look at it.
Each viewer can see what they want from the shared data pool.

It is possible to get an error for real-time reports (data set is too large) - in which case, you need to change the max number of rows per page.

**All fields in an historical report should have the Filter Pre-Query field checked.**

It is unlikely that two users will want to see the same values/collections for the same date/time range.

The filter is injected into the SQL Query. Data is filtered pre-query.

---

**Real Time Data and Real-Time Reports**

In real-time, each PG passes current status information to Unified ICM software. This current (real-time) data, which is kept in the Router’s memory, includes data about agents, skill groups, services, Call Types, trunk groups, and other entities.

Every 15 seconds (by default), the Router forwards the current (in-memory) data to the Distributor Admin Workstation, where it is stored on a number of real-time tables in the local Admin Workstation databases and distributed to the Client AWs.

Old real-time data is constantly overwritten by new real-time data.

<table>
<thead>
<tr>
<th>Time Increment</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Half</td>
<td>&quot;Half&quot; values contain a value for the current half-hour. The current half-hour is defined as the time period falling between xx:00:00 and xx:29:59, or xx:30:00 and xx:59:59. For example, if it is currently xx:18:33, the CallsOfferedHalf real-time element contains a value that reflects the first 18 minutes and 33 seconds of the specific half-hour. When a new half-hour begins, at time (xx:00:00 or xx:30:00), the database element is reset to zero.</td>
</tr>
<tr>
<td>Now</td>
<td>&quot;Now&quot; contains a snapshot of the activity at a particular instant (the last check). For example, Unified ICM software tracks CallsQNow, which is the number of calls currently in queue for a service or route. When a call is answered, the CallsQNow count is reduced immediately by one (-1) because the call has left the queue. This change is seen at the next real-time update of the report screen.</td>
</tr>
<tr>
<td>To5</td>
<td>The &quot;To5&quot; values track data on a rolling five-minute basis. The rolling five-minute data employs a&quot;sliding&quot; five-minute window. The To5 data is updated every three seconds. When the oldest three-second interval expires, a new three-second interval is added. In this manner, the window is always placed on the current five-minute interval.</td>
</tr>
</tbody>
</table>
Time Increment | Description
--- | ---
Today | To arrive at values for "Today", Unified ICM software adds the values at the end of each half-hour interval since midnight. It also counts the values for the current half-hour.

At the end of each half hour, half-hour data (for example CallsOfferedHalf) is summed into the Today data.

At midnight, the real-time Today count is cleared in the database. Midnight is defined using the time of the peripheral.

Real-time reports are generally small, with fewer than 20 rows. They are refreshed by default every 30 seconds. This refresh rate value is configurable on the Report Wizard Data Settings tab.

Service Levels

The service level tells you what percentage of calls are answered within the amount of time specified in the service level threshold.

Service-level data is collected in the Unified ICM Schema database for call types, services, routes, and peripherals. This data can be viewed in Unified CC reports.

NOTE: With the existence of a network VRU, when calls are translation-routed, the measurement of service level begins when the call arrives at the routing script, or when its call type is changed.

This means that if self-service is performed on a call before the call is queued to an agent, the routing script must be set up to change the call type of the call when self-service is completed. Otherwise, the time spent in self-service will negatively impact the service level.

Service-level Threshold

Service-level threshold is the number of seconds set as the maximum time a caller should wait before being connected with an agent. Calls answered within the service-level threshold are considered to have met the service level, while calls not answered within the service-level threshold are considered not to have met the service level.

For example, if you set a service-level threshold of 30 seconds, you want all calls to be answered within 30 seconds. Every call answered within 30 seconds improves the service level. Every call that is not answered within 30 seconds reduces the service level.

Using 30 seconds as an example threshold, if you had 50 calls that were answered in under 30 seconds and 80 calls that took longer than 30 seconds to answer, then Unified ICM software, when ignoring abandoned calls, would calculate the service level as follows: 50/(50+80) x 100 = Service Level %

In this example, the service level would be 38 percent.
Service level can be computed in three ways, depending on how calls that abandon before the service-level timer expires are treated. Each computation is described in the Unified ICM Service-Level Calculation section further on in this topic.

**Service-Level Event**

Calls are counted for service level purposes as soon as it is determined how the call contributes to the service-level calculation. This determination is made when either the call is answered, the caller abandons, or the service-level timer passes before the call is answered or abandoned - whichever occurs first.

Each of these events are called a *service-level event*:

- The call is answered by an agent before the service-level threshold expires. In this case, the ServiceLevelCalls and ServiceLevelsCallsOffered database fields are incremented.

- The call abandons or Re-routes on No Answer (RONAs) to IVR before the service-level threshold expires. In this case, the ServiceLevelAband and ServiceLevelCallsOffered database fields are incremented.

- The call reaches the service-level threshold without being answered by an agent or abandoned. In this case, only the ServiceLevelCallsOffered database field is incremented.

Tasks that abandon before the short calls timer, as defined in the Unified ICM configuration, do not count towards the service level offered or service level abandoned call counters. Also, calls that encounter an error condition or are sent to non-monitored devices (using the label node) within the service-level threshold do not affect the service level.

**Enterprise Service-Level Calculation**

Any call that has a service-level event is treated as a service-level call offered, which means that it will be used in the service-level calculation. Unified ICM software provides a uniform calculation across all peripherals.

Enterprise service level can be calculated in any of three ways:

- Abandoned calls ignored.
  
  The number of calls answered within the service-level threshold divided by the number of calls that had a service-level event minus the number of calls that were abandoned before exceeding the service-level threshold. Calls abandoned before the service-level threshold expired are removed from this calculation.

- Abandoned calls negatively impact service level.
  
  The number of calls answered within the service-level threshold divided by the number of calls that had a service-level event. This treats abandoned calls as though they had exceeded the service-level threshold.

- Abandoned calls positively impact service level.
The number of calls answered within the service-level threshold plus the number of calls abandoned within the threshold, all divided by the number of calls that had a service-level event. This treats abandoned calls as though they were answered within the service-level threshold.

The System Manager specifies which service-level calculation to use when the peripheral service is configured. Regardless of the service-level calculation method being used, Unified ICM tracks the data needed to calculate the service level.

**Peripheral Service Level**

While Unified ICM software calculates its own service level, it also tracks, for some peripherals, the service level calculated by the peripheral. This service level, called the peripheral service level, is a proprietary service level as calculated by the peripheral. Some peripherals support more than one type of service-level calculation. The method of service-level calculation used by the peripheral is set by the System Manager when the peripheral service is configured.

**Note:** If Unified ICM software is connected to CCE through an CCE Gateway PG, peripheral service levels are not applicable.

**Configuring Service Levels**

You can configure service-level calculations and their thresholds in the Unified ICM Configuration Manager.

Note: In the Configuration Manager, the service level for the peripheral is configured separately from that of the Unified ICM/CCE Service Level (the service level for call types, services, and routes).

**Service Levels and Skill Groups**

If agents log in to sub-priorities within a Skill Group, the Service Level LAA includes only those agents who are logged in to the Priority 1 skill level. All other agents in all other skill priorities are not considered in the Service Level LAA.

**Example Call Type Service-Level Calculations**

In an IP Contact Center environment, Call Types are used to calculate service levels. Call Type reports display this service-level data.

The following are the service-level calculations for call types

- **SL Aban Ignored**

  The Unified ICM/CCE Enterprise service level where abandoned tasks are ignored. The calculation removes tasks abandoned after the service-level threshold for the half-hour interval. Derived from:

  \[
  \text{SL Aban Ignored} = \frac{\text{Call\_Type\_Half\_Hour\_Service\_Level\_Calls\_Half}}{(\text{Call\_Type\_Half\_Hour\_Service\_Level\_Calls\_Offered\_Half} - \text{Call\_Type\_Half\_Hour\_Service\_Level\_Aband\_Half})}
  \]

- **SL Aban Positive**
The Unified ICM/CCE Enterprise service level where abandoned tasks positively impact the service level. This calculation treats abandoned tasks as though they were connected within the service-level threshold for the half-hour interval. Derived from:

\[
\frac{(\text{Call\_Type\_Half\_Hour\_ServiceLevel\_Calls\_Half} + \text{Call\_Type\_Half\_Hour\_ServiceLevel\_Aband\_Half})}{\text{Call\_Type\_Half\_Hour\_ServiceLevel\_Calls\_Offered\_Half}}
\]

- **SL Aban Negative**

The Unified ICM/CCE Enterprise service level where abandoned tasks negatively impact the service level. This calculation treats abandoned tasks as though they had exceeded the service-level threshold for the half-hour interval. Derived from:

\[
\frac{\text{Call\_Type\_Half\_Hour\_ServiceLevel\_Calls\_Half}}{\text{Call\_Type\_Half\_Hour\_ServiceLevel\_Calls\_Offered\_Half}}
\]

Example Service-Level Calculations

In a Unified ICM environment, services are used to calculate service levels. Service reports display this service-level data. These reports are not appropriate for IP Contact Centers.

The following are the service-level calculations for services:

- **SL Aban Ignored**

The Unified ICM/CCE Enterprise service level where abandoned tasks are ignored. The calculation removes tasks abandoned after the service-level threshold for the half-hour interval. Derived from:

\[
\frac{\text{Service\_Half\_Hour\_ServiceLevel\_Calls\_To\_Half}}{\text{Service\_Half\_Hour\_ServiceLevel\_Calls\_Offered\_To\_Half} - \text{Service\_Half\_Hour\_ServiceLevel\_Aband\_To\_Half}}
\]

- **SL Aban Positive**

The Unified ICM/CCE Enterprise service level where abandoned tasks positively impact the service level. This calculation treats abandoned tasks as though they were connected within the service-level threshold for the half-hour interval. Derived from:

\[
\frac{(\text{Service\_Half\_Hour\_ServiceLevel\_Calls\_To\_Half} + \text{Service\_Half\_Hour\_ServiceLevel\_Aband\_To\_Half})}{\text{Service\_Half\_Hour\_ServiceLevel\_Calls\_Offered\_To\_Half}}
\]

- **SL Aban Negative**

The Unified ICM/CCE Enterprise service level where abandoned tasks negatively impact the service level. This calculation treats abandoned tasks as though they had exceeded the service-level threshold for the half-hour interval. Derived from:

\[
\frac{\text{Service\_Half\_Hour\_ServiceLevel\_Calls\_To\_Half}}{\text{Service\_Half\_Hour\_ServiceLevel\_Calls\_Offered\_To\_Half}}
\]
Services

A Service is a particular type of processing required by the caller.

An Enterprise Service is a configured entity that serves to group a collection of Services on different peripherals. Configuring them allows you to report on applications across all ACDs, thus providing an enterprise view.

Short Calls

A short call is a call that is either abandoned very quickly or answered and terminated very quickly. By defining what you believe to be a short call, you can filter out from reporting metrics those calls that did not stay in the system long enough to be considered and counted as events.

You can configure the number of seconds for an abandoned short call and the number of seconds for an answered short call.

Skill Groups

An agent skill group is a collection of agents at a single contact center who share a common set of competencies and can handle the same types of requests.

An Enterprise Skill Group is a configured entity that serves to group a collection of skill groups on different peripherals. Configuring them allows you to report on skill groups across all ACDs, thus providing an enterprise view.

A peripheral skill group is a skill group associated with a specific single peripheral (ACD, PBX, IVR) in the contact center enterprise.

Superheaders in Report Templates

Unified IC report templates differ from their corresponding WebView templates in that the columns in the generated reports are not organized by superheaders.

Columns in Unified IC reports can be moved, renamed, added, and removed. This flexibility means that superheaders are not possible.

Although the superheaders do not appear, all the columns from the corresponding WebView templates are present in the Unified IC templates.

Here is an example of the WebView agent25 report.
Superheaders in Report Templates

Figure 47: WebView Report with SuperHeader

<table>
<thead>
<tr>
<th>Completed Tasks</th>
<th>Agent State Times</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incomplete Tasks</td>
<td>Aban Hold</td>
</tr>
<tr>
<td>Hold Time</td>
<td></td>
</tr>
<tr>
<td></td>
<td>RONA</td>
</tr>
<tr>
<td></td>
<td>Aban Hold</td>
</tr>
<tr>
<td></td>
<td>Trans Out</td>
</tr>
<tr>
<td></td>
<td>Log On Duration</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note the superheaders for Completed Tasks, for Incoming Hold Tasks (within Completed Tasks), and for Agent State Times.

Here is an example of the Unified IC Agent Historical All Fields Historical report.

Figure 48: Unified IC Report with No Superheader

Note that it includes the same fields as the WebView agent25 report, with no superheaders.
Part 6: Unified ICM/CC Templates

Chapters in Part 4 document the stock reporting templates for the Unified ICM/CC database that are installed with Unified IC.

Agent Reports (page 183)
Call Type Reports (page 211)
Service Reports (page 227)
Skill Group Reports (page 239)
Trunk Group Report (page 271)
Agent Reports

This chapter contains the following topics:

- Agent Historical All Fields, page 183
- Agent Real Time All Fields, page 189
- Agent Not Ready Detail, page 193
- Agent Team Historical All Fields, page 196
- Agent Team Real Time All Fields, page 202
- Agent Team State Counts Real Time, page 205

Agent Historical All Fields

About the Agent Historical All Fields Report (page 183)

Visible Fields in the Agent Historical All Fields Report (page 185)

Hidden Fields in the Agent Historical All Fields Report (page 188)

About the Agent Historical All Fields Report

Reports generated from this template show all data for the agents in the selected skill groups for the selected interval.

Note: This report is the same report as the Agent Skill Group Historical All Fields (page 239), report except that this report is first sorted by skill group rather than by agent.

The simple filter for this report is slightly different than the filter for other historical reports. This report data is built from an Anonymous Block.

For reports which need to fetch more than the system specified maximum row limit (default row limit is 3000), you must modify the Row Limit value in the Web Application Settings window that is part of the Configuration Tool. However, for reports that use Anonymous
Block and Stored Procedures, you also need to update the number of rows, that need to be fetched from the database, in the query command of the Anonymous Block and the Stored Procedures in the report template. For more information, see Modify the Number of Rows to be Extracted (page 141).

**Applicable Environment:** Unified CCE and Unified ICM.

**Grouping:** This template is grouped and sorted by Agent Name and then by Skill Group Name.

**Value List:** Agent

**Historical Key Field:** AgentID

**Corresponding WebView templates:**


**Note:**

- This template differs from the corresponding WebView template (agent25) in that it does not organize data by "superheaders." This template uses a grouped grid that does not support superheaders.

- For more information and an illustration, see About Superheaders in Report Templates (page 179)

- See also Grouped Grids (page 171).

This template also corresponds to these WebView Templates:

- agent25: Agent Consolidated Half Hour
- agent27: Agent Historical All Fields
- agent23: Agent Performance Summary Half Hour
- agent21: Agent Task Summary Half Hour

**Database Schema Table(s) from which data is retrieved:**

- Agent
- Media_Routing_Domain
- Person
- Agent_Skill_Group_Half_Hour
- Skill_Group

**See also:**
Visible Fields in the Agent Historical All Fields Report (page 185)

Hidden Fields in the Agent Historical All Fields Report (page 188)

Visible Fields in the Agent All Fields Historical Report

Visible fields are those fields that appear in a report generated from the stock template.

Visible fields are listed below in the order (left to right) in which they appear by default in the stock template.

Note: Fields applicable to a voice domain only are marked with an asterisk (*). Such fields are not applicable for e-mail or collaboration media.

Agent Name

This is a calculated field, derived from: Person.LastName "," Person.FirstName

The first and last name of the agent.

Skill Group Name

Derived from: Skill_Group.EnterpriseName

The agent skill group's enterprise name

DateTime

Derived from: Agent_Skill_Group_Half_Hour.DateTime

The date and time of the selected row's data in MM/DD/YYYY (month, day, year) and HH:MM:SS (hour, minute, second) format.

Handled

Derived from: Agent_Skill_Group.HandledCallsTalkTime

The number of inbound calls that have been answered and have completed wrap-up by agents in the skill group during the half-hour interval.

AHT

This is a calculated field, derived from:
(Agent_Skill_Group_Half_Hour.HandledCallsTimeToHalf / Agent_Skill_Group_Half_Hour.CallsHandledToHalf)

The average time spent by the agent in handling a task in the half hour interval, measured in HH:MM:SS (hours, minutes, seconds).

Held

Derived from: Agent_Skill_Group_Half_Hour.IncomingCallsOnHoldToHalf
The number of incoming calls to this agent that were placed on hold in the half hour interval.

**Avg Hold**

This is a calculated field, derived from:
\[
\text{Avg Hold} = \frac{\text{Agent\_Skill\_Group\_Half\_Hour.Incoming Calls On Hold Time To Half}}{\text{Agent\_Skill\_Group\_Half\_Hour.Incoming Calls On Hold To Half}}
\]

The average time in HH:MM:SS (hours, minutes, seconds) that calls were put on hold in the half hour interval, for all incoming calls which included hold time.

**Aban Ring**

Derived from: Agent\_Skill\_Group\_Half\_Hour.Abandon Ring Calls To Half

For voice: the total number of calls that were abandoned while the agent's phone was ringing.

For non-voice: the total number of tasks that were abandoned while being offered to an agent.

**RONA**

Derived from: Agent\_Skill\_Group\_Half\_Hour.Redirect No Ans Calls To Half

The number of tasks that left the agent's phone or terminal that were redirected to another dialed number because of no answer in the half hour interval.

**Aban Hold**

Derived from: Agent\_Skill\_Group\_Half\_Hour.Abandon Hold Calls To Half

The number of Unified ICM routed calls to the agent that abandoned while the call was on hold and/or the number of paused tasks that the agent ended in the half hour interval.

**Trans In **

Derived from: Agent\_Skill\_Group\_Half\_Hour.Transferred In Calls To Half

The number of incoming calls that were transferred to this agent from other agents within the same peripheral that did not go to IVR for queuing in the half hour interval. This value is updated when the agent completes the call.

**Note:** For blind transfers in Unified CCE with a Unified CCE System PG, this field is updated when the call that was blind transferred to an IVR is subsequently transferred to another agent and the agent answers the call. For this call scenario this field is not updated in Unified CCE without an Unified CCE System PG

**Trans Out **

This is a calculated field, derived from:
\[
\text{Trans Out} = \text{Agent\_Skill\_Group\_Half\_Hour.Transferred Out Calls To Half} + \text{Agent\_Skill\_Group\_Half\_Hour.Net Transferred Out Calls To Half}
\]
The number of calls this agent transferred to another agent or skill group in the half hour interval. This includes Consultative Calls if this transfer was consultative-not blind. The value is updated at the time the agent completes the transfer of the call.

**Ext Out** *

Derived from: **Agent_Skill_Group_Half_Hour.AgentOutCallsToHalf**

The number of outgoing external calls that this agent made in the half hour interval.

**Log On Duration**

Derived from: **Agent_Skill_Group.LoggedOnTime**

The total time during the interval the agent was logged in, measured in HH:MM:SS (hours, minutes, seconds) format.

**% Active**

This is a calculated field, derived from: 

\[
\frac{(Agent\_Skill\_Group\_Half\_Hour.TalkInTimeToHalf + Agent\_Skill\_Group\_Half\_Hour.TalkOutTimeToHalf + Agent\_Skill\_Group\_Half\_Hour.TalkOtherTimeToHalf + Agent\_Skill\_Group\_Half\_Hour.TalkAutoOutTimeToHalf + Agent\_Skill\_Group\_Half\_Hour.TalkPreviewTimeToHalf + Agent\_Skill\_Group\_Half\_Hour.TalkReserveTimeToHalf) \times Agent\_Skill\_Group\_Half\_Hour.LoggedOnTimeToHalf}{Agent\_Skill\_Group\_Half\_Hour.LoggedOnTimeToHalf}
\]

The percentage of time that the agent has spent talking on calls in this skill group in relation to the agent's LoggedOnTime.

**% Hold**

This is a calculated field, derived from: 

\[
\frac{Agent\_Skill\_Group\_Half\_Hour.HoldTimeToHalf \times Agent\_Half\_Hour.LoggedOnTimeToHalf}{Agent\_Half\_Hour.LoggedOnTimeToHalf}
\]

The percentage of time that the agent has put a call on hold or paused a task in relation to LoggedOnTime or the half hour interval, whichever is less.

**% Not Active**

This is a calculated field derived from: 

\[
\frac{Agent\_Skill\_Group\_Half\_Hour.AvailTimeToHalf \times Agent\_Half\_Hour.LoggedOnTimeToHalf}{Agent\_Half\_Hour.LoggedOnTimeToHalf}
\]

The percentage of time that the agent has spent in the Not Active or Available state in relation to LoggedOnTime. Applies to all skill groups.

**% Not Ready**

This is a calculated field, derived from: 

\[
\frac{Agent\_Skill\_Group\_Half\_Hour.NotReadyTimeToHalf \times Agent\_Skill\_Group\_Half\_Hour.LoggedOnTimeToHalf}{Agent\_Skill\_Group\_Half\_Hour.LoggedOnTimeToHalf}
\]

The percentage of time that the agent has spent in the Not Ready state in relation to LoggedOnTime or the half hour interval, whichever is less. Applies to all skill groups.
This is a calculated field, derived from:
\((\text{Agent\_Skill\_Group\_Half\_Hour.ReservedStateTimeToHalf} / \text{Agent\_Skill\_Group\_Half\_Hour.LoggedOnTimeToHalf})\)

The percentage of time that the agent has spent in Reserved state waiting for an Unified ICM routed task from this skill group in relation to LoggedOnTime.

% Wrap Up

This is a calculated field, derived from:
\(((\text{Agent\_Skill\_Group\_Half\_Hour.WorkReadyTimetoHalf} + \text{Agent\_Skill\_Group\_Half\_Hour.WorkNotReadyTimetoHalf}) / \text{Agent\_Skill\_Group\_Half\_Hour.LoggedOnTimeToHalf})\)

The percentage of time that the agent has spent in Wrap-up state after an incoming or outgoing calls to/from this skill group in relation to LoggedOnTime.

% Busy Other

This is a calculated field, derived from:
\((\text{Agent\_Skill\_Group\_Half\_Hour.BusyOtherTimetoHalf} / \text{Agent\_Skill\_Group\_Half\_Hour.LoggedOnTimeToHalf})\)

The percentage of time that the agent has spent in the BusyOther state in relation to LoggedOnTime.

Note: The agent state time percentages in the Report Summary row will only add up to 100% when ALL of the skill groups for an agent have been selected. When viewing a subset of an agent's skill groups, the percentages may not balance.

**Report Summary:** There is a summary for Skill Group Name and a report summary for all data. See About Report Summaries (page 121).

**Hidden Fields in the Agent Historical All Fields Report**

Hidden fields for this template are listed in the Simple Wizard (page 114).

The data source for each hidden field is displayed in the Report Wizard Field Map tab. See Report Field Data Source (page 120).

**Sample Agent Historical All Fields Report**

This illustration is a sample of the report generated from the Agent Historical All Fields template.
Agent Real Time All Fields

About the Agent Real Time All Fields Report (page 189)

Visible Fields in the Agent Real Time All Fields Report (page 190)

Hidden Fields in the Agent Real Time All Fields Report (page 193)

About the Agent Real Time All Fields Report

This report presents a table of selected agents showing each agent's currently active skill group, state, and call direction within each media routing domain into which the agent is logged.

Applicable Environment: Unified CCE and Unified ICM.

Grouping: This report is grouped and sorted by agent name.
Value List: Agent

Corresponding WebView template: The visible fields in this report match agent20: Agent Real Time WebView Report

This template also corresponds to these WebView Templates:

• agent20: Agent Real Time
• agent28: Agent Real Time All Fields

Database Schema Table(s) from which data is retrieved:

• Agent
• Agent_Real_Time
• Controller_Time
• Media_Routing_Domain
• Person
• Skill_Group

See also:

Visible Fields in the Agent Real Time All Fields Report (page 190)
Hidden Fields in the Agent Real Time All Fields Report (page 193)

Visible Fields in the Agent Real Time All Fields Report

Visible fields are those fields that appear in a report generated from the stock template.

Visible fields are listed in the order (left to right) in which they appear by default in the stock template.

Note: Fields applicable to a voice domain only are marked with an asterisk (*). Such fields are not applicable for e-mail or collaboration media.

Agent Name

Derived from: Person.LastName , Person.FirstName

The last and first name of the agent.

Extension

Derived from: Agent_Real_Time.Extension
The phone extension into which the agent is logged.

**LogOn DateTime**

Derived from: Agent_Real_Time.DateTimeLogin

The date and time that the agent logged in. The format is MM/DD/YYYY (month, day, year) and HH:MM:SS (hour, minute, second) format.

**Active Skill Group**

Derived from: Skill_Group.EnterpriseName

The skill group associated with the task on which the agent is currently working. If the agent is not involved in any task in the media routing domain, this field shows Not Applicable. Since an agent can be logged into multiple skill groups, this field is not filled until the agent is assigned a task.

**Agent State**

Derived from: Agent_Real_Time.AgentState

The current state of the agent. See Agent States (page 168).

**Mobile Agent Mode**

Derived from: Agent_Real_Time.PhoneType

The mode by which the agent is connected (populated for CCE only):

0 = Not Mobile (Local agent; normal ACD/CCE phone or non-voice task)
1 = Call By Call (Mobile agent's phone is connected for each incoming call)
2 = Nailed Connection (Mobile agent calls and logs in once; line remains connected through multiple calls)

**Mobile Agent Phone #**

Derived from: Agent_Real_Time.RemotePhoneNumber

For a mobile agent (an agent working remotely), the current phone number. Populated for CCE only.

**Duration in Current State**

This is a calculated field derived from: DATEDIFF(seconds, Agent_Real_Time.DateTimeLastStateChange, getdate())

The time spent in the current agent state in HH:MM:SS (hours, minutes, seconds) format.

**Reason Code**
Derived from: Agent_Real_Time.ReasonCode

A code received from the peripheral that indicates the reason for the agent's last state change. If the code is not defined, this displays 0.

**Note:** For reason codes to be displayed in a report, the agent's CTI OS desk settings and CTI OS registry settings need to be configured to display the reason code. Set this in the Unified ICM Configuration Manager Agent Desk Settings List tool.

**Supv Assist Reqstd** *

Derived from: Agent_Real_Time.RequestedSupervisorAssist

Whether or not the agent requested supervisor assistance: No|Yes.

**Direction**

Derived from: Agent_Real_Time.Direction

The direction of active task:

- In (inbound task - non voice tasks are always inbound)
- Out (outgoing external task)
- Other (outgoing or incoming internal task)
- Not Applicable (if the logged in agent is not active in the skill group)

**Destination** *

Derived from: Agent_Real_Time.Destination

The type of outbound task on which the agent is currently working.

**Avail in MRD**

Derived from: Agent_Real_Time.AvailableInMRD

Whether or not the agent is available to accept a task in this media routing domain:

- NO (Not available)
- YES_ICM (Unified ICM available in media routing domain)
- YES_APP (Application available in media routing domain)

An agent is available for a task in a media routing domain (MRD) if the agent's state in that MRD is anything other than Not Ready, and the agent is not at the agent's maximum task limit for the MRD, and the agent is not working on a non-interruptible task in another MRD. If an agent is ICM-available, then Unified ICM can assign tasks to the agent. If an agent is Application-available, then the application can assign tasks to the agent. In the former case,
only Unified ICM can assign tasks to the agent. In the latter, only the application can assign tasks to the agent.

**Report Summary:** There is a summary row for all report data.

See About Report Summaries (page 121).

Hidden Fields in the Agent Real Time All Fields Report

Hidden fields for this template are listed in the Simple Wizard (page 114).

The data source for each hidden field is displayed in the Report Wizard Field Map tab. See Report Field Data Source (page 120).

Sample Agent Real Time All Fields Report

This illustration is a sample of the report generated from the Agent Real Time All Fields template.

![Sample Agent Real Time All Fields Report](image)

**Agent Not Ready Detail**

About the Agent Not Ready Detail Report (page 193)

Visible Fields in the Agent Not Ready Detail Report (page 194)

Hidden Fields in the Agent Not Ready Detail Report (page 196)

**About the Agent Not Ready Detail Report**

Run this report to check agent availability in a logon session.

The simple filter for this report is slightly different than the filter for other historical reports. This report data is built from an Anonymous Block.

For reports which need to fetch more than the system specified maximum row limit (default row limit is 3000), you must modify the Row Limit value in the Web Application Settings window that is part of the Configuration Tool. However, for reports that use Anonymous Block and Stored Procedures, you also need to update the number of rows, that need to be fetched from the database, in the query command of the Anonymous Block and the Stored Procedures in the report template. For more information, see Modify the Number of Rows to be Extracted (page 141).
Applicable Environment: Unified CCE and Unified ICM.

Grouping: This report is grouped and sorted by Agent Name and then by Logon Date Time.

Value List: Agent


Database Schema Table(s) from which data is retrieved:

- Agent
- Agent_Event_Detail
- Media_Routing_Domain
- Person
- Reason_Code

Notes:

The report returns accurate data for COMPLETED Not Ready activity only. Rows in the report marked with an asterisk (*) have incomplete data, and therefore the calculations in them will not be accurate.

Important: To report on agent Not Ready reason codes, configure the Not Ready Reason codes in the ICM Configuration Manager AND on the agent desktop software (CTI or Cisco Agent Desktop).

In a Unified CCE environment, ensure that agent event detail is enabled on the peripheral. It is enabled by default in the ICM Configuration Manager for the Unified CCE peripheral only.

See also:

Visible Fields in the Agent Not Ready Detail Report (page 194)

Hidden Fields in the Agent Not Ready Detail Report (page 196)

Visible Fields in the Agent Not Ready Detail Report

Visible fields are those fields that appear in a report generated from the stock template.

Visible fields are listed in the order (left to right) in which they appear by default in the stock template.

Agent Name

The first and last name of the agent.
Derived from: Person.LastName "," Person.FirstName

**LogOn Date Time**

The date and time the agent logged on, measured in MM:DD:YYYY (month, day, year) and HH:MM:SS (hours, minutes, seconds) format.

This is a calculated field derived from: (Agent_Logout.LogoutDateTime - Agent_Logout.LoginDuration)

**Logon Duration**

The date and time the agent logged on, measured in MM:DD:YYYY (month, day, year) and HH:MM:SS (hours, minutes, seconds) format.

This is a calculated field derived from: (Agent_Logout.LogoutDateTime - Agent_Logout.LoginDuration)

**Reason Code**

A code and text (if configured) from the peripheral that indicates the reason for the agent's last state change. If not defined, this displays 0.

This is a calculated field derived from: Reason_Code.ReasonCodeName (if reason code text is configured) and Agent_Event_Detail.ReasonCode

**Duration**

The amount of time in HH:MM:SS (hours, minutes, seconds) that the agent spent in the Not Ready state for the given reason.

Derived from: Agent_Event_Detail.Duration

**% Logon Duration**

The percent of the agent's total logon session that the agent spent in the Not Ready state for the given reason.

This is a calculated field derived from: (Agent_Event_Detail.Duration / (Agent_Event_Detail.DateTime - Agent_Event_Detail.LoginDateTime))

**% Not Ready**

The percentage of time an agent spent in each Not Ready state relative to the other Not Ready states.

This is a calculated field derived from: Derived from: ((Agent_Event_Detail.Duration / (sum of Agent_Event_Detail.Duration for all not ready reason codes))

**Report Summary:** This report has a summary row for Agent Name and a report summary for all data. See About Report Summaries (page 121).
Hidden Fields in the Agent Not Ready Detail Report

Hidden fields for this template are listed in the Simple Wizard (page 114).

The data source for each hidden field is displayed in the Report Wizard Field Map tab. See Report Field Data Source (page 120).

Sample Agent Not Ready Detail Report

This illustration is a sample of the report generated from the Agent Not Ready Detail template.

Figure 53: Agent Not Ready Detail Report

Agent Team Historical All Fields

About the Agent Team Historical All Fields Report (page 196)

Visible Fields in the Agent Team Historical Report (page 197)

Hidden Fields in the Agent Team Historical Report (page 201)

About the Agent Team Historical All Fields Report

Reports generated from this template show all the available report team data from the Agent_Skill_Group_Half_Hour database table for each selected team during the time period selected.

Applicable Environment: Unified CCE and Unified ICM.

Grouping: This template is grouped and sorted by Agent Team Name, and then by Supervisor, and then by Agent Name.

Value List: Agent Team
Corresponding WebView template: The visible fields in this report will match agteam25: Agent Team Consolidated Half Hour WebView Report

The report also contains fields from the following WebView templates:

- All fields from agteam27: Agent Team Historical All Fields.
- Calculated fields from agteam23: Agent Team Performance Summary Half Hour
- Calculated fields from agteam21: Agent Team Task Summary Half Hour

Note:

- This template differs from the corresponding WebView template (agteam25) in that it does not organize data by "superheaders." This report uses a grouped grid that does not support superheaders.
- For more information and an illustration, see About Superheaders in Report Templates (page 179).

Also see Grouped Grids (page 171).

Database Schema Table(s) from which data is retrieved:

- Agent
- Agent_Skill_Group_Half_Hour
- Agent_Team
- Agent_Team_Member
- Media_Routing_Domain
- Person
- Skill_Group

See also:

Visible Fields in the Agent Team Historical Report (page 197)

Hidden Fields in the Agent Team Historical Report (page 201)

Visible Fields in the Agent Team Historical All Fields Report

Visible fields are those fields that appear in a report generated from the stock template.

Visible fields are listed in the order (left to right) in which they appear by default in the stock template.
Agent Team Historical All Fields

Note: Fields applicable to a voice domain only are marked with an asterisk (*). Such fields are not applicable for e-mail or collaboration media.

Agent Team Name
Derived from: Agent_Team.EnterpriseName
The Enterprise Name of the agent team.

Supervisor
Derived from: Person.LastName + ' ' + Person.FirstName
The agent teams' primary supervisor.

Agent Name
Derived from: Person.LastName"," Person.FirstName
The last and first name of the agent.

DateTime
Derived from: Agent_Skill_Group_Interval.DateTime

Handled
The number of Unified ICM Routed tasks this agent has handled.
Derived from: Agent_Skill_Group_Half_Hour.CallsHandledtoHalf

AHT
This is a calculated field derived from:
(Agent_Skill_Group_Half_Hour.HandledCallsTimeToHalf / Agent_Skill_Group_Half_Hour.CallsHandledToHalf)
The average time spent by the agent in handling a task, measured in HH:MM:SS (hours, minutes, seconds).

Held Tasks
Derived from: Agent_Skill_Group_Half_Hour.IncomingCallsOnHoldToHalf
The number of incoming calls to this agent that were placed on hold.

Avg Hold
The average time in HH:MM:SS (hours, minutes, seconds) that calls were put on hold, for all incoming calls which included hold time.
This is a calculated field derived from:
(Agent_Skill_Group_Half_Hour.IncomingCallsOnHoldTimeToHalf / 
Agent_Skill_Group_Half_Hour.IncomingCallsOnHoldToHalf)

**Aban Ring**

Derived from: Agent_Skill_Group_Half_Hour.AbandonRingCallsToHalf

For voice: the total number of calls that were abandoned while the agent's phone was ringing. For non-voice: the total number of tasks that were abandoned while being offered to an agent.

**RONA**

Derived from: Agent_Skill_Group_Half_Hour.RedirectNoAnsCallsToHalf

The number of tasks that left the agent's phone or terminal that were redirected to another dialed number because of no answer.

**Aban Hold**

Derived from: Agent_Skill_Group_Half_Hour.AbandonHoldCallsToHalf

The number of Unified ICM routed calls to the agent that abandoned while the call was on hold and/or the number of paused tasks that the agent ended in the half hour interval.

**Trans In** *

Derived from: Agent_Skill_Group_Half_Hour.TransferredInCallsToHalf

The number of incoming calls that were transferred to this agent from other agents within the same peripheral that did not go to IVR for queuing. This value is updated when the agent completes the call.

**Trans Out** *

This is a calculated field derived from:
Agent_Skill_Group_Half_Hour.TransferredOutCallsToHalf + 
Agent_Skill_Group_Half_Hour.NetTransferredOutCallsToHalf

The number of calls this agent transferred to another agent or skill group. This includes Consultative Calls if this transfer was consultative-not blind. This value is updated when the agent completes the transfer.

**Ext Out** *

Derived from: Agent_Skill_Group_Half_Hour.AgentOutCallsToHalf

The number of Outgoing external calls that this agent made in the half hour interval.

**Log On Duration**

Derived from: Agent_Half_Hour.LoggedOnTimeToHalf
The total time in the half hour interval the agent was logged in, measured in HH:MM:SS (hours, minutes, seconds) format.

**% Active**

This is a calculated field derived from: 
\[
\frac{\text{Agent\_Skill\_Group\_Half\_Hour\_TalkInTimeToHalf} + \text{Agent\_Skill\_Group\_Half\_Hour\_TalkOutTimeToHalf} + \text{Agent\_Skill\_Group\_Half\_Hour\_TalkOtherTimeToHalf} + \text{Agent\_Skill\_Group\_Half\_Hour\_TalkAutoOutTimeToHalf} + \text{Agent\_Skill\_Group\_Half\_Hour\_TalkPreviewTimeToHalf} + \text{Agent\_Skill\_Group\_Half\_Hour\_TalkReserveTimeToHalf}}{\text{Agent\_Half\_Hour\_LoggedOnTimeToHalf}}
\]

The percentage of time that the agent has spent talking on calls in this skill group in relation to LoggedOnTime.

**% Hold**

This is a calculated field derived from:
\[
\frac{\text{Agent\_Skill\_Group\_Half\_Hour\_HoldTimeToHalf}}{\text{Agent\_Half\_Hour\_LoggedOnTimeToHalf}}
\]

The percentage of time that the agent has put a call on hold or paused a task in relation to LoggedOnTime or the half hour interval, whichever is less.

**% Not Active**

This is a calculated field derived from: 
\[
\frac{\text{Agent\_Skill\_Group\_Half\_Hour\_AvailTimeToHalf}}{\text{Agent\_Half\_Hour\_LoggedOnTimeToHalf}}
\]

The percentage of time that the agent has spent in the Not Active or Available state in relation to LoggedOnTime. Applies to all skill groups.

**% Not Ready**

This is a calculated field derived from: 
\[
\frac{\text{Agent\_Skill\_Group\_Half\_Hour\_NotReadyTimeToHalf}}{\text{Agent\_Half\_Hour\_LoggedOnTimeToHalf}}
\]

The percentage of time that the agent has spent in the Not Ready state in relation to LoggedOnTime or the half hour interval, whichever is less. Applies to all skill groups.

**% Reserved**

This is a calculated field derived from: 
\[
\frac{\text{Agent\_Skill\_Group\_Half\_Hour\_ReservedStateTimeToHalf}}{\text{Agent\_Half\_Hour\_LoggedOnTimeToHalf}}
\]

The percentage of time that the agent has spent in Reserved state waiting for an Unified ICM routed task from this skill group in relation to LoggedOnTime.

**% Wrap Up**
This is a calculated field derived from: `((Agent_Skill_Group_Half_Hour.WorkReadyTimetoHalf + Agent_Skill_Group_Half_Hour.WorkNotReadyTimetoHalf) / Agent_Half_Hour.LoggedOnTimeToHalf)

The percentage of time that the agent has spent in Wrap-up state after an incoming or outgoing calls to/from this skill group in relation to LoggedOnTime.

**Report Summary:** There is a summary row for Agent Team Name and a report summary for all data. See [About Report Summaries](#) (page 121).

### Hidden Fields in the Agent Team Historical All Fields Report

Hidden fields for this template are listed in the [Simple Wizard](#) (page 114).

The data source for each hidden field is displayed in the Report Wizard Field Map tab. See [Report Field Data Source](#) (page 120).

### Sample Agent Team Historical All Fields Report

This illustration is a sample of the report generated from the Agent Team Historical All Fields template.

**Figure 54: Agent Team Historical Report 1 of 2**

**Figure 55: Agent Team Historical Report 2 of 2**
Agent Team Real Time All Fields

About the Agent Team Real Time All Fields Report (page 202)

Visible Fields in the Agent Team Real Time Report (page 203)

Hidden Fields in the Agent Team Real Time Report (page 205)

About the Agent Team Real Time All Fields Report

This report shows the current status of the selected agent team(s) and the current agent states of each agent within the selected agent team(s).

**Applicable Environment:** Unified CCE and/or Unified ICM

**Grouping:** This report is grouped and sorted by Agent Team Name and then by Supervisor.

**Value List:** Agent Team

**Corresponding WebView templates:** The visible fields in this report match agteam20: Agent Team Real Time WebView Report

This template also corresponds to agteam28: Agent Team Real Time All Fields

**Database Schema Table(s) from which data is retrieved:**

- Agent
- Agent_Real_Time
- Agent_Team
- Agent_Team_Member
- Media_Routing_Domain
- Person
- Skill_Group

**See also:**

Visible Fields in the Agent Team Real Time Report (page 203)

Hidden Fields in the Agent Team Real Time Report (page 205)
Visible Fields in the Agent Team Real Time All Fields Report

Visible fields are fields that appear in a report generated from the stock template. They are listed in the order (left to right) in which they appear by default in the stock template.

**Note:** Fields applicable to a voice domain only are marked with an asterisk (*). Such fields are not applicable for e-mail or collaboration media.

**Agent Team Name**

Derived from: Agent_Team.EnterpriseName

The Enterprise Name of the agent team.

**Supervisor**

Derived from: Person.LastName + ' ' + Person.FirstName

The agent teams' primary supervisor.

Derived from: Person.LastName ", " Person.FirstName

The last and first name of the agent.

**Extension**

Derived from: Agent_Real_Time.Extension

The phone extension that the agent has logged into.

**Logon DateTime**

Derived from: Agent_Real_Time.DateTimeLogin

Date and time of the login of the agent measured in MM/DD/YYYY HH:MM:SS (month, day, year, hour, minute, second) format.

**Active Skill Group**

Derived from: Skill_Group.EnterpriseName

The skill group associated with the task on which the agent is currently working. If the agent is not involved in any task in the media routing domain, this field shows Not Applicable. Since an agent can be logged into multiple skill groups, this field is not filled until the agent is assigned a task.

**Agent State**

Derived from: Agent_Real_Time.AgentState

The current state of the agent. See Agent States (page 168).
Mobile Agent Mode

Derived from: Agent_Real_Time.PhoneType

The mode by which the agent is connected: 0 Derived from: Not Mobile (Local agent; normal ACD/CCE phone or non-voice task) 1 Derived from: Call By Call (Mobile agent's phone is connected for each incoming call) 2 Derived from: Nailed Connection (Mobile agent calls and logs in once; line remains connected through multiple calls)

Mobile Agent Phone #

Derived from: Agent_Real_Time.RemotePhoneNumber

For a mobile agent (an agent working remotely), the current phone number.

Duration in Current State

Derived from: DATEDIFF(second, Agent_Real_Time.DateTimeLastStateChange, getdate())

The length of time since the agent's state last changed, measured in HH:MM:SS (hours, minutes, seconds) format.

Reason Code

Derived from: Agent_Real_Time.ReasonCode

A code received from the peripheral that indicates the reason for the agent's last state change. If not defined, this displays 0.

SupervAssist *

Derived from: Agent_Real_Time.Requested SupervisorAssist

Whether or not the agent requested supervisor assistance: No Yes

Direction

Derived from: Agent_Real_Time.Direction

The direction of active task: In (inbound task - non voice tasks are always inbound) Out (outgoing external task) Other (outgoing or incoming internal task) Not Applicable (if the logged in agent is not active in the skill group)

Destination *

Derived from: Agent_Real_Time.Destination

The type of outbound task on which the agent is currently working.

Avail in MRD

Derived from: Agent_Real_Time.AvailableInMRD
Whether or not the agent is available to accept a task in this media routing domain.

**Report Summary:** There is a summary row for Agent Team Name, a summary row for each Supervisor and a report summary for all data. See About Report Summaries (page 121).

Hidden Fields in the Agent Team Real Time All Fields Report

Hidden fields for this template are listed in the Simple Wizard (page 114).

The data source for each hidden field is displayed in the Report Wizard Field Map tab. See Report Field Data Source (page 120).

Sample Agent Team Real Time All Fields Report

This illustration is a sample of the report generated from the Agent Team Real Time All Fields template.

*Figure 56: Agent Real Time All Fields Report 1 of 2*

<table>
<thead>
<tr>
<th>Agent Name</th>
<th>Extension</th>
<th>Login Date/Time</th>
<th>Active Skill Group</th>
<th>Agent State</th>
<th>Mobile Agent</th>
<th>Network Agent</th>
<th>Phone ID</th>
<th>Duration In Current State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent 1001</td>
<td>1001</td>
<td>6/12/2006 4:47:44 PM</td>
<td>Not Applicable</td>
<td>Work, Not Fuzzy</td>
<td>Not Mobile</td>
<td>Yes</td>
<td>20:30:00</td>
<td></td>
</tr>
</tbody>
</table>

*Figure 57: Agent Real Time All Fields Report 2 of 2*

<table>
<thead>
<tr>
<th>Reason Code</th>
<th>Superv Assit Regstd</th>
<th>Direction</th>
<th>Destination</th>
<th>Avail In MRD</th>
</tr>
</thead>
<tbody>
<tr>
<td>NONE</td>
<td>No</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td>Yes_ICM</td>
</tr>
</tbody>
</table>

Agent Team State Counts Real Time

About the Agent Team State Counts Real Time Report (page 205)

Visible Fields in the Agent Team State Counts Report (page 206)

Hidden Fields in the Agent Team State Counts Report (page 208)

About the Agent Team State Counts Real Time Report

A table summary of the number of agents in various agent states.

Provides real-time agent team information on number of agents assigned to a team, number of agents logged on, number of agents in different states, and number of agents available to receive incoming tasks.

**Applicable Environment:** Unified CCE and/or Unified ICM

**Grouping:** There is no grouping for this report. It is sorted by Agent Team.
**Value List:** Agent Team

**Corresponding WebView template:** Corresponding (similar) to WebView template: agteam32: Agent Team State Counts Real Time.

**Database Schema Table(s) from which data is retrieved:**

- Agent
- Agent_Real_Time
- Agent_Team
- Agent_Team_Member
- Media_Routing_Domain
- Person

**See also:**

Visible Fields in the Agent Team State Counts Report (page 206)

Hidden Fields in the Agent Team State Counts Report (page 208)

**Visible Fields in the Agent Team State Counts Real Time Report**

Visible fields are those fields that appear in a report generated from the stock template.

Visible fields are listed here in the order (left to right) in which they appear by default in the stock template.

**Note:** Fields applicable to a voice domain only are marked with an asterisk (*). Such fields are not applicable for e-mail or collaboration media.

**Agent Team Name**

Derived from: Agent_Team.EnterpriseName

The enterprise name of the agent team.

**Supervisor**

Derived from: Person.LastName + ' ' + Person.FirstName

The team’s primary supervisor.

**Total On Team**

Derived from: Agent_Team_Member
The count of agents configured for the individual team.

**Agents Logged On**

The number of agents currently logged on.

Derived from: count of agents with Agent_Real_Time.AgentState = 0.

**Active In***

Derived from: count of agents where Agent_Real_Time.AgentState is 11 or 4 and Agent_Real_Time.Direction is 1.

The number of agents currently working on incoming tasks.

**Active Out***

Derived from: count of agents where Agent_Real_Time.AgentState is 11 or 4 and Agent_Real_Time.Direction is 3.

The number of agents currently working on outbound tasks.

**Active Other***

Derived from: (Agent_Real_Time.AgentState Derived from: 11 or Agent_Real_Time.AgentState Derived from: 4) and Agent_Real_Time.Direction = 3

The number of agents currently working on internal (neither inbound nor outbound) tasks. Examples of other tasks include agent-to-agent transfers and supervisor tasks.

**Hold**

Derived from: Count of agents where Agent_Real_Time.AgentState is 10 or 12

The number of agents that have all active tasks on hold and/or have paused tasks. The agent is not in the Hold state with one task on hold and talking on another task (for example, a consultative call). The agent must have all active tasks on hold.

**Not Active**

Derived from: Count of agents where Agent_Real_Time.AgentState is 3 or 14

The number of agents in the Not Active state, the state where the agent is ready to accept tasks, but is not currently involved in task work.

**Wrap Up**

Derived from: Count of agents where Agent_Real_Time.AgentState is 5 or 6.

The number of agents in the Work Not Ready state Work Ready state. The Work Not Ready state is a state in which an agent is involved in after task work and is assumed not to be ready to accept incoming tasks when done. The Work Ready state is a state in which an agent is involved in after task work and is assumed to be ready to accept incoming tasks when done.
Not Ready

Derived from: Count of agents where Agent_Real_Time.AgentState is 2.

The number of agents in the Not Ready state, a state in which agents are logged in but are neither involved in any task handling activity nor available to handle a task.

Reserved

Derived from: Count of agents where Agent_Real_Time.AgentState is 8.

The number of agents currently in the Reserved state, a state in which an agent has been selected to receive a task. An agent is in the Reserved state until the task is answered.

Eligible for Task

Derived from: Count of agents where Agent_Real_Time.AvailableInMRD is 0.

The number of agents who are eligible to receive tasks in the specified media routing domain.

Note: It is possible for an agent to be in the Not Active state (available) and yet be not Eligible For Task in a media routing domain.

This can occur under the following circumstances:

• In media routing domains other than Voice: if the agent is currently working on a Voice task.

• In the Voice media routing domain: if the agent is currently working on a multimedia task other than an Email task.

Note also that it is possible for an agent to be currently working on a task (Active In state) and yet be Eligible For Task in a media routing domain. This can occur in the Multi Session Chat (MSC) media routing domain. If the agent is currently working on a MSC task, an agent is eligible to receive a task up to the maximum task limit configured in the system.

Report Summary: There is a summary row for the total report. See About Report Summaries (page 121).

Hidden Fields in the Agent Team State Counts Real Time Report

Hidden fields for this template are listed in the Simple Wizard (page 114).

The data source for each hidden field is displayed in the Report Wizard Field Map tab. See Report Field Data Source (page 120).

Sample Agent Team State Counts Real Time Report

This illustration is a sample of the report generated from the Agent Team State Counts Real Time template.
### Chapter 19: Agent Reports

#### Agent Team State Counts Real Time

**Figure 58: Agent Team State Count Report 1**

<table>
<thead>
<tr>
<th>Media</th>
<th>Agents Logged On</th>
<th>Active In</th>
<th>Active Out</th>
<th>Active Other</th>
<th>Hold</th>
<th>Not Active</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco_Voice</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>9</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>7</td>
</tr>
</tbody>
</table>

**Figure 59: Agent Team State Count Report 2**

<table>
<thead>
<tr>
<th>Wrap Up</th>
<th>Not Ready</th>
<th>Reserved</th>
<th>Eligible For Task</th>
<th>Agent Team Name</th>
<th>Supervisor</th>
<th>Total On Team</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>REMEX_AAP_SYDNEY</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>6</td>
<td>REMEX_EMEA</td>
<td></td>
<td>5</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>7</td>
<td></td>
<td></td>
<td>9</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>7</td>
<td></td>
<td></td>
<td>9</td>
</tr>
</tbody>
</table>
Chapter 20

Call Type Reports

This chapter contains the following topics:

- Call Type Abandon/Answer Distribution Historical, page 211
- Call Type Historical /Call Type Daily All Fields, page 215
- Call Type Real Time All Fields, page 222

Call Type Abandon/Answer Distribution Historical

About the Call Type Abandon/Answer Distribution Historical Report (page 211)

Visible Fields in the Call Type Abandon/Answer Distribution Historical Report (page 212)

Hidden Fields in the Call Type Abandon/Answer Distribution Historical Report (page 214)

About the Call Type Abandon/Answer Distribution Historical Report

For each call type, reports generated from this template show the number of answered and abandoned calls for separate intervals for the report's time period, broken out into half-hour summaries.

Applicable Environment: Unified CCE and Unified ICM.

Grouping: This report is grouped and sorted by Call Type Name.

Value List: Call Type

Corresponding WebView template: caltyp31: Call Type Abandon/Answer by Half Hour

Database Schema Table(s) from which data is retrieved:

- Bucket_Intervals
• Call_Type

• Call_Type_Half_Hour

**Note:** This template differs from the corresponding WebView template (calltyp31) in that it does not organize data by "superheaders." This template uses a grouped grid that does not support superheaders. For more information and an illustration, see Superheaders in Report Templates (page 179). See also Grouped Grids (page 171).

**Notes:** If intervals are defined and if data exists for those intervals, the column headings display the value for the end of the interval. In this example, Interval 1 is 00:00:00 - 00:00:08. Interval 2 is 00:00:08 - 00:00:30:

*Figure 60: Ans Aban Columns with Data*

<table>
<thead>
<tr>
<th>00:00:08-Ans</th>
<th>00:00:08-Aban</th>
<th>00:00:30-Ans</th>
<th>00:00:30-Aban</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>0</td>
<td>4</td>
<td>1</td>
</tr>
<tr>
<td>13</td>
<td>1</td>
<td>4</td>
<td>1</td>
</tr>
</tbody>
</table>

If no data exists, the column headings show [int 1]-Ans, [int1]-Aban, and so forth:

*Figure 61: Ans Aban Columns without Data*

<table>
<thead>
<tr>
<th>[int1]-Ans</th>
<th>[int1]-Aban</th>
<th>[int2]-Ans</th>
<th>[int2]-Aban</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

See Call Type Intervals (page 169)

See also:

Visible Fields in the Call Type Abandon/Answer Distribution Historical Report (page 212)

Hidden Fields in the Call Type Abandon/Answer Distribution Historical Report (page 214)

**Visible Fields in the Call Type Abandon/Answer Distribution Historical Report**

Visible fields are those fields that appear in a report generated from the stock template.

Visible fields are listed here in the order (left to right) in which they appear by default in the stock template.

**Call Type Name**

The enterprise name for the call type.

Derived from Call_Type.EnterpriseName

**Date Time**
The date and time when the call type interval data was generated in MM/DD/YYYY (month, day, year) and HH:MM:SS (hours, minutes, seconds) format.

For every half hour in the selected time period there is summary row for each selected call type.

Derived from: Call_Type_Half_Hour.DateTime

ASA

Average Speed of Answer. The average answer wait time from when first queue to skill group or LAA select node was executed for this call to when this call was answered. This is an important measure of service quality because the time can vary, even over the course of one day, due to call volumes and staff levels.

This is a calculated field, derived from: Call_Type_Half_Hour.AnswerWaitTimeHalf / Call_Type_Half_Hour.CallsAnsweredToHalf

Avg Aban Delay

The average delay time of all abandoned calls that ended in this call type during the current half hour interval. This includes calls that abandoned in queue, calls that abandoned while at the IVR (prompting or self service) and calls that abandoned while ringing at the agent's phone or en route to the agent's phone.

This is a calculated field, derived from: Call_Type_Half_Hour.CallDelayAbandTime / Call_Type_Half_Hour.TotalCallsAbandToHalf.

Int 1 Ans and Aban

The number of calls answered/abandoned between the time set to begin measuring and interval 1. The system default interval 1 is 8 seconds. For example: 00:00 - 00:08

Derived from: Call_Type_Half_Hour.AnsInterval(1) and Call_Type_Half_Hour.AbandInterval(1)

Int 2 Ans and Aban

The number of calls answered/abandoned between interval 1 and interval 2. The system default interval 2 is 30 seconds. For example: 00:08 - 00:38

Derived from: Call_Type_Half_Hour.AnsInterval(2) and Call_Type_Half_Hour.AbandInterval(2)

Int 3 Ans and Aban

The number of calls answered/abandoned between interval 2 and interval 3. The system default interval 3 is 60 seconds (1 minute). For example: 00:38 - 01:38

Derived from: Call_Type_Half_Hour.AnsInterval(3) and Call_Type_Half_Hour.AbandInterval(3)

Int 4 Ans and Aban

The number of calls answered/abandoned between interval 3 and interval 4. The system default interval 4 is 90 seconds (1 and ½ minutes). For example: 01:38 - 03:08
Derived from: Call_Type_Half_Hour.AnsInterval(4) and Call_Type_Half_Hour.AbandInterval(4)

**Int 5 Ans and Aban**

The number of calls answered/abandoned between interval 4 and interval 5. The system default interval 5 is 120 seconds (2 minutes). For example: 03:08 - 05:08

Derived from: Call_Type_Half_Hour.AnsInterval(5) and Call_Type_Half_Hour.AbandInterval(5)

**Int 6 Ans and Aban**

The number of calls answered/abandoned between interval 5 and interval 6. The system default interval 6 is 180 seconds (3 minutes). For example: 05:08 - 08:08

Derived from: Call_Type_Half_Hour.AnsInterval(6) and Call_Type_Half_Hour.AbandInterval(6)

**Int 7 Ans and Aban**

The number of calls answered/abandoned between interval 6 and interval 7. The system default interval 7 is 300 seconds (5 minutes). For example: 08:08 - 13:08

Derived from: Call_Type_Half_Hour.AnsInterval(7) and Call_Type_Half_Hour.AbandInterval(7)

**Int 8 Ans and Aban**

The number of calls answered/abandoned between interval 7 and interval 8. The system default interval 8 is 600 seconds (10 minutes). For example: 13:08 - 23:08

Derived from: Call_Type_Half_Hour.AnsInterval(8) and Call_Type_Half_Hour.AbandInterval(8)

**Int 9 Ans and Aban**

The number of calls answered/abandoned between interval 8 and interval 9. The system default interval 9 is 1200 seconds (20 minutes). For example: 23:08 - 43:08

Derived from: Call_Type_Half_Hour.AnsInterval(9) and Call_Type_Half_Hour.AbandInterval(9)

**Int 10 Ans and Aban**

The number of calls answered/abandoned within the remaining time in the report time period measured in minutes and seconds. For example: > 43:08

Derived from: Call_Type_Half_Hour.AnsInterval(10) and Call_Type_Half_Hour.AbandInterval(10)

**Report Summary:** The summary line shows an average for the ASA and Avg Aban Delay columns and totals for the interval columns. See About Report Summaries (page 121).

Hidden Fields in the Call Type Abandon/Answer Distribution Historical Report

Hidden fields for this template are listed in the Simple Wizard (page 114).
The data source for each hidden field is displayed in the Report Wizard Field Map tab. See Report Field Data Source (page 120).

Sample Call Type Abandon/Answer Distribution Historical Report

This illustration is a sample of the report generated from the Call Type Abandon/Answer Distribution Historical Report template.

**Figure 62: Call Type Abandon/Answer Distribution report 1 of 2**

![Call Type Abandon/Answer Distribution report 1 of 2](image1)

**Figure 63: Call Type Abandon/Answer Distribution report 1 of 2**

![Call Type Abandon/Answer Distribution report 1 of 2](image2)

Call Type Historical /Call Type Daily All Fields

**About the Call Type Historical/Call Type Daily All Fields Report** (page 215)

**Visible Fields in the Call Type Historical All Fields Report** (page 216)

**Hidden Fields in the Call Type Historical All Fields Report** (page 220)

**About the Call Type Historical/Call Type Daily All Fields Report**

Reports generated from this template show the hour-hour status of call types for the selected time period.

**Applicable Environment:** Unified ICM and CCE

**Note:** For Unified ICM, the presence of certain data depends on the use of Enterprise Queuing and on whether Translation Routing has been implemented.

**Grouping:** By call type and then by date and time

**Value List:** Call Type

**Note:** This template differs from the corresponding WebView template (calltyp21) in that it does not organize data by "superheaders." This template uses a grouped grid that does not support superheaders. For more information and an illustration, see Superheaders in Report Templates (page 179). See also Grouped Grids (page 171).
Corresponding WebView templates:

- caltyp21: Call Type Half Hour Report
- caltyp23: Call Type Historical All Fields Report

Database Schema Table(s) from which data is retrieved:

- Call_Type
- Call_Type_Half_Hour

See also:

Visible Fields in the Call Type Historical All Fields Report (page 216)
Hidden Fields in the Call Type Historical All Fields Report (page 220)

Visible Fields the Call Type Historical All Fields Report

Visible fields are those fields that appear in a report generated from the stock template.

Visible fields are listed here in the order (left to right) in which they appear by default in the stock template.

**Call Type Name**

The enterprise name for the call type.

Derived from Call_Type.EnterpriseName

**Date Time**

The date and time when the record was generated in MM/DD/YYYY (month, day, year) and HH:MM:SS (hours, minutes, seconds) format.

Derived from: Call_Type_Half_Hour.DateTime

**SL**

Service Level Type used to calculate Service level for the half-hour interval.

See Service Levels (page 175).

Derived from: Call_Type_Half_Hour.ServiceLevelHalf

**Aban Within SL**
The total number of calls of this call type abandoned within the service level threshold during the half-hour interval. Valid for both Unified CC Enterprise and standard ACD targets that use translation routes.

Derived from: Call_Type_Half_Hour.ServiceLevelAbandHalf

**ASA**

Average Speed of Answer. The average answer wait time from when first queue to skill group or LAA select node was executed for this call to when this call was answered. This is an important measure of service quality because the time can vary, even over the course of one day, due to call volumes and staff levels.

This is a calculated field, derived from: Call_Type_Half_Hour.AnswerWaitTimeHalf / Call_Type_Half_Hour.CallsAnsweredToHalf

**Offered**

Tasks that have been offered to this call type during the interval.

Derived from: Call_Type_Half_Hour.CallsOfferedHalf

For Call Type, the router counts CallsOffered when the call enters the call type via the routing script associated with the call type or a CallType node in the script.

It can be balanced with following formula:

\[
\text{CallsOfferedHalf} = \text{CallsHandledHalf} + \text{ErrorCountToHalf} + \text{ICRDefaultRoutedToHalf} + \text{NetworkDefaultRoutedToHalf} + \text{ReturnBusyToHalf} + \text{ReturnRingToHalf} + \text{NetworkAnnouncementToHalf} + \text{OverflowOutHalf} + \text{IncompleteCallsHalf} + \text{ShortCallsHalf} + \text{CallsRoutedNonAgentToHalf} + \text{CallsRONAToHalf} + \text{ReturnReleaseToHalf} + \text{AgentErrorCountToHalf} + \text{TotalCallsAbandToHalf}
\]

All of the fields on the right side of the formula are counted when the call is ended or the call type is changed.

**Assigned from Q**

The number of tasks of the call type assigned from the queue to be routed in the half hour interval.

Derived from: Call_Type_Half_Hour.RouterQueueCallsToHalf

**Answered**

The total number of calls of this call type answered by agents in the half-hour interval. This field is applicable to both Unified ICM and Unified CC Enterprise with the following exception: if the call is answered by an agent on a standard ACD, this field is incremented only if the call was translation routed.

Derived from: Call_Type_Half_Hour.CallsAnsweredToHalf

**AWT**
Average Wait Time. The average of answer wait time in seconds for all calls that were handled for the call type during the half-hour interval. This field is applicable to both Unified ICM and Unified CC Enterprise with the following exception: if the call is answered by an agent on a standard ACD, this field is incremented only if the call was translation routed.

Derived from Call_Type_Half_Hour.AnswerWaitTimeHalf

Total

The number of tasks of the call type that were completed in the half hour interval.

This is a calculated field, derived from:

\[
\text{Total} = \text{Call\_Type\_Half\_Hour.TotalCallsAbandToHalf} + \text{Call\_Type\_Half\_Hour.RouterCallsAbandQToHalf} + \text{Call\_Type\_Half\_Hour.IncompleteCallsHalf} + \text{Call\_Type\_Half\_Hour.ReturnBusyToHalf} + \text{Call\_Type\_Half\_Hour.ReturnRingToHalf} + \text{Call\_Type\_Half\_Hour.ICRDefaultRoutedToHalf} + \text{Call\_Type\_Half\_Hour.NetworkDefaultRoutedToHalf} + \text{Call\_Type\_Half\_Hour.OverflowOutHalf} + \text{Call\_Type\_Half\_Hour.CallsRONAToHalf} + \text{Call\_Type\_Half\_Hour.ReturnReleaseToHalf} + \text{Call\_Type\_Half\_Hour.CallsRoutedNonAgentToHalf} + \text{Call\_Type\_Half\_Hour.ShortCallsHalf} + \text{Call\_Type\_Half\_Hour.ErrorCountToHalf} + \text{Call\_Type\_Half\_Hour.AgentErrorCountToHalf}
\]

Handled

The total number of tasks handled to completion for the call type in the half hour interval.

Derived from: Call_Type_Half_Hour.CallsHandledHalf

Aban

The total number of calls abandoned while in VRU (that is, while undergoing prompting or listening to voice menus options), calls abandoned while queued to skill group, and calls abandoned at agent desktop. This value also includes abandon for calls that are not in the queue; for example, when the caller hangs up while listening to a VRU prompt. Therefore, the number of calls abandoned at a VRU before being queued is TotalCallsAband minus RouterCallsAbandToAgent and RouterCallsAbandQ. Does not include short calls.

Derived from: Call_Type_Half_Hour.TotalCallsAbandToHalf

Return

The number of tasks of the call type that ICM software routed to Return nodes in the half-hour interval.

This is a calculated field, derived from:

\[
\text{Return} = \text{Call\_Type\_Half\_Hour.ReturnBusyToHalf} + \text{Call\_Type\_Half\_Hour.ReturnRingToHalf} + \text{Call\_Type\_Half\_Hour.ReturnReleaseToHalf}
\]

Default Treatment
The number of tasks of the call type that have been given default treatment or end nodes in the half hour interval.

Derived from: Call_Type_Half_Hour.ICRDefaultRoutedToHalf

**Network Routed**

The number of tasks of the call type that were routed not by ICM software but by the carrier in the half hour interval. For pre-routed calls, the carrier decides where to route the call.

Derived from: Call_Type_Half_Hour.NetworkDefaultRoutedToHalf

**Flow Out**

The number of tasks of the call type that flowed out of the call type to another call type in the half hour interval. See *Overflow Out* (page 172).

Derived from: Call_Type_Half_Hour.OverflowOutHalf

**Calls Error**

The number of calls for this Call Type that had errors or were incomplete in the half hour interval.

This is a calculated field, derived from: Call_Type_Half_Hour.ErrorCountToHalf + Call_Type_Half_Hour.IncompleteCallsHalf + Call_Type_Half_Hour.AgentErrorCountToHalf

**Other**

The number of tasks of the call type that are Short, have been routed to non Agent targets, and/or have been redirected in the half hour interval.

This is a calculated field, derived from:

\[
\text{Call Type Half Hour Calls Routed Non Agent To Half} + \\
\text{Call Type Half Hour Calls Routed Non Agent To Half} + \\
\text{Call Type Half Hour Short Calls Half}
\]

**% Queued**

The percentage of all handled tasks of the call type that were queued in the half hour interval.

This is a calculated field, derived from: (Call_Type_Half_Hour.CallsHandledToHalf / Call_Type_Half_Hour.CallsHandledHalf)

**% Aban**

The percentage of all the tasks that came in to the call type in the half hour interval that were abandoned.

This is a calculated field, derived from:

\[
\frac{\text{Call Type Half Hour Total Calls Abandes To Half}}{\text{Call Type Half Hour Calls Handled Half} + \\
\text{Call Type Half Hour Total Calls Abandes To Half} + \\
\text{Call Type Half Hour Incomplete Calls Half} + \\
\text{Call Type Half Hour Incomplete Calls Half}}
\]
Call Type Historical / Call Type Daily All Fields

Avg Aban Delay

The average delay time of all abandoned calls that ended in this call type during the current half hour interval. This includes calls that abandoned in queue, calls that abandoned while at the IVR (prompting or self service) and calls that abandoned while ringing at the agent's phone or en route to the agent's phone.

This is a calculated field.

Short Calls

The number of calls abandoned during the Call_Type Abandon Call Wait Time. Calls abandoned after this time period are counted as Abandoned, not Short Calls.

Derived from: Call_Type_Half_Hour.ShortCallsHalf

Report Summaries

See About Report Summaries (page 121).

- Call Type Summary

  Field totals, with the exception of the SL (service level) field, for each call type in the report. The SL fields have percentage values

- Report Summary

  Field totals, with the exception of the SL (service level) field, for all call types in the report. The SL fields have percentage values.

Hidden Fields the Call Type Historical All Fields Report

Hidden fields for this template are listed in the Simple Wizard (page 114).

The data source for each hidden field is displayed in the Report Wizard Field Map tab. See Report Field Data Source (page 120).

Sample Call Type Historical All Fields Report

This illustration is a sample of the report generated from the Call Type Historical All Fields Report template.
Call Type Real Time All Fields

About the Call Type Real Time All Fields Report (page 222)

Visible Fields in the Call Type Real Time All Fields Report (page 222)

Hidden Fields in the Call Type Real Time All Fields Report (page 225)

Reports generated from this template show the current status of call types

**Applicable Environment:** Unified ICM and CCE

**Value List:** Call Type

**Corresponding WebView template:** caltyp20: Call Type Real Time All Fields

**Note:** This template differs from the corresponding WebView template (caltyp20) in that it does not organize data by "superheaders." This template uses a grouped grid that does not support superheaders. For more information and an illustration, see Superheaders in Report Templates (page 179). See also Grouped Grids (page 171).

**Database Schema Table(s) from which data is retrieved:**

- Call_Type
- Call_Type_Real_Time

**See also:**

Visible Fields in the Call Type Real Time All Fields Report (page 222)

Hidden Fields in the Call Type Real Time All Fields Report (page 225)

Visible Fields in the Call Type Real Time All Fields Report

Visible fields are those fields that appear in a report generated from the stock template.

Visible fields are listed here in the order (left to right) in which they appear by default in the stock template.

**Call Type Name**

The enterprise name for the call type.

Derived from Call_Type.EnterpriseName
ASA5

Average Speed of Answer during the rolling five minute interval. The total Answer Time for all tasks of the call type divided by the number of tasks of this type answered during the current 5-minute interval.

This is a calculated field, derived from: (Call_Type_Real_Time.AnswerWaitTimeTo5 / Call_Type_Real_Time.CallsAnsweredTo5)

VRU (not Q) Now

The number of tasks in Run VRUNscript or Wait state. This represents the number of tasks at VRU prompting or self service.

This is a calculated field, derived from: Call_Type_Real_Time.CallsAtVRUNow - Call_Type_Real_Time.RouterCallsQNow

Queue Now

The number of tasks currently in the queue.

Derived from: Call_Type_Real_Time.RouterCallsQNow

CCE Agent Now

The number of tasks that have been routed to CCE agents but are not yet ended. This column is incremented when the call is answered and decremented when the call ends, i.e., after wrap up has completed, if applicable.

Derived from: Call_Type_Real_Time.CallsAtAgentNow

Longest Queued

The time spent in queue for the longest currently queued task, measured in HH:MM:SS (hours, minutes, seconds) format.

This is a calculated field, calculated by subtracting the time the task entered the queue from the current time.

SL

The Unified ICM/CCE service level for the rolling five minute interval.

Derived from: Call_Type_Half_Hour.ServiceLevelTo5

Offered 5

The total handle time in HH:MM:SS (hours,minutes,seconds) for all tasks of this call type ending in the half hour interval.

Derived from: Call_Type_Real_Time.CallsOfferedTo5

Handled 5
The number of calls of this call type handled for the call type ending during the rolling five minute interval.

Derived from: Call_Type_Real_Time.CallsHandledTo5

**Aband 5**

The number of tasks abandoned at the IVR during the rolling five minute interval, while offered to the agent and on route to the agent.

Derived from: Call_Type_Real_Time.TotalCallsAbandTo5

**Aband Within SL**

The number of tasks abandoned before the service level timer expired.

Derived from: Call_Type_Real_Time.ServiceLevelAbandTo5

**Default Label**

The number of tasks of this type that ICM software used default routing for during the half-hour interval.

Derived from: Call_Type_Real_Time.ICRDefaultRoutedToHalf

**Network Routed**

The number of tasks of this type for which the IXC used default routing during the current half-hour interval. For pre-routed tasks, the carrier decides where to route the task.

Derived from: Call_Type_Real_Time.NetworkDefaultRoutedToHalf

**Flow Out 5**

The number of tasks that executed a Requalify or Call Type node and flowed to another call type during the rolling five minute interval.

See *OverflowOut (page 172).*

Derived from: Call_Type_Real_Time.OverflowOutTo5

**Calls Error**

The number of errors for tasks of this type in the current half-hour interval.

Derived from: Call_Type_Real_Time.ErrorCountToHalf

**Calls Other**

The number of tasks of this type that ICM software routed to the Return nodes and tasks that were Redirected On No Answer and tasks that were routed to non-agent targets such as a label during the half-hour interval.
This is a calculated field, derived from: (Call_Type_Real_Time.ReturnBusyToHalf + Call_Type_Real_Time.ReturnRingToHalf + Call_Type_Real_Time.ReturnReleaseHalf + Call_Type_Real_Time.CallsRONAHalf + Call_Type_Real_Time.CallsRoutedNonAgentHalf)

**Avg Aban**

The average time of abandoned calls for this call type during the rolling five minute interval, measured in HH:MM:SS (hours,minutes,seconds) format.

This is a calculated field, derived from: Call_Type_Real_Time.CallDelayAbandTimeTo5 / Call_Type_Real_Time.TotalCallsAbandTo5

**Report Summary:** There is a summary for all data in the report. See About Report Summaries (page 121).

Hidden Fields in the Call Type Real Time All Fields Report

Hidden fields for this template are listed in the Simple Wizard (page 114).

The data source for each hidden field is displayed in the Report Wizard Field Map tab. See Report Field Data Source (page 120).

Sample Call Type Real Time All Fields Report

This illustration is a sample of the report generated from the Call Type All Fields Real Time template.

**Figure 67: Call Type Real Time All Fields Report 1 of 2**

<table>
<thead>
<tr>
<th>Call Type Name</th>
<th>ASAS</th>
<th>VBQ(reat Q) Now</th>
<th>Queue New</th>
<th>ECE Agent New</th>
<th>Longest Queued</th>
<th>SL</th>
<th>OfferedS</th>
</tr>
</thead>
<tbody>
<tr>
<td>CallType_01</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CallType_02</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CallType_03</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CallType_Media_01</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CallType_Media_02</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CallType_Pass</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Michael O’Connor</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SM_MIA_02</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>outbound</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 68: Call Type Real Time All Fields Report 2 of 2**

<table>
<thead>
<tr>
<th>Abands</th>
<th>Aban within SL</th>
<th>Default Label</th>
<th>Network Routed</th>
<th>Flow Outs</th>
<th>Calls Error</th>
<th>Calls Other</th>
<th>Avg Aban</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0:00:00</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0:00:00</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0:00:00</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0:00:00</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0:00:00</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0:00:00</td>
</tr>
</tbody>
</table>
Service Reports

This chapter contains the following topics:

- Enterprise Service Historical All Fields, page 227
- Peripheral Service Historical All Fields, page 231
- Peripheral Service Real Time All Fields, page 234

Enterprise Service Historical All Fields

About the Enterprise Service Historical All Fields Report (page 227)

Visible Fields in the Enterprise Service Historical All Fields Report (page 228)

Hidden Fields in the Enterprise Service Historical All Fields Report (page 230)

About the Enterprise Service Historical All Fields Report

This report shows all the available Enterprise Service Historical All Fields report data in the Service_Half_Hour database table so that you can select which data you want for a customized enterprise-service historical report.

Applicable Environment: Unified ICM

Grouping: by Enterprise Name

Value List: Service

Corresponding WebView template: entsvc24: Enterprise Service Historical All Fields

Database Schema Table(s) from which data is retrieved:

- Enterprise_Service
Enterprise Service Historical All Fields

- Enterprise_Service_Member
- Service_Half_Hour

See also:

Visible Fields in the Enterprise Service Historical All Fields Report (page 228)

Hidden Fields in the Enterprise Service Historical All Fields Report (page 230)

Visible Fields in the Enterprise Service Historical All Fields Report

Visible fields are fields that appear in a report generated from the stock template. They are listed in the order (left to right) in which they appear by default in the stock template.

**Enterprise Name** Derived from: Enterprise_Service.EnterpriseName

The enterprise name of the enterprise service.

**DateTime** Derived from: Service_Half_Hour.DateTime

The date and time of the selected row's data in MM/DD/YYYY (month, day, year) and HH:MM:SS (hour, minute, second) format.

**Ans**

Derived from: Service_Half_Hour.CallsAnsweredToHalf

The total number of tasks associated with the service that were answered by agents in the half hour interval.

**ASA**

Derived from: Service_Half_Hour.AvgSpeedAnswerToHalf

The average answer wait time in HH:MM:SS (hours, minutes, seconds) for all tasks answered for the service in the half hour interval.

**Handled**

Derived from: Service_Half_Hour.CallsHandledToHalf

The number of tasks associated with the service that were handled in the half hour interval.

**AHT**

Derived from: Service_Half_Hour.AvgHandleTimeToHalf

The average handle time in HH:MM:SS (hours, minutes, seconds) of tasks associated with the service ending in the half hour interval.
Aban Q *

Derived from: Service_Half_Hour.CallsAbandQToHalf

The number of tasks associated with the service that were abandoned in queue in the half hour interval.

Avg Delay Q Aban

Derived from: Service_Half_Hour.AvgDelayQAbandToHalf

Average delay time in HH:MM:SS (hours, minutes, seconds) of tasks associated with the service that were abandoned in queue in the half hour interval.

Task Q

Derived from: Service_Half_Hour.CallsQToHalf

The number of tasks associated with the service that were queued in the half hour interval.

Avg Delay Q *

Derived from: Service_Half_Hour.AvgDelayQToHalf

The average delay in the queue for the tasks associated with the service in the half hour interval.

SL

Derived from: Service_Half_Hour.ServiceLevelToHalf

The number of tasks associated with the service answered within the ICM/IPCC Enterprise service level threshold in the half hour interval.

SL Type

Derived From: Service_Half_Hour.ServiceLevelType

The default value that indicates how Unified ICM software calculates the service level (that is, how it handles abandoned calls in calculating the service level). You can override this default for individual services.

Trans In *

Derived from: Service_Half_Hour.TransferInCallsToHalf

The number of tasks transferred into the service in the half hour interval. The value is updated in the database when the call is completed.

Trans Out *

Derived from: Service_Half_Hour.TransferOutCallsToHalf
The number of tasks transferred out of the service in the half hour interval. The value is updated in the database when the transfer of the call is completed.

**Out***

Derived from: Service_Half_Hour.CallsOutToHalf

The number of outbound tasks placed by agents associated with the service in the half hour interval.

**RONA**

Derived from: Skill_Group_Half_Hour.ServiceLevelCallsDequeuedToHalf

The count of calls that are redirected with no answer within the skill group service level threshold in the last half hour interval.

**Report Summary:** The report has a summary row for each Enterprise Name in the table and a total summary for all Enterprise Names. See About Report Summaries (page 121).

Hidden Fields in the Enterprise Service Historical All Fields Report

Hidden fields for this template are listed in the Simple Wizard (page 114).

The data source for each hidden field is displayed in the Report Wizard Field Map tab. See Report Field Data Source (page 120).

Sample Enterprise Service Historical All Fields Report

This illustration is a sample of the report generated from the Enterprise Service Historical All Fields template.

*Figure 69: Enterprise Service Historical report sample layout*
Peripheral Service Historical All Fields

About the Peripheral Service Historical All Fields Report (page 231)

Visible Fields in the Peripheral Service Historical All Fields Report (page 231)

Hidden Fields in the Peripheral Service Historical All Fields Report (page 234)

About the Peripheral Service Historical All Fields Report

This report shows peripheral service historical report data.

Applicable Environment: Unified ICM and CCE

Grouping: by Service Name

Value List: Service

Corresponding WebView template: persvc26: Peripheral Service Historical All Fields

Database Schema Table(s) from which data is retrieved:

- Service
- Service_Half_Hour

See also:

Visible Fields in the Peripheral Service Historical All Fields Report (page 231)

Hidden Fields in the Peripheral Service Historical All Fields Report (page 234)

Visible Fields in the Peripheral Service Historical All Fields Report

Visible fields are fields that appear in a report generated from the stock template. They are listed in the order (left to right) in which they appear by default in the stock template.

Visible fields are listed in the order (left to right) in which they appear by default in the stock template.

Note: Fields applicable to a voice domain only are marked with an asterisk (*). Such fields are not applicable for e-mail or collaboration media.

Service Name

Derived from: Service.EnterpriseName
The enterprise name of the peripheral service

**DateTime**

Derived from: Service_Half_Hour.DateTime

The date and time of the selected row's data in MM/DD/YYYY (month, day, year) and HH:MM:SS (hour, minute, second) format.

**Ans**

Derived from: Service_Half_Hour.CallsAnsweredToHalf

The total number of tasks associated with the service that were answered by agents in the half hour interval.

**ASA**

Derived from: Service_Half_Hour.AvgSpeedAnswerToHalf

The average answer wait time in HH:MM:SS (hours, minutes, seconds) for all tasks answered for the service in the half hour interval.

**Handled**

Derived from: Service_Half_Hour.CallsHandledToHalf

The number of tasks associated with the service that were handled in the half hour interval.

**AHT**

Derived from: Service_Half_Hour.AvgHandleTimeToHalf

The average handle time in HH:MM:SS (hours, minutes, seconds) of tasks associated with the service ending in the half hour interval.

**Aban Queue** *

Derived from: Service_Half_Hour.CallsAbandQToHalf

The number of tasks associated with the service that were abandoned in queue in the half hour interval.

**Avg Delay Q Aban** *

Derived from: Service_Half_Hour.AvgDelayQAbandToHalf

Average delay time in HH:MM:SS (hours, minutes, seconds) of tasks associated with the service that were abandoned in queue in the half hour interval.

**Task Q** *

Derived from: Service_Half_Hour.CallsQToHalf
The total number of tasks associated with the service that were queued in the half hour interval.

**Avg Delay Q** *

Derived from: Service_Half_Hour.AvgDelayQToHalf

The average delay in queue for tasks associated with the service in the half hour interval.

**SL**

Derived from: Service_Half_Hour.ServiceLevelToHalf

The Enterprise service level for the service in the half hour interval.

**SL Type**

Derived From: Service_Half_Hour.ServiceLevelType

The default value that indicates how ICM software calculates the service level (that is, how it handles abandoned calls in calculating the service level). You can override this default for individual services.

**Trans In** *

Derived from: Service_Half_Hour.TransferInCallsToHalf

The number of tasks transferred into the service in the half hour interval. The value is updated in the database when the call is completed.

**Trans Out** *

Derived from: Service_Half_Hour.TransferOutCallsToHalf

The number of tasks transferred out of the service in the half hour interval. The value is updated in the database when the transfer of the call is completed.

**Out** *

Derived from: Service_Half_Hour.CallsOutToHalf

The number of outbound tasks placed by agents associated with the service in the half hour interval.

**RONA**

Derived from: Skill_Group_Half_Hour.ServiceLevelCallsDequeuedToHalf

The count of calls that are redirected with no answer within the skill group service level threshold in the last half hour interval.

**Report Summary:** The report has a summary row for each Service Name and a total summary for all Services. See About Report Summaries (page 121).
Hidden Fields in the Peripheral Service Historical All Fields Report

Hidden fields for this template are listed in the Simple Wizard (page 114).

The data source for each hidden field is displayed in the Report Wizard Field Map tab. See Report Field Data Source (page 120).

Sample Peripheral Service Historical All Fields Report

This illustration is a sample of the report generated from the Peripheral Service Historical All Fields template.

Figure 70: Peripheral Service Historical 1 of 2

Peripheral Service Real Time All Fields

About the Peripheral Service Real Time All Fields Report (page 234)

Visible Fields in the Peripheral Service Real Time All Fields Report (page 235)

Hidden Fields in the Peripheral Service Real Time All Fields Report (page 237)

About the Peripheral Service Real Time All Fields Report

This report shows available peripheral-service real-time data.

Applicable Environment: Unified ICM and CCE

Value List: Service
Corresponding WebView template: persvc27 (Peripheral Service Real Time)

Database Schema Table(s) from which data is retrieved:

- Service
- Service_Real_Time

Note: This template differs from the corresponding WebView template in that it does not organize data by "superheaders." This template uses a grouped grid that does not support superheaders. For more information and an illustration, see About Superheaders in Report Templates (page 179). See also Grouped Grids (page 171).

See also:

Visible Fields in the Peripheral Service Real Time All Fields Report (page 235)

Hidden Fields in the Peripheral Service Real Time All Fields Report (page 237)

Visible Fields in the Peripheral Service Real Time All Fields Report

Visible fields are fields that appear in a report generated from the stock template. They are listed in the order (left to right) in which they appear by default.

Service Name

Derived from: Service.EnterpriseName

The enterprise name of the peripheral service

In Progress

Derived from: Service_Real_Time.CallsInProgress

Number of inbound and outbound calls currently that had previously been offered (for example, calls being played an announcement, queued calls, or connected calls) and are currently being handled for the service.

Q Now

Derived from: Service_Real_Time.CallsQNow

The tasks in queue associated with the service now at the peripheral.

Aban5

Derived from: Service_Real_Time.CallsAbandQTo5

The number of tasks associated with the service that abandoned while in queue or ringing during the rolling five minute interval. An abandoned task is one in which the caller hung up before being connected with an agent. If the caller hangs up almost immediately, you might not want
to count that as an abandoned task. When configuring each peripheral, you can specify the minimum length of an abandoned task.

**Avg Delay Q**

Derived from: Service_Real_Time.AvgDelayQAbandTo5

The average delay time of tasks associated with the service that were abandoned in the service queue during the rolling five minute interval. This value is calculated as follows: DelayQAbandTimeTo5 / CallsAbandQTo5.

**ASA5**

Derived from: Service_Real_Time.AvgSpeedAnswerTo5

The average answer wait time for tasks associated with the service during the rolling five minute interval: AnswerWaitTimeTo5 / CallsOfferedTo5. Answer wait time is the elapsed time from when the task is offered at the peripheral to when it is answered. This includes all DelayTime, LocalQTime, and RingTime associated with the task.

**AHT5**

Derived from: Service_Real_Time.AvgHandleTimeTo5

The average handle time in HH:MM:SS (hours, minutes, seconds) for tasks associated with the service during the rolling five minute interval. The value is calculated as follows: HandleTimeTo5 / CallsHandledTo5.

**LAA**

Derived from: Service_Real_Time.LongestAvailAgent

The time that the longest available agent associated with the service became available.

**Longest Task Q**

Derived from: Service_Real_Time.LongestCallQ

Time that the longest call in the queue for the service was put there.

**Flow In 5**

Derived from: Service_Real_Time.OverflowInTo5

Number of calls the peripheral overflowed into this service during the rolling five-minute interval.

**Flow Out 5**

Derived from: Service_Real_Time.OverflowOutTo5

Number of calls overflowed out of this service during the rolling five-minute interval.
SL5

Derived from: Service_Real_Time.ServiceLevelTo5

The Enterprise service level for the service during the rolling five minute interval.

SL5 Aban

Derived from: Service_Real_Time.ServiceLevelAbandTo5

Number of calls to the service abandoned within the service level threshold during the rolling five-minute interval.

SL5 Tasks

Derived from: Service_Real_Time.ServiceLevelCallsTo5

Number of calls to the service answered within the ICM service level during the rolling five-minute interval.

Report Summary: The report has total summary row. See About Report Summaries (page 121).

Hidden Fields in the Peripheral Service Real Time All Fields Report

Hidden fields for this template are listed in the Simple Wizard (page 114).

The data source for each hidden field is displayed in the Report Wizard Field Map tab. See Report Field Data Source (page 120).

Sample Peripheral Service Real Time All Fields Report

This illustration is a sample of the report generated from the Peripheral Service Real Time All Fields template.

Figure 71: Peripheral Service Real Time

Figure 72: Peripheral Service Real Time 2

<table>
<thead>
<tr>
<th>Longest Task Q</th>
<th>In Progress</th>
<th>SL5 Aban</th>
<th>SL5 Tasks</th>
<th>SL5</th>
<th>Flow In 5</th>
<th>Flow Out 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>00:00:00</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.00 %</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>00:00:00</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.00 %</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>00:00:00</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.00 %</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>00:00:00</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.00 %</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>00:00:00</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.00 %</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>00:00:00</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.00 %</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>00:00:00</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.00 %</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>00:00:00</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.00 %</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>00:00:00</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.00 %</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
Skill Group Reports

This chapter contains the following topics:

- Agent Skill Group Historical All Fields, page 239
- Agent Skill Group Real Time All Fields, page 244
- Enterprise Skill Group Historical All Fields, page 249
- Enterprise Skill Group Real Time All Fields, page 254
- Peripheral Skill Group Historical All Fields, page 259
- Peripheral Skill Group Real Time All Fields, page 264

Agent Skill Group Historical All Fields

About the Agent Skill Group Historical All Fields Report (page 239)

Visible Fields in the Agent Skill Group Historical All Fields Report (page 240)

Hidden Fields in the Agent Skill Group Historical All Fields Report (page 244)

About the Agent Skill Group Historical All Fields Report

Reports generated from this template pull data from the Agent_Skill_Group_Half_Hour database table to show activity for selected agents for a selected interval, sorted by skill group.

Note: This report is the same report as the Agent Historical All Fields (page 183) report except that this report is first sorted by skill group rather than by agent.

Applicable Environment: Unified CCE and Unified ICM.

Grouping: This report is grouped and sorted by Skill Group Name and then by Agent Name.

Value List: Skill Group
Corresponding WebView templates: agent25: Agent Skill Group Consolidated Half Hour Report

This template also contains fields from agtskg27: Agent Skill Group Historical All Fields and calculated fields from agtskg23: Agent Skill Group Performance Summary Half Hour.

Note: This template differs from the corresponding WebView template in that it does not organize data by "superheaders." This template uses a grouped grid that does not support superheaders. For more information and an illustration, see Superheaders in Report Templates (page 179). See also Grouped Grids (page 171).

Database Schema Table(s) from which data is retrieved:

- Agent
- Agent_Skill_Group_Half_Hour
- Skill_Group

See also:

Visible Fields in the Agent Skill Group Historical All Fields Report (page 240)
Hidden Fields in the Agent Skill Group Historical All Fields Report (page 244)

Visible Fields in the Agent Skill Group Historical All Fields Report

Visible fields are those fields that appear in a report generated from the stock template.

Visible fields are listed below in the order (left to right) in which they appear by default in the stock template.

Note: Fields applicable to a voice domain only are marked with an asterisk (*). Such fields are not applicable for e-mail or collaboration media.

Skill Group Name

Derived from: Skill_Group.EnterpriseName

The agent skill group's enterprise name

Agent Name

This is a calculated field, derived from: Person.LastName + ", " + Person.FirstName

The first and last name of the agent.

Date Time

Derived from: Agent_Skill_Group_Half_Hour.DateTime
The date and time of the selected row's data in MM/DD/YYYY (month, day, year) and HH:MM:SS (hour, minute, second) format.

**Handled**

Derived from: `Agent_Skill_Group_Half_Hour.CallsHandledToHalf`

The number of inbound calls that have been answered and have completed wrap-up by agents in the skill group during the half-hour interval.

**AHT**

This is a calculated field, derived from:

\[
\text{Agent_Skill_Group_Half_Hour.HandledCallsTimeToHalf} / \text{Agent_Skill_Group_Half_Hour.CallsHandledToHalf}
\]

The average time spent by the agent in handling a task in the half hour interval, measured in HH:MM:SS (hours, minutes, seconds).

**Held**

Derived from: `Agent_Skill_Group_Half_Hour.IncomingCallsOnHoldToHalf`

The number of incoming calls to this agent that were placed on hold in the half hour interval.

**Avg Hold**

This is a calculated field, derived from:

\[
\text{Agent_Skill_Group_Half_Hour.IncomingCallsOnHoldTimeToHalf} / \text{Agent_Skill_Group_Half_Hour.IncomingCallsOnHoldToHalf}
\]

The average time in HH:MM:SS (hours, minutes, seconds) that calls were put on hold in the half hour interval, for all incoming calls which included hold time.

**Aban Ring**

Derived from: `Agent_Skill_Group_Half_Hour.AbandonRingCallsToHalf`

For voice: the total number of calls that were abandoned while the agent's phone was ringing.

For non-voice: the total number of tasks that were abandoned while being offered to an agent.

**RONA**

Derived from: `Agent_Skill_Group_Half_Hour.RedirectNoAnsCallsToHalf`

The number of tasks that left the agent's phone or terminal that were redirected to another dialed number because of no answer in the half hour interval.

**Aban Hold**

Derived from: `Agent_Skill_Group_Half_Hour.AbandonHoldCallsToHalf`
The number of Unified ICM routed calls to the agent that abandoned while the call was on hold and/or the number of paused tasks that the agent ended in the half hour interval.

**Trans In** *

Derived from: Agent_Skill_Group_Half_Hour.TransferredInCallsToHalf

The number of incoming calls that were transferred to this agent from other agents within the same peripheral that did not go to IVR for queuing in the half hour interval. This value is updated when the agent completes the call.

**Note:** For blind transfers in Unified CCE with a Unified CCE System PG, this field is updated when the call that was blind transferred to an IVR is subsequently transferred to another agent and the agent answers the call. For this call scenario this field is not updated in Unified CCE without an Unified CCE System PG

**Trans Out** *

This is a calculated field, derived from:

Agent_Skill_Group_Half_Hour.TransferredOutCallsToHalf +
Agent_Skill_Group_Half_Hour.NetTransferredOutCallsToHalf

The number of calls this agent transferred to another agent or skill group in the half hour interval. This includes Consultative Calls if this transfer was consultative-not blind. The value is updated at the time the agent completes the transfer of the call.

**Ext Out** *

Derived from: Agent_Skill_Group_Half_Hour.AgentOutCallsToHalf

The number of outgoing external calls that this agent made in the half hour interval.

**Log On Time**

Derived from: Agent_Skill_Group.LoggedOnTime

The total time during the interval the agent was logged in, measured in HH:MM:SS (hours, minutes, seconds) format.

**% Active**

This is a calculated field, derived from: (Agent_Skill_Group_Half_Hour.TalkInTimeToHalf +
Agent_Skill_Group_Half_Hour.TalkOutTimeToHalf +
Agent_Skill_Group_Half_Hour.TalkOtherTimeToHalf +
Agent_Skill_Group_Half_Hour.TalkAutoOutTimeToHalf +
Agent_Skill_Group_Half_Hour.TalkPreviewTimeToHalf +
Agent_Skill_Group_Half_Hour.TalkReserveTimeToHalf) /
Agent_Skill_Group_Half_Hour.LoggedOnTimeToHalf

The percentage of time that the agent has spent talking on calls in this skill group in relation to the agent's LoggedOnTime.

**% Hold**
This is a calculated field, derived from: \( \text{Agent\_Skill\_Group\_Half\_Hour.HoldTimeToHalf} / \text{Agent\_Half\_Hour.LoggedOnTimeTimeToHalf} \)

The percentage of time that the agent has put a call on hold or paused a task in relation to LoggedOnTime or the half hour interval, whichever is less.

**% Not Active**

This is a calculated field derived from:
\( (\text{Agent\_Skill\_Group\_Half\_Hour.AvailTimeToHalf}/\text{Agent\_Half\_Hour.LoggedOnTimeToHalf}) \)

The percentage of time that the agent has spent in the Not Active or Available state in relation to LoggedOnTime. Applies to all skill groups.

**% Not Ready**

This is a calculated field, derived from: \( (\text{Agent\_Skill\_Group\_Half\_Hour.NotReadyTimeToHalf} / \text{Agent\_Skill\_Group\_Half\_Hour.LoggedOnTimeToHalf}) \)

The percentage of time that the agent has spent in the Not Ready state in relation to LoggedOnTime or the half hour interval, whichever is less. Applies to all skill groups.

**% Reserved**

This is a calculated field, derived from:
\( (\text{Agent\_Skill\_Group\_Half\_Hour.ReservedStateTimeToHalf}/\text{Agent\_Skill\_Group\_Half\_Hour.LoggedOnTimeToHalf}) \)

The percentage of time that the agent has spent in Reserved state waiting for an ICM routed task from this skill group in relation to LoggedOnTime.

**% Wrap Up**

This is a calculated field, derived from:
\( ((\text{Agent\_Skill\_Group\_Half\_Hour.WorkReadyTimetoHalf} + \text{Agent\_Skill\_Group\_Half\_Hour.WorkNotReadyTimetoHalf}) / \text{Agent\_Skill\_Group\_Half\_Hour.LoggedOnTimeToHalf}) \)

The percentage of time that the agent has spent in Wrap-up state after an incoming or outgoing calls to/from this skill group in relation to LoggedOnTime.

**% Busy Other**

This is a calculated field, derived from: \( (\text{Agent\_Skill\_Group\_Half\_Hour.BusyOtherTimetoHalf} / \text{Agent\_Skill\_Group\_Half\_Hour.LoggedOnTimeToHalf}) \)

The percentage of time that the agent has spent in the BusyOther state in relation to LoggedOnTime.

Note: The agent state time percentages in the Report Summary row will only add up to 100% when ALL of the skill groups for an agent have been selected. When viewing a subset of an agent's skill groups, the percentages may not balance.
**Report Summary:** There is a summary row for Skill Group Name and for Agent Name. There is a total report summary for all fields except % Busy Other. See About Report Summaries (page 121).

**Hidden Fields in the Agent Skill Group Historical All Fields Report**

Hidden fields for this template are listed in the Simple Wizard (page 114).

The data source for each hidden field is displayed in the Report Wizard Field Map tab. See Report Field Data Source (page 120).

**Sample Agent Skill Group Historical All Fields Report**

This illustration is a sample of the report generated from the Agent Skill Group Historical All Fields template.

**Agent Skill Group Real Time All Fields**

About the Agent Skill Group Real Time All Fields Report (page 245)

Visible Fields in the Agent Skill Group Real Time All Fields Report (page 245)

Hidden Fields in the Agent Skill Group Real Time All Fields Report (page 248)
About the Agent Skill Group Real Time All Fields Report

This report is a table showing current agent status within the specified skill group(s).

**Applicable Environment:** Unified CCE and Unified ICM.

**Corresponding WebView templates:** agtskg20 and agtskg30: Agent Skill Group Real Time WebView Report

**Grouping:** by Skill Group Name

**Value List:** Skill Group

**Database Schema Table(s) from which data is retrieved:**

- Agent
- Agent_Real_Time
- Agent_Skill_Group_Real_Time
- Controller_Time
- Media_Routing_Domain
- Person
- Skill_Group

**See also:**

Visible Fields in the Agent Skill Group Real Time All Fields Report (page 245)

Hidden Fields in the Agent Skill Group Real Time All Fields Report (page 248)

Visible Fields in the Agent Skill Group Real Time All Fields Report

Visible fields are those fields that appear in a report generated from the stock template.

Visible fields are listed in the order (left to right) in which they appear by default in the stock template.

**Note:** Fields applicable to a voice domain only are marked with an asterisk (*). Such fields are not applicable for e-mail or collaboration media.

**Skill Group Name**

The skill group associated with the task on which the agent is currently working. If the agent is not involved in any task in the media routing domain, this field shows Not Applicable. Since
an agent can be logged into multiple skill groups, this field is not filled until the agent is assigned a task.

Derived from: Skill_Group.EnterpriseName + Skill_Group.SkillTargetID

**Agent Name**

Derived from: Person.LastName + ", " + Person.FirstName

The last and first name of the agent.

**Ent Queued Now**

The number of tasks currently queued for the skill group.

**Note:** This field is visible by default and is applicable to CCE only. The equivalent field for Unified ICM is named *Queued Now (ICM)* is hidden by default.

Derived from: Skill_Group_Real_Time.RouterCallsQNow

**Extension**

Derived from: Agent_Real_Time.Extension

The phone extension into which the agent is logged.

**Agent State**

Derived from: Agent_Real_Time.AgentState

The current state of the agent. See [Agent States (page 168)](#).

**LogOn Date Time**

Derived from: Agent_Real_Time.DateTimeLogin

The date and time that the agent logged in. The format is MM/DD/YYYY (month, day, year) and HH:MM:SS (hour, minute, second) format.

**Duration in Current State**

This is a calculated field derived from: DATEDIFF(seconds, Agent_Real_Time.DateTimeLastStateChange, getdate())

The time spent in the current agent state in HH:MM:SS (hours, minutes, seconds) format.

**Mobile Agent Mode**

Derived from: Agent_Real_Time.PhoneType

The mode by which the agent is connected (populated for CCE only):

0 = Not Mobile (Local agent; normal ACD/CCE phone or non-voice task)
1 = Call By Call (Mobile agent's phone is connected for each incoming call)

2 = Nailed Connection (Mobile agent calls and logs in once; line remains connected through multiple calls)

**Mobile Agent Phone Number**

Derived from: Agent_Real_Time.RemotePhoneNumber

For a mobile agent (an agent working remotely), the current phone number. Populated for CCE only.

**Reason Code**

Derived from: Agent_Real_Time.ReasonCode

A code received from the peripheral that indicates the reason for the agent's last state change. If the code is not defined, this displays 0.

**Note:** For reason codes to be displayed in a report, the agent's CTI OS desk settings and CTI OS registry settings need to be configured to display the reason code. Set this in the Unified ICM Configuration Manager Agent Desk Settings List tool.

**Sup Assist Reqstd **

Derived from: Agent_Real_Time.RequestedSupervisorAssist

Whether or not the agent requested supervisor assistance: No|Yes.

**Destination **

Derived from: Agent_Real_Time.Destination

The type of outbound task on which the agent is currently working.

**Direction**

Derived from: Agent_Real_Time.Direction

The direction of active task:

- In (inbound task - non voice tasks are always inbound)
- Out (outgoing external task)
- Out (outgoing external task)
- Other (outgoing or incoming internal task)
- Not Applicable (if the logged in agent is not active in the skill group)

**Avail in MRD**
Whether or not the agent is available to accept a task in this media routing domain:

- NO (Not available)
- YES_ICM (Unified ICM available in media routing domain)
- YES_APP (Application available in media routing domain)

An agent is available for a task in a media routing domain (MRD) if the agent's state in that MRD is anything other than Not Ready, and the agent is not at the agent's maximum task limit for the MRD, and the agent is not working on a non-interruptible task in another MRD. If an agent is ICM-available, then ICM can assign tasks to the agent. If an agent is Application-available, then the application can assign tasks to the agent. In the former case, only ICM can assign tasks to the agent. In the latter, only the application can assign tasks to the agent.

Active Tasks

The number of tasks associated with the skill group that the agent is working on.

Report Summary: There is a summary for each Skill Group Name and a total report summary. See About Report Summaries (page 121).

Hidden Fields in the Agent Skill Group Real Time All Fields Report

Hidden fields for this template are listed in the Simple Wizard (page 114).

The data source for each hidden field is displayed in the Report Wizard Field Map tab. See Report Field Data Source (page 120).

Sample Agent Skill Group Real Time All Fields Report

This illustration is a sample of the report generated from the Agent Skill Group Real Time All Fields template.

<table>
<thead>
<tr>
<th>Skill Group Name</th>
<th>Agent Name</th>
<th>Ext Qued Now</th>
<th>Extension</th>
<th>Agent State</th>
<th>Log On Date/Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>CCM_PM1_Cisco_Voice_Sales</td>
<td>Agent_A191</td>
<td>630801</td>
<td>Work Not Ready</td>
<td>3/13/2006 4:47:44 PM</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Duration in Current State</th>
<th>Mobile Agent Mode</th>
<th>Mobile Agent Phone #</th>
<th>Reason Code</th>
<th>Supv Assist Reqtd</th>
<th>Destination</th>
</tr>
</thead>
<tbody>
<tr>
<td>14:10:20</td>
<td>Not Mobile</td>
<td>NONE</td>
<td>No</td>
<td>No</td>
<td>Not Applicable</td>
</tr>
</tbody>
</table>
Enterprise Skill Group Historical All Fields

About the Enterprise Skill Group Historical All Fields Report

**Applicable Environment:** Unified CCE and Unified ICM.

**Grouping:** by Enterprise Skill Group Name

**Value List:** Enterprise Skill Group

**Corresponding WebView templates:** entskg35: CCE (CCE) Enterprise Skill Group Consolidated Half Hour

This template also contains fields from entskg25: ICM Enterprise Skill Group Consolidated Half Hour, from entskg27: Enterprise Skill Group Historical All Fields, and calculated fields from entskg08: FTE for Enterprise Skill Groups Half Hour

**Note:** This template differs from the corresponding WebView template in that it does not organize data by "superheaders." This template uses a grouped grid that does not support superheaders. For more information and an illustration, see *Superheaders in Report Templates* (page 179). See also *Grouped Grids* (page 171).

**Database Schema Table(s) from which data is retrieved:**

- Enterprise_Skill_Group
- Enterprise_Skill_Group_Member
- Skill_Group
- Skill_Group_Half_Hour

**See also:**

Visible Fields in the Enterprise Skill Group Historical All Fields Report (page 250)
Visible Fields in the Enterprise Skill Group Historical All Fields Report

Visible fields are those fields that appear in a report generated from the stock template. Visible fields are listed below in the order (left to right) in which they appear by default in the stock template.

**Note:** Fields applicable to a voice domain only are marked with an asterisk (*). Such fields are not applicable for e-mail or collaboration media.

**Enterprise Skill Group Name**

The enterprise skill group's enterprise name and ID.


**DateTime**

The date and time of the selected row's data in MM/DD/YYYY (month, day, year) and HH:MM:SS (hour, minute, second) format.

Derived from: `Skill_Group_Half_Hour.DateTime`

**Ent Queued**

The number of tasks queued to this Skill Group in the half hour interval. Derived from: `Skill_Group_Half_Hour.RouterCallsQueuedToHalf`

*Note:* This field is visible by default and is applicable to CCE only. The equivalent field for Unified ICM is named **Total Queued (ICM)** is hidden by default.

**ASA**

The skill group's average speed of answer in HH:MM:SS (hour, minutes, seconds) calculated from the time spent by callers when placed in queue and ringing at the agent's desktop before the task is answered divided by the number of tasks answered.

Derived from: `Skill_Group_Half_Hour.AnswerWaitTimeToHalf / Skill_Group_Half_Hour.CallsAnsweredToHalf`

**Total**

The total number of tasks completed by this skill group in the half hour interval.

Aban

For voice: the total number of calls that were abandoned while the agent's phone was ringing. For non-voice: the total number of tasks that were abandoned while being offered to an agent.

Derived from: (Skill_Group_Half_Hour.RouterCallsAbandQToHalf + Skill_Group_Half_Hour.AbandonCallsRingToHalf)

RONA

The total duration in HH:MM:SS (hours, minutes, and seconds) during the period that agents were logged into this skill group.

Handled

The number of Routed tasks handled within this skill group in the half hour interval.

Derived from: Skill_Group_Half_Hour.CallsHandledToHalf

AHT

The Average Handle Time in HH:MM:SS (hours, minutes, seconds) for tasks sent to the skill group.

Derived from: Skill_Group_Half_Hour.HandledCallsTimeToHalf / Skill_Group_Half_Hour.CallsHandledToHalf

AAT

The Average Active Time in HH:MM:SS (hours, minutes, seconds) for tasks sent to the skill group.

Derived from: Skill_Group_Half_Hour.HandledCallsTalkTimeToHalf / Skill_Group_Half_Hour.CallsHandledToHalf

Aban Hold

The number of tasks offered to the skill group that abandoned while being held or paused by the agent. The value is incremented at the time the call disconnects.

Derived from: Skill_Group_Half_Hour.AbandonHoldCallsToHalf

Trans In *

The time in HH:MM:SS (hours, minutes, seconds) that handling calls transferred into the skill group in the half hour interval.

Derived from: Skill_Group_Half_Hour.TransferInCallsTimeToHalf

Trans Out *

Derived from: Service_Half_Hour.TransferOutCallsToHalf

The number of tasks transferred out of the service in the half hour interval. The value is updated in the database when the transfer of the call is completed.
Active Time

The total time spent in the Active state within this skill group in the half hour interval, measured in HH:MM:SS (hours, minutes, seconds) format.

Derived from: Skill_Group_Half_Hour.TalkTimeToHalf

Hold Time

The total time agents spent in the Hold/Paused state in this skill group in the half hour interval, measured in HH:MM:SS (hours, minutes, seconds) format.

Derived from: Skill_Group_Half_Hour.HoldTimeToHalf

Log On Duration

The total time in the half hour interval the agents were logged into this skill group, measured in HH:MM:SS (hours, minutes, seconds) format.

Derived from: Skill_Group_Half_Hour.LoggedOnTimeToHalf

% Not Active

The percentage of time that agents have spent in the Not Active or Available state in relation to LoggedOnTime or the half hour interval, whichever is less.

Derived from: (Skill_Group_Half_Hour.AvailTimeToHalf / Skill_Group_Half_Hour.LoggedOnTimeToHalf)

% Not Ready

The percentage of time that agents spent in the Not Ready state in relation to LoggedOnTime or the half hour interval, whichever is less.

Derived from: (Skill_Group_Half_Hour.NotReadyTimeToHalf / Skill_Group_Half_Hour.LoggedOnTimeToHalf)

% Active

The percentage of time the half hour interval that the agent of this skill group has spent in Active state in this Skill Group in relation to LoggedOnTime.

Derived from: Skill_Group_Half_Hour.TalkTimeToHalf / Skill_Group_Half_Hour.LoggedOnTimeToHalf

% Hold

The percentage of time the half hour interval that agents have put a call from this skill group on hold in relation to LoggedOnTime.

Derived from: (Skill_Group_Half_Hour.HoldTimeToHalf / Skill_Group_Half_Hour.LoggedOnTimeToHalf)
% Reserved

The percentage of time the half hour interval that agents have spent in Reserved state waiting for an ICM routed call from this skill group in relation to LoggedOnTime.

Derived from: (Skill_Group_Half_Hour.ReservedStateTimeToHalf / Skill_Group_Half_Hour.LoggedOnTimeToHalf)

% Wrap Up

The percentage of time the half hour interval that agents have spent in Wrap-up state after incoming or outgoing tasks in relation to LoggedOnTime or interval, whichever is less.

Derived from: (Skill_Group_Half_Hour.WorkReadyTimeToHalf + Skill_Group_Half_Hour.WorkNotReadyTimeToHalf) / Skill_Group_Half_Hour.LoggedOnTimeToHalf)

% Busy Other

The percentage of time the half hour interval that the agents of this skill group spent in busy other state.

Derived from: (Skill_Group_Half_Hour.BusyOtherTimeToHalf / Skill_Group_Half_Hour.LoggedOnTimeToHalf)

Report Summary: There is a summary for each Enterprise Skill Group Name and a total report summary. See About Report Summaries (page 121).

Hidden Fields in the Enterprise Skill Group Historical All Fields Report

Hidden fields for this template are listed in the Simple Wizard (page 114).

The data source for each hidden field is displayed in the Report Wizard Field Map tab. See Report Field Data Source (page 120).

Sample Enterprise Skill Group Historical All Fields Report

This illustration is a sample of the report generated from the Enterprise Skill Group Historical All Fields template.

Figure 79: Enterprise Skill Group Historical All Fields 1 of 3
Enterprise Skill Group Real Time All Fields

About the Enterprise Skill Group Real Time All Fields Report (page 254)

Visible Fields in the Enterprise Skill Group Real Time All Fields Report (page 255)

Hidden Fields in the Enterprise Skill Group Real Time All Fields Report (page 258)

About the Enterprise Skill Group Real Time All Fields Report

This report shows the current status of the selected enterprise skill groups.

**Note:** If a call is queued to an Enterprise skill group, then the call will be queued at each peripheral skill group that belongs to the enterprise skill group. Therefore one call queued to an enterprise skill group composed of five peripheral skill groups will show up as 5 calls.

**Applicable Environment:** Unified CCE and Unified ICM.

**Value List:** Enterprise Skill Group

**Corresponding WebView templates:**

entskg30: IPCC Enterprise Skill Group Status Real Time WebView Report

entskg20: ICM Enterprise Skill Group Status Real Time

entskg28: Enterprise Skill Group Real Time All Fields

**Database Schema Table(s) from which data is retrieved:**

- \Enterprise_Skill_Group Skill_Group_Real_Time Enterprise_Skill_Group_Member
- Enterprise_Skill_Group_Member
- Skill_Group
Visible Fields in the Enterprise Skill Group Real Time All Fields Report

Visible fields are those fields that appear in a report generated from the stock template.

Visible fields are listed below in the order (left to right) in which they appear by default in the stock template.

**Note:** Fields applicable to a voice domain only are marked with an asterisk (*). Such fields are not applicable for e-mail or collaboration media.

**Enterprise Skill Group Name**

The enterprise skill group's enterprise name and ID.

Derived from: Enterprise_Skill_Group.EnterpriseName
(Enterprise_Skill_Group.EnterpriseSkillGroupID)

**Ent Queued Now**

The number of calls currently queued to the skill group at the CallRouter and at the local ACD queue.

**Note:** This field is visible by default and is applicable to CCE only. The equivalent field for Unified ICM is named **Queued Now (ICM)** is hidden by default.

Derived from: Skill_Group_Real_Time.RouterCallsQNow

**Ent Longest Task Q**

The longest queued task on the routing media, measured in HH:MM:SS (hours, minutes, seconds) format.

**Note:** This field is visible by default and is applicable to CCE only. The equivalent field for Unified ICM is named **Longest Task Q (ICM)** is hidden by default.

Derived from: Skill_Group_Real_Time.RouterLongestCallInQ

**ASA 5**

The Average Speed of Answer measured in HH:MM:SS (hours, minutes, seconds) format for the skill group during the rolling five minute interval.
Handled

The number of tasks that have been handled during the rolling five minute interval.

Derived from: Skill_Group_Real_Time.CallsHandledTo5

AHT

The average time in HH:MM:SS (hours, minutes, seconds) it has taken during the rolling five minute interval to handle a task.

Derived from: Skill_Group_Real_Time.HandleCallsTimeTo5 / Skill_Group_Real_Time.CallsHandledTo5

Log On

The number of agents that are currently logged on to the skill group. This count is updated each time an agent logs on and each time an agent logs off.

Derived from: Skill_Group_Real_Time.LoggedOn

Not Ready

The number of agents in the Not Ready state for the skill group. Not Ready is a state in which agents are logged on but are neither involved in any call handling activity nor available to handle a call.

Derived from: Skill_Group_Real_Time.NotReady

Not Active

The number of agents in the skill group who are currently not working on a task associated with the skill group.

Derived from: Skill_Group_Real_Time.Avail

Active In

The number of agents in the skill group currently working on inbound tasks.

Derived from: Skill_Group_Real_Time.TalkingIn

Active Out *

The number of agents in the skill group currently talking on outbound calls.

Derived from: Skill_Group_Real_Time.TalkingOut

Active Other *
The number of agents in the skill group currently talking on internal (neither inbound nor outbound) calls.

Examples of other calls include agent-to-agent transfers and supervisor calls. Derived from: Skill_Group_Real_Time.TalkingOther

**Active Auto Out** *

The number of agents in the skill group currently talking on AutoOut (predictive) calls.

Derived from: Skill_Group_Real_Time.TalkingAutoOut

**Active Preview** *

The number of agents in the skill group currently talking on outbound Preview calls.

Derived from: Skill_Group_Real_Time.TalkingPreview

**Active Reservation** *

The number of agents in the skill group currently talking on agent reservation calls.

Derived from: Skill_Group_Real_Time.TalkingReserve

**AAT**

The average talk or active time measured in HH:MM:SS (hours, minutes, seconds) format during the rolling five minute interval.

Derived from: (Skill_Group_Real_Time.HandledCallsTalkTimeTo5 / Skill_Group_Real_Time.CallsHandledTo5)

**Wrap Up**

The number of agents currently in wrap-up state for this skill group. Wrap Up is call-related work performed by an agent after the call is over. An agent performing wrap up is in either the Work Ready or Work Not Ready state.


**Hold**

The number of agents that have all active calls on hold or whose state to the skill group is Paused. The agent is not in the Hold state with one call on hold and talking on another call (for example, a consultative call). The agent must have all active calls on hold.

Derived from: Skill_Group_Real_Time.Hold

**Reserved**

Number of agents for the skill group currently in the Reserved state.

Derived from: Skill_Group_Real_Time.ReservedAgents
Busy Other

The number of agents currently in the BusyOther state.

Busy Other is a state in which the agent handling calls assigned to other skill groups during the half-hour interval.

For example, an agent might be talking on an inbound call in one skill group while simultaneously logged on to and ready to accept calls from other skill groups. The agent can be active (talking on or handling calls) in only one skill group at a time. Therefore, while active in one skill group, for the other skill group the agent is considered to be in the Busy Other state.

Derived from: Skill_Group_Real_Time.BusyOther

% Utilization

The percentage of Ready time that agents in the skill group spent talking or doing call work during the current five-minute interval. This is the percentage of time agents spend working on calls versus the time agents were ready.

Derived from: Skill_Group_Real_Time.PercentUtilizationTo5

Report Summary: There is a total report summary. See About Report Summaries (page 121).

Hidden Fields in the Enterprise Skill Group Real Time All Fields Report

Hidden fields for this template are listed in the Simple Wizard (page 114).

The data source for each hidden field is displayed in the Report Wizard Field Map tab. See Report Field Data Source (page 120).

Sample Enterprise Skill Group Real Time All Fields Report

This illustration is a sample of the report generated from the Enterprise Skill Group Real Time All Fields template.

Figure 82: Enterprise Skill Group Real Time Report 1 of 2

Figure 83: Enterprise Skill Group Real Time Report 2 of 2
Peripheral Skill Group Historical All Fields

About the Peripheral Skill Group Historical Report (page 259)

Visible Fields in the Peripheral Skill Group Historical Report (page 260)

Hidden Fields in the Peripheral Skill Group Historical Report (page 264)

About the Peripheral Skill Group Historical Report

A table of the selected Peripheral Skill Group(s) showing consolidated call and skill group statistics, gathered in half-hour increments.

Note: Completed tasks are all the tasks that completed during the time shown (that is, on the row in the report). This includes any tasks which began before the time frame shown. However, this does not include tasks where the caller abandoned in the local ACD queue.

This report displays the same data as the Enterprise Skill Group Historical report except that this report is organized by media rather then by skill group.

Applicable Environment: Unified CCE and Unified ICM.

Grouping: by Skill Group Name

Value List: Skill Group

Corresponding WebView templates: perskg35: IPCC Peripheral Skill Group Consolidated Half Hour

Also contains:

- all fields from perskg27: Peripheral Skill Group Historical All Fields.
- calculated fields from perskg33: IPCC Peripheral Skill Group Performance Summary Half Hour
- calculated fields from perskg35: IPCC Peripheral Skill Group Consolidated Half Hour
- calculated fields from perskg23: ICM Peripheral Skill Group Performance Summary Half Hour
- calculated fields from perskg25: ICM Peripheral Skill Group Consolidated Half Hour
- calculated fields from perskg08: FTE for Peripheral Skill Groups Half Hour

Database Schema Table(s) from which data is retrieved:

- Media_Routing_Domain
Visible Fields in the Peripheral Skill Group Historical Report

Visible fields are those fields that appear in a report generated from the stock template. Visible fields are listed below in the order (left to right) in which they appear by default in the stock template.

**Note:** Fields applicable to a voice domain only are marked with an asterisk (*). Such fields are not applicable for e-mail or collaboration media.

**Skill Group Name**

The enterprise skill group's enterprise name and ID.


**DateTime**

The date and time of the selected row's data in MM/DD/YYYY (month, day, year) and HH:MM:SS (hour, minute, second) format.

Derived from: `Skill_Group_Half_Hour.DateTime`

**Ent Queued**

The number of tasks queued to this Skill Group in the half hour interval. Derived from: `Skill_Group_Half_Hour.RouterCallsQueuedToHalf`

**Note:** This field is visible by default and is applicable to CCE only. The equivalent field for Unified ICM is named Total Queued (ICM) is hidden by default.

**ASA**

The skill group's average speed of answer in HH:MM:SS (hour, minutes, seconds) calculated from the time spent by callers when placed in queue and ringing at the agent's desktop before the task is answered divided by the number of tasks answered.

Derived from: `Skill_Group_Half_Hour.AnswerWaitTimeToHalf / Skill_Group_Half_Hour.CallsAnsweredToHalf`
SL Ans

The count of calls that are routed to the skill group or queued to the skill group in the last half hour interval.

Derived from: Skill_Group_Real_Time.ServiceLevelCallsOfferedToHalf

SL Aban

The count of calls that are abandoned within the skill group service level threshold in the last half hour interval.

Derived from: Skill_Group_Real_Time.ServiceLevelCallsAbandToHalf

Total

The total number of tasks completed by this skill group in the half hour interval.


Aban

For voice: the total number of calls that were abandoned while the agent's phone was ringing. For non-voice: the total number of tasks that were abandoned while being offered to an agent.

Derived from: (Skill_Group_Half_Hour.RouterCallsAbandQToHalf + Skill_Group_Half_Hour.AbandonRingCallsRingToHalf )

RONA

The total duration in HH:MM:SS (hours, minutes, and seconds) during the period that agents were logged into this skill group.

Derived from: Skill_Group_Half_Hour.LoggedOnTimeToHalf

Handled

The number of Routed tasks handled within this skill group in the half hour interval.

Derived from: Skill_Group_Half_Hour.CallsHandledToHalf

AHT

The Average Handle Time in HH:MM:SS (hours, minutes, seconds) for tasks sent to the skill group.

Derived from: Skill_Group_Half_Hour.HandledCallsTimeToHalf / Skill_Group_Half_Hour.CallsHandledToHalf

AAT
The Average Active Time in HH:MM:SS (hours, minutes, seconds) for tasks sent to the skill group.

Derived from: Skill_Group_Half_Hour.HandledCallsTalkTimeToHalf / Skill_Group_Half_Hour.CallsHandledToHalf

**Aban Hold**

The number of tasks offered to the skill group that abandoned while being held or paused by the agent. The value is incremented at the time the call disconnects.

Derived from: Skill_Group_Half_Hour.AbandonHoldCallsToHalf

**Trans In **

The time in HH:MM:SS (hours, minutes, seconds) that handling calls transferred into the skill group in the half hour interval.

Derived from: Skill_Group_Half_Hour.TransferInCallsTimeToHalf

**Trans Out **

The number of tasks this agent transferred to another agent or skill group in the half hour interval. This includes Consultative Calls. The value is updated in the database when the transfer of the call is completed.


**Ext Out **

For default skill groups: the number of times an agent initiated an outgoing external call in the half hour interval. For routing skill groups: the number of times an agent initiated a transfer or conference to an external device in the half hour interval.

Derived from: Skill_Group_Half_Hour.AgentOutCallsToHalf

**Active Time**

The time in HH:MM:SS (hours, minutes, seconds) that agents in the skill group were in the Active state in the half hour interval.

Derived from: Skill_Group_Half_Hour.TalkTimeToHalf

**Hold Time**

The total time agents spent in the Hold/Paused state in this skill group, measured in HH:MM:SS (hours, minutes, seconds) format. Includes Incoming Direct and Outgoing Internal, although call counts are not shown in this report.

Derived from: Skill_Group_Half_Hour.HoldTimeToHalf

**Log On Duration**
The total duration in HH:MM:SS (hours, minutes, and seconds) during the period that agents were logged into this skill group.

Derived from: Skill_Group_Half_Hour.LoggedOnTimeToHalf

% Not Active

The percentage of agents in the skill group who are NOT currently involved in tasks and who are ready to accept calls or tasks.


% Not Ready

The percentage of time that agents spent in the Not Ready state in relation to LoggedOnTime or the half hour interval, whichever is less.

Derived from: (Skill_Group_Half_Hour.NotReadyTimeToHalf / Skill_Group_Half_Hour.LoggedOnTimeToHalf)

% Active

The percentage of agents in the skill group who are working on incoming tasks or who are in one of the talking states.


% Hold

The percentage of time that agents spent in the Hold/Paused state in relation to LoggedOnTime or interval, whichever is less.

Derived from: (Skill_Group_Half_Hour.HoldTimeToHalf / Skill_Group_Half_Hour.LoggedOnTimeToHalf)

% Reserved

The percentage of time that agents spent working on Reserved time in relation to LoggedOnTime or interval, whichever is less.

Derived from: (Skill_Group_Half_Hour.ReservedStateTimeToHalf / Skill_Group_Half_Hour.LoggedOnTimeToHalf)

% Wrap Up

The percentage of time that agents have spent in Wrap-up state after incoming or outgoing calls in relation to LoggedOnTime or interval, whichever is less.
Derived from: \((\text{Skill}\_\text{Group}\_\text{Half}\_\text{Hour}.\text{WorkReadyTimeToHalf} + \text{Skill}\_\text{Group}\_\text{Half}\_\text{Hour}.\text{WorkNotReadyTimeToHalf}) / \text{Skill}\_\text{Group}\_\text{Half}\_\text{Hour}.\text{LoggedOnTimeToHalf})\)

**% Busy Other**

The percentage of time that agents spent working on Busy Other time in relation to LoggedOnTime or interval, whichever is less.

Derive from: \((\text{Skill}\_\text{Group}\_\text{Half}\_\text{Hour}.\text{BusyOtherTimeToHalf} / \text{Skill}\_\text{Group}\_\text{Half}\_\text{Hour}.\text{LoggedOnTimeToHalf})\)

**Report Summary:** There is a summary for each Skill Group Name and a total report summary. See About Report Summaries (page 121).

Hidden Fields in the Peripheral Skill Group Historical Report

Hidden fields for this template are listed in the Simple Wizard (page 114).

The data source for each hidden field is displayed in the Report Wizard Field Map tab. See Report Field Data Source (page 120).

Sample Peripheral Skill Group Historical Report

This illustration is a sample of the report generated from the Peripheral Skill Group Historical All Fields template.

**Figure 84: Peripheral Skill Group Historical Report 1 of 2**

Peripheral Skill Group Real Time All Fields

About the Peripheral Skill Group Real Time All Fields Report (page 265)
Visible Fields in the Peripheral Skill Group Historical Report (page 265)

Hidden Fields in the Peripheral Skill Group Historical Report (page 269)

About the Peripheral Skill Group Real Time All Fields Report

Reports generated from this template show the current status of the selected skill groups.

Note: If there are primary or secondary skill groups defined for the base skill group, then the base skill group is not shown.

Applicable Environment: Unified CCE and Unified ICM.

Grouping: by Skill Group Name

Value List: Skill Group

Corresponding WebView templates: perskg30: IPCC Peripheral Skill Group Status Real and perskg20: IPCC Peripheral Skill Group Status Real

Database Schema Table(s) from which data is retrieved:

- Media_Routing
- Skill_Group
- Skill_Group_Real_Time

See also:

Visible Fields in the Peripheral Skill Group Historical Report (page 265)

Hidden Fields in the Peripheral Skill Group Historical Report (page 269)

Visible Fields in the Peripheral Skill Group Real Time All Fields Report

Visible fields are those fields that appear in a report generated from the stock template.

Visible fields are listed below in the order (left to right) in which they appear by default in the stock template.

Note: Fields applicable to a voice domain only are marked with an asterisk (*). Such fields are not applicable for e-mail or collaboration media.

Skill Group Name

The enterprise name of the skill group and its skill target ID.

Derived from: Skill_Group.EnterpriseName and Skill_Group.SkillTargetID
Ent Queued Now

The number of calls currently queued to the skill group at the Unified ICM (Network Queue) and at the local ACD queue.

Note: This field is visible by default and is applicable to CCE only. The equivalent field for Unified ICM is named Queued Now (ICM) is hidden by default.

Derived from: Skill_Group_REAL_TIME.RouterCallsQNow

Ent Longest Task Q

The longest queued task on the routing media, measured in HH:MM:SS (hours, minutes, seconds) format.

Note: This field is visible by default and is applicable to CCE only. The equivalent field for Unified ICM is named Longest Task Q (ICM) is hidden by default.

Derived from: Skill_Group_REAL_TIME.RouterLongestCallInQ

ASA 5

The Average Speed of Answer measured in HH:MM:SS (hours, minutes, seconds) format for the skill group during the rolling five minute interval.

Derived from: Skill_Group_REAL_TIME.AnswerWaitTimeTo5 / Skill_Group_REAL_TIME.CallsAnsweredTo5

Ans Within SL

The number of tasks that are answered within the skill group service level threshold in the last five-minute interval.

Derived from: Skill_Group_REAL_TIME.ServiceLevelCallsTo5

Aban Within SL

The count of calls that are abandoned within the skill group service level threshold during the rolling five minute interval. Derived from:

Skill_Group_REAL_TIME.ServiceLevelCallsAbandTo5

Handled

The number of tasks that have been handled during the rolling five minute interval.

Derived from: Skill_Group_REAL_TIME.CallsHandledTo5

AHT

The average time in HH:MM:SS (hours, minutes, seconds) it has taken during the rolling five minute interval to handle a task.
Derived from: Skill_Group_Real_Time.HandleCallsTimeTo5 / Skill_Group_Real_Time.CallsHandledTo5

**Log On**

The number of agents that are currently logged on to the skill group. This count is updated each time an agent logs on and each time an agent logs off.

Derived from: Skill_Group_Real_Time.LoggedOn

**Not Ready**

The number of agents in the Not Ready state for the skill group. Not Ready is a state in which agents are logged on but are neither involved in any call handling activity nor available to handle a call.

Derived from: Skill_Group_Real_Time.NotReady

**Not Active**

The number of agents in the skill group who are currently not working on a task associated with the skill group.

Derived from: Skill_Group_Real_Time.Avail

**Active In**

The number of agents in the skill group currently working on inbound tasks.

Derived from: Skill_Group_Real_Time.TalkingIn

**Active Out * **

The number of agents in the skill group currently talking on outbound calls.

Derived from: Skill_Group_Real_Time.TalkingOut

**Active Other * **

The number of agents in the skill group currently talking on internal (neither inbound nor outbound) calls.

Derived from: Skill_Group_Real_Time.TalkingOther

**Active Auto Out * **

The number of agents in the skill group currently talking on AutoOut (predictive) calls.

Derived from: Skill_Group_Real_Time.TalkingAutoOut

**Active Preview * **

The number of agents in the skill group currently talking on outbound Preview calls.
Peripheral Skill Group Real Time All Fields

Derived from: Skill_Group_Real_Time.TalkingPreview

**Active Reservation** *

The number of agents in the skill group currently talking on agent reservation calls.

Derived from: Skill_Group_Real_Time.TalkingReserve

**Average Active Time**

The average talk or active time measured in HH:MM:SS (hours, minutes, seconds) format during the rolling five minute interval.

Derived from: (Skill_Group_Real_Time.HandledCallsTalkTimeTo5 / Skill_Group_Real_Time.CallsHandledTo5)

**Wrap Up**

The number of agents currently in wrap-up state for this skill group. Wrap Up is call-related work performed by an agent after the call is over. An agent performing wrap up is in either the Work Ready or Work Not Ready state.


**Hold**

The number of agents that have all active calls on hold or whose state to the skill group is Paused. The agent is not in the Hold state with one call on hold and talking on another call (for example, a consultative call). The agent must have all active calls on hold.

Derived from: Skill_Group_Real_Time.Hold

**Reserved**

The number of agents for the skill group currently in the Reserved state. Reserved is a state in which an agent is awaiting a call and is unavailable to receive any incoming calls. This state applies to agents on Northern Meridian ACDs only.

Derived from: Skill_Group_Real_Time.ReservedAgents

**Busy Other**

The number of agents currently in the BusyOther state.

Busy Other is a state in which the agent handling calls assigned to other skill groups during the half-hour interval).

For example, an agent might be talking on an inbound call in one skill group while simultaneously logged on to and ready to accept calls from other skill groups. The agent can be active (talking on or handling calls) in only one skill group at a time. Therefore, while active in one skill group, for the other skill group the agent is considered to be in the Busy Other state.

Derived from: Skill_Group_Real_Time.BusyOther
% Utilization

The percentage of Ready time that agents in the skill group spent talking or doing call work during the current five-minute interval. This is the percentage of time agents spend working on calls versus the time agents were ready.

Derived from: Skill_Group_Real_Time.PercentUtilizationTo5

Report Summary: There is a summary row for Skill Group Name. There is a total report summary for all fields except % Busy Other. See About Report Summaries (page 121).

Hidden Fields in the Peripheral Skill Group Real Time All Fields Report

Hidden fields for this template are listed in the Simple Wizard (page 114).

The data source for each hidden field is displayed in the Report Wizard Field Map tab. See Report Field Data Source (page 120).

Sample Peripheral Skill Group Real Time All Fields Report

This illustration is a sample of the report generated from the Peripheral Skill Group Real Time All Fields template.

Figure 85: Peripheral Skill Group Real Time 1 of 3

Figure 86: Peripheral Skill Group Real Time 2 of 3

Figure 87: Peripheral Skill Group Real Time 3 of 3
IVR Reports

IVR Ports Performance Historical

About the IVR Ports Performance Historical Report (page 271)

Visible Fields in the IVR Ports Performance Historical Report (page 272)

Hidden Fields in the IVR Ports Performance Historical Report (page 272)

About the IVR Ports Performance Historical Report

This template shows the performance of IVR ports for the selected time period. It presents a table of half-hour counts of IVR ports in-service, ports idle, and the time HH:MM:SS (hours, minutes, seconds) that all ports were busy.

Applicable Environment: Unified CCE

Default Sort Order: By IVR port trunk group and then by date and time.

Grouping: by IVR Ports

Value List: Trunk

Corresponding WebView template: trkgrp23: IVR Ports Performance Half Hour Report

Database Schema Table(s) from which data is retrieved: Trunk_Group and Trunk_Group_Half_Hour

See also:

Visible Fields in the IVR Ports Performance Historical Report (page 272)
Visible Fields in the IVR Ports Performance Historical Report

Visible fields (fields that appear in a report generated from the stock template) are listed in the order (left to right) in which they appear by default.

**IVR Ports** Derived from: Trunk_Group.EnterpriseName

The name of the IVR port used by the trunk group.

**DateTime** Derived from: Trunk_Group_Half_Hour.DateTime

The date and time of the selected row's data in MM/DD/YYYY (month, day, year) and HH:MM:SS (hour, minute, second) format.

**Ports** Derived from: Trunk_Group_Half_Hour.TrunksInService

The number of ports in the group in service at the end of the half hour interval.

**% Busy** Derived from: Trunk_Group_Half_Hour.InUseInboundTimeToHalf / Trunk_Group_Half_Hour.InServiceTimeToHalf

The percentage of time that the trunk groups in service were in use in the half hour interval (for Inbound Only).

**All Ports Busy** Derived from: Trunk_Group_Half_Hour.AllTrunksBusyToHalf

The total time, in HH:MM:SS (hours, minutes, seconds), in the half hour interval, that all ports in the group were busy.

**Report Summary**

This report has a Group Summary for each IVR Port for each interval. It also has a Report Summary all fields for all IVR Ports.

See About Report Summaries (page 121).

Hidden Fields in the IVR Ports Performance Historical Report

Hidden fields for this template are listed in the Simple Wizard (page 114).

The data source for each hidden field is displayed in the Report Wizard Field Map tab. See Report Field Data Source (page 120).

Sample IVR Ports Performance Historical Report

This illustration is a sample of the report generated from the IVR Ports Performance Historical Report template.
Figure 88: IVR Ports Performance Historical report - sample layout

<table>
<thead>
<tr>
<th>IVR Ports</th>
<th>Date/Time</th>
<th>Ports</th>
<th>All Ports Busy</th>
<th>% Busy</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASTIVR_B(3FVFR_B)</td>
<td>10/2/2007 10:00:00 AM</td>
<td>300</td>
<td>0</td>
<td>0.06%</td>
</tr>
<tr>
<td></td>
<td>10/2/2007 10:30:00 AM</td>
<td>300</td>
<td>0</td>
<td>0.22%</td>
</tr>
<tr>
<td></td>
<td>10/2/2007 11:00:00 AM</td>
<td>300</td>
<td>0</td>
<td>0.14%</td>
</tr>
<tr>
<td></td>
<td>10/3/2007 10:00:00 AM</td>
<td>300</td>
<td>0</td>
<td>0.10%</td>
</tr>
<tr>
<td></td>
<td>10/3/2007 10:30:00 AM</td>
<td>300</td>
<td>0</td>
<td>0.08%</td>
</tr>
<tr>
<td></td>
<td>10/3/2007 11:00:00 AM</td>
<td>300</td>
<td>0</td>
<td>0.04%</td>
</tr>
<tr>
<td>CVSV.3BC5D5M10541_120</td>
<td>10/2/2007 10:00:00 AM</td>
<td>110</td>
<td>0</td>
<td>0.24%</td>
</tr>
<tr>
<td></td>
<td>10/2/2007 10:30:00 AM</td>
<td>110</td>
<td>0</td>
<td>0.08%</td>
</tr>
<tr>
<td></td>
<td>10/2/2007 11:00:00 AM</td>
<td>110</td>
<td>0</td>
<td>0.52%</td>
</tr>
<tr>
<td></td>
<td>10/3/2007 10:00:00 AM</td>
<td>110</td>
<td>0</td>
<td>0.00%</td>
</tr>
<tr>
<td></td>
<td>10/3/2007 10:30:00 AM</td>
<td>110</td>
<td>0</td>
<td>0.00%</td>
</tr>
<tr>
<td></td>
<td>10/3/2007 11:00:00 AM</td>
<td>110</td>
<td>0</td>
<td>0.10%</td>
</tr>
</tbody>
</table>

Generated on 5/28/2007 at 11:01 AM by \textit{\textsc{Windows-Explorer.exe}}

DataTime: AM, Trunk Group: (In selected values: ASTIVR_B(3FVFR_B), CVSV.3BC5D5M10541_120), Historical Data Field: Between 10/2/2007 12:00:00 AM and 10/4/2007 12:00:00 AM
Part 7: Expert Advisor Templates

Chapters in Part 7 document the stock Expert Advisor templates that can be imported into Unified IC.

- Expert Advisor Report Templates (page 277)
- Fields Used in Expert Advisor Templates (page 283)
Chapter 24

Expert Advisor Report Templates

This section explains the Expert Advisor report templates you can use with Cisco Unified Intelligence Center (Unified IC).

Both reporting applications retrieve identical data from the Historical Reporting database (HRDB) on the Expert Advisor reporting server.

All reports are presented as tables in Unified IC.

This chapter contains the following topics:

- Agent Assignment Queue Report, page 277
- Agent Handle Report, page 278
- Agent Reject and Timeout Report, page 278
- Agent State Summary Report, page 279
- Assignment Queue Detail Report, page 279
- Contact Detail Reports, page 280
- Contact Media Detail Report, page 281

Agent Assignment Queue Report

This report shows contacts offered to and handled by each expert for each assignment queue.

Required data values for this report are Report Start Time and Report End Time.

Data in this report includes:

- Assignment Queue Name (page 284)
- Agent Name (page 283)
- Avg. Handle Time (page 284)
Agent Handle Report

This report shows the number of contacts offered to and handled by an expert advisor, regardless of the assignment queue.

Required data values for this report are Report Start Time and Report End Time.

**Data in this report includes:**

- Agent Name (page 283)
- Avg. Handle Time (page 284)
- Avg. Talk Time (page 284)
- Contacts Offered (page 285)
- Contacts Handled (page 285)
- Handled/Offered % (page 285)

Agent Reject and Timeout Report

For each expert advisor, this report shows the number of contacts that were rejected and the number of offered contacts that timed out.

Required data values for this report are Report Start Time and Report End Time.

**This report displays the following data:**

- Agent Name (page 283)
- Contacts Offered (page 285)
- Contacts Rejected (page 285)
- Contacts Timed Out (page 285)
- Reject/Offered% (page 286)
Agent State Summary Report

This report shows total logged-in time, available/unavailable time, and active time for each expert advisor.

Required data values for this report are Report Start Time and Report End Time.

This report displays the following data:

• **Agent Name** (page 283) - Crystal Reports
  
  In Unified IC, Agent Name is represented by `resourceid` (page 286), `firstname` (page 285), `lastname` (page 285)

• **Total Logged-in Time (Days and Time)** (page 287)

• **Active Time (Days and Time)** (page 283)

• **Available Time (Days, Time, % Time)** (page 284)

• **Available %** (page 284)

• **Unavailable Time (Days, Time, % Time)** (page 287)

• **Unavailable %** (page 287)

• **Wrapup time** (page 287) - Unified IC only

**Note:** This report might occasionally show Available Time % + Unavailable Time % as a value other than 100%. This is a rounding discrepancy in the database and is not an issue for the report.

Assignment Queue Detail Report

This report shows the number of contacts handled by each assignment queue, along with average handle and talk time.

Required data values for this report are Report Start Time and Report End Time.

This report displays the following data:

• **Assignment Queue Name** (page 284)
Contact Detail Reports

There are four contact detail reports, differentiated as follows:

- **By Assignment Queue** shows the contact detail for a specified assignment queue.
  
  Required data values for this report are Report Start GMT Time, Report End GMT Time, and Assignment Queue Name.

- **By Caller Address** shows the contacts for a specified caller address.
  
  Required data values for this report are Report Start GMT Time, Report End GMT Time, and Caller Address.

- **By Contact Disposition** shows the contact disposition details for a specified incoming disposition.
  
  Required data values for this report are Report Start GMT Time, Report End GMT Time, and Contact Detail Disposition.

- **By Incoming Address** shows the contacts for a specified incoming address.
  
  Required data values for this report are Report Start GMT Time, Report End GMT Time, and Incoming Address.

Run the report. Then select a column on the grid to sort by AssignmentQueue (the Default) or by Incoming Address, Caller Address, or Disposition.

**This report displays the following data:**

- Application (page 283)
- Assignment Queue Name (page 284)
- CallerAddress (page 284)
- ContactDetailType (page 284)
- ContactDisposition (page 284)
- ContactID (page 284)
Contact Media Detail Report

This report shows contact segment media details.

Required data values for this report are Report Start GMT Time and Report End GMT Time. In addition, you can filter by Contact ID, Application ID, or Incoming Address.

Note: This report displays a maximum of 1002 records. Avoid selecting all items for a long time range. Limit the select of Contact ID, Application ID, or Incoming Address choices and pull data multiple times for a shorter time range.

This report displays the following data:

- Application (page 283)
- ContactID (page 284)
- ContactSegmentNum (page 285)
- Duration (page 285)
- Incoming Address (page 285)
- MediaDirection (page 285)
- MediaType (page 285)
- MediaStatus (page 285)
- ParticipantID (page 286)
- ParticipantType (page 286)
Fields that appear in the historical reports are listed below in alphabetical order. The table shows the reports the field appears in and a description of its purpose in that report. Where applicable, the table also notes calculations that produce its value.

<table>
<thead>
<tr>
<th>This data field</th>
<th>Appears in these reports</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Time</td>
<td>Agent State Summary (page 279)</td>
<td>Time the expert spends working on the task, shown as:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Days (total active time /24)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>and as</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Time (total active time in hours)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This is the time the expert goes to TaskCompleted state minus the time the expert goes to Active state.</td>
</tr>
<tr>
<td>Agent Name</td>
<td>Agent Assignment Queue (page 277)</td>
<td>First and last name of the expert advisor.</td>
</tr>
<tr>
<td></td>
<td>Agent Handle (page 278)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Agent Reject and Timeout (page 278)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Agent State Summary (page 279)</td>
<td></td>
</tr>
<tr>
<td>Application</td>
<td>Contact Detail (page 280)</td>
<td>Unique, system-generated ID for the application.</td>
</tr>
<tr>
<td></td>
<td>Contact Media Detail (page 281)</td>
<td></td>
</tr>
</tbody>
</table>
### Alphabetical List of All Fields in the Historical Reports

<table>
<thead>
<tr>
<th>This data field</th>
<th>Appears in these reports</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment Queue Name</td>
<td>Agent Assignment Queue (page 277) Assignment Queue Detail (page 279) Contact Detail (page 280)</td>
<td>Name of the assignment queue, as configured in the Cisco Unified Expert Advisor Operations Console.</td>
</tr>
<tr>
<td>% Available</td>
<td>Agent State Summary (page 279)</td>
<td>Percentage of time agent spends in available state. Calculated as (available time / total logged-in time) * 100</td>
</tr>
<tr>
<td>Available Time</td>
<td>Agent State Summary (page 279)</td>
<td>Time the expert spends in available state, calculated as:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Days (total available time / 24)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Time (total available time),</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• % Time (total available time / total logged-in time) * 100</td>
</tr>
<tr>
<td>Avg Handle Time</td>
<td>Agent Handle (page 278)</td>
<td>Average time the expert spent on a handled contact.</td>
</tr>
<tr>
<td>Calculated as (Total Ring time + Total Talk time + Total Wrapup time) / Total Contacts Handled</td>
<td>Agent Assignment Queue (page 277) Assignment Queue Detail (page 279)</td>
<td>Average handle time for calls handled by this expert for this assignment queue.</td>
</tr>
<tr>
<td>Note: Wrapup Time is always 0 in this release.</td>
<td>Assignment Queue Detail (page 279)</td>
<td>Average handle time for calls handled by this assignment queue.</td>
</tr>
<tr>
<td>Avg Talk Time</td>
<td>Agent Handle (page 278)</td>
<td>Average time the expert spent talking with the caller.</td>
</tr>
<tr>
<td>Calculated as Total Talk time / Total Contacts Handled</td>
<td>Assignment Queue Detail (page 279)</td>
<td>Average time spent with contacts in this assignment queue.</td>
</tr>
<tr>
<td></td>
<td>Agent Assignment Queue (page 277)</td>
<td>Average time the expert spent talking with the caller for calls routed to this assignment queue.</td>
</tr>
<tr>
<td>Caller Address</td>
<td>Contact Detail (page 280)</td>
<td>The address associated with the caller. For incoming TDM calls, this contains the ANI when available.</td>
</tr>
<tr>
<td>Contact Detail Type</td>
<td>Contact Detail (page 280)</td>
<td>For this release, all contact detail types are translation-routed.</td>
</tr>
<tr>
<td>Contact Disposition</td>
<td>Contact Detail (page 280)</td>
<td>How this leg of the call was handled.</td>
</tr>
<tr>
<td>Contact ID</td>
<td>Contact Detail (page 280) Contact Media Detail (page 281)</td>
<td>A generated ID for the contact. This ID is established when a caller initiates a contact into the system and is used for the entire caller interaction.</td>
</tr>
<tr>
<td>This data field</td>
<td>Appears in these reports</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Contact Segment Number</td>
<td>Contact Media Detail (page 281)</td>
<td>Identifier associated with the segment of the contact.</td>
</tr>
<tr>
<td>Contacts Handled</td>
<td>Agent Handle (page 278)</td>
<td>Total contacts handled by this expert.</td>
</tr>
<tr>
<td>Calculated as Contacts handled = Contacts offered - Contacts Timeout - Contacts Rejected</td>
<td>Agent Assignment Queue (page 277)</td>
<td>Total contacts handled by this expert that were routed by this assignment queue.</td>
</tr>
<tr>
<td>Incremented when the call ends</td>
<td>Agent Assignment Queue (page 277)</td>
<td>Total contacts handled by this assignment queue.</td>
</tr>
<tr>
<td>Contacts Offered</td>
<td>Agent Reject and Timeout (page 278)</td>
<td>Total number of contacts offered to this expert.</td>
</tr>
<tr>
<td></td>
<td>Agent Handle (page 278)</td>
<td>Total number of contacts offered to this expert.</td>
</tr>
<tr>
<td></td>
<td>Agent Assignment Queue (page 277)</td>
<td>Total contacts offered to this expert that were routed by this assignment queue.</td>
</tr>
<tr>
<td>Contacts Rejected</td>
<td>Agent Reject and Timeout (page 278)</td>
<td>Total number of contacts rejected by this expert (the expert responded to the IM and was unable to accept the call).</td>
</tr>
<tr>
<td>Contacts Timed Out</td>
<td>Agent Reject and Timeout (page 278)</td>
<td>Total number of contacts that timed out (the expert did not respond to the call).</td>
</tr>
<tr>
<td>Contact Type ID</td>
<td>Contact Detail (page 280)</td>
<td>ContactID associated with the contact segment. Null in this release.</td>
</tr>
<tr>
<td>Duration</td>
<td>Contact Media Detail (page 281)</td>
<td>Duration for the segment is calculated as (ContactSegmentDetail.endDateTime - ContactSegmentDetail.startDateTime).</td>
</tr>
<tr>
<td>First Name</td>
<td>Agent State Summary (page 279)</td>
<td>The first name of the expert as obtained from the Cisco Unified Presence server during synchronization.</td>
</tr>
<tr>
<td>Incoming Address ID</td>
<td>Contact Detail (page 280)</td>
<td>Contact Detail (page 281)</td>
</tr>
<tr>
<td>Handled/Offered %</td>
<td>Agent Assignment Queue (page 277)</td>
<td>Percentage of offered calls that the expert handled.</td>
</tr>
<tr>
<td></td>
<td>Agent Handle (page 278)</td>
<td></td>
</tr>
<tr>
<td>Last Name</td>
<td>Agent State Summary (page 279)</td>
<td>The last name of the expert as obtained from the Cisco Unified Presence server during synchronization.</td>
</tr>
<tr>
<td>Media Type</td>
<td>Contact Media Detail (page 281)</td>
<td>Type of media associated with this contact. In this release, Media Type is always Audio.</td>
</tr>
<tr>
<td>Media Status</td>
<td>Contact Media Detail (page 281)</td>
<td>Status of the media associated with the contact.</td>
</tr>
<tr>
<td>Media Direction</td>
<td>Contact Media Detail (page 281)</td>
<td>Direction of the media associated with the contact.</td>
</tr>
<tr>
<td>This data field</td>
<td>Appears in these reports</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Originator Address</td>
<td>Contact Detail (page 280)</td>
<td>Address associated with the Originator at the time the contact was initiated.</td>
</tr>
<tr>
<td>Originator Type</td>
<td>Contact Detail (page 280)</td>
<td>Originator type. Values: 0 = Unknown</td>
</tr>
<tr>
<td>Originator ID</td>
<td>Contact Detail (page 280)</td>
<td>Identifier associated with the OriginatorType specified.</td>
</tr>
<tr>
<td>Original Incoming Address ID</td>
<td>Contact Detail (page 280)</td>
<td>The IncomingAddressID associated with the original incoming Contact Detail.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For consultative contacts, the OriginalIncomingAddressID is the IncomingAddressID from the initial Contact Detail Record.</td>
</tr>
<tr>
<td>Participant ID</td>
<td>Contact Media Detail (page 281)</td>
<td>System-generated identifier for the participant.</td>
</tr>
<tr>
<td>Participant Type</td>
<td>Contact Media Detail (page 281)</td>
<td>Type associated with the ParticipantID for the ContactSegment. 0 = Unknown. 1 = Resource.</td>
</tr>
<tr>
<td>Reject/Offered %</td>
<td>Agent Reject and Timeout (page 278)</td>
<td>Percentage of offered calls that the expert rejected.</td>
</tr>
<tr>
<td>Resource ID</td>
<td>Agent State Summary (page 279)</td>
<td>The unique ID generated by the system when the resource is added and saved.</td>
</tr>
<tr>
<td>Session ID</td>
<td>Contact Detail (page 280)</td>
<td>System-generated ID that groups related contact objects.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For this release, the SessionID is the same as the ContactID.</td>
</tr>
<tr>
<td>% Rejected</td>
<td>Agent Reject and Timeout (page 278)</td>
<td>Percentage of rejected contacts (the expert responded with a message that he or she was not able to accept the call).</td>
</tr>
<tr>
<td>Calculated as (Contacts Rejected / Contacts Offered * 100)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>% Timed Out</td>
<td>Agent Reject and Timeout (page 278)</td>
<td>Percentage of contacts that timed out (the expert did not respond to the message).</td>
</tr>
<tr>
<td>Calculated as (Contacts Timed Out / Contacts Offered * 100)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Timeout/Offered %</td>
<td>Agent Reject and Timeout (page 278)</td>
<td>Percentage of offered calls to which the expert did not respond.</td>
</tr>
<tr>
<td>Summary</td>
<td>Agent Assignment Queue (page 277)</td>
<td>An aggregate of the statistics over all agents within a specific assignment queue.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Summaries for Contacts Offered and Contacts Handled is a simple total. Summaries for Avg columns are calculated as a weighted average.</td>
</tr>
<tr>
<td>This data field</td>
<td>Appears in these reports</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>% Unavailable</td>
<td>Agent State Summary (page 279)</td>
<td>Percentage of time agent spends in unavailable state. Calculated as (unavailable time / total logged-in time) * 100)</td>
</tr>
<tr>
<td>Total Logged In Time</td>
<td>Agent State Summary (page 279)</td>
<td>Logoff time minus logon time. If the expert logs in multiple times, the system sums times for all the sessions.</td>
</tr>
<tr>
<td>Unavailable Time, calculated as:</td>
<td>Agent State Summary (page 279)</td>
<td>Time agent spends in unavailable state.</td>
</tr>
<tr>
<td>• Days (total unavailable time / 24)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Time (total unavailable time)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• % Time (total unavailable time / total logged-in time) * 100%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wrapup Time</td>
<td>Agent State Summary (page 279)</td>
<td>Time agent spends in wrapup state. Always 0 in this release.</td>
</tr>
</tbody>
</table>
Troubleshooting Tips and FAQs

This Appendix has Troubleshooting Tips for:

- Installation (page 289)
- Configuration (page 290)
- Security (page 295)
- License (page 295)
- Login (page 296)
- User Interface (page 297)
- Reporting (page 298)

You can find other troubleshooting information on Troubleshooting Tips for Unified IS 7.5 (http://docwiki.cisco.com/wiki/Troubleshooting_Tips_for_Unified_IS_7.5). If you can sign in with a Cisco user ID and password, you can add or update troubleshooting tips on this site.

Installation

SQL Hardening

During the installation, SQL Hardening is applied to the Archiver and the CUIC databases.

SQL Hardening is the process of allowing connection to SQL Server by Windows authentication only.
It is possible for the Cisco Unified IC SQL Hardening to fail if it is preempted by your organization's SQL Hardening policy.

Should SQL Hardening fail for any reason, there is no effect on functionality.

The failure of SQL Hardening then it will be possible to connect to SQL Server using both Windows authentication and SQL authentication.

Troubleshooting Configuration

Configuration Tool and Fully Qualified Domain Names

When entering Domain Name information in the Unified IS Configuration Tool, enter only the base Domain name. For example, if the domain name is "Unified.com" enter "Unified". Entering the fully-qualified domain name might result in an exception.

Configuring IIS Failed

If you see this message, look at the CuisConfigTool.Log file and make every effort to resolve the error based on the information in that file.

Only if it is not possible to resolve the matter from information in the CuisConfigTool log, manually configure IIS as follows:

1. Create an application pool:
   - In the IIS management console, right-click on Application Pools. Click New. Select Application Pool.
   - Enter the name CUIS application pool.
   - Leave the Use default settings for application pools radio buttons selected and click OK.
   - Right-click the new application pool and select Properties.
   - In the Identity tab, select the Configurable radio button and enter the credentials of the Unified IC internal user.

2. Create a web application:
   - In the IIS management console, right-click on Web Sites. Click New; then Web Site.
   - For description, enter CUIS Website.
   - For Path, browse to the CuisWeb directory inside the <CUIS_HOME> directory.
   - For Allow Anonymous Access, select False.
– Allow the following permissions: Read, Run Scripts, Execute.
– Accept the defaults for all other fields,

3. Right-click on the newly created web application and select Properties.

4. In the Home Directory tab, for Application pool, select the CUIS application pool.

5. In the Directory Security tab:
   – In authentication and access control, click Edit.
   – Check only the Integrated Windows Authentication checkbox.

6. Under Web service extensions In the IIS management console, make sure that ASP.NET v2.0.50727 is allowed.

Configuring the CUIC Scheduler Service Failed

If you see this message, look at the CuisConfigTool.Log file and make every effort to resolve the error based on the information in that file.

Only if it is not possible to resolve the matter from information in the CuisConfigTool log, configure the Scheduler as follows:

1. Open a command windows.

2. Go to the directory <CUIS_HOME>CuisScheduler.

3. Run the following command: installutil CuisScheduler.exe.

4. From Windows Administrative Tools > Services, ensure that this service is set to startup automatically.

5. Set the configuration file:
   – Locate the CuisScheduler.exe.config file. It is in the same directory as the Scheduler service executable.
   – Replace its contents with the contents of the web.config file located in <CUIS_HOME>CuisWeb.

6. Change the credentials under which the scheduler service runs.
   – Locate the CUIS Scheduler Service in the Services control panel.
   – Right-click the service and select Properties.
   – In the LogOn tab, enter information so that the CUIS Scheduler Service runs with the credentials of the Unified IC internal user.
7. Start the Scheduler service.

Creating CUIC Database Failed

If you see this message, look at the :CuisConfigTool.Log file and make every effort to resolve the error based on the information in that file.

Only if it is not possible to resolve the matter from information in the CuisConfigTool log, you can manually run the SQL script as follows:

1. Open MS SQL Server. Make sure you are connected as a user who is an administrator in SQL Server and to the master database.

2. Open a "New Query" window.

3. Copy and paste the contents of the following file into the query window:
   &lt;CUIS_HOME&gt;\CuisSqlScripts\CUIC\CUIC_DB_INSTALL.SQL.

4. Do a search-and-replace on the text that was pasted from the file. Search for cuic_data, and replace with cuic_data&lt;ip or hostname of CUIC web server&gt;.

5. Execute the query.

6. Open Object Explorer &gt; Databases to verify that the database was created.

Domains and Named Instances

If SQL Server uses Named Instances, then you must create the Unified IC User and the Archiver User as Domain Users.

Machines in Multiple Domains

Unified IS does not support deployments when servers are in separate domains.

Port 80 Error

During the Web Server configuration, you might see an error if Port 80 is already being used. This is most likely the Default Web Site that IIS installs.

To resolve this:

1. Navigate to Internet Information Services. (My Computer &gt; Manage &gt; Service and Applications &gt; IIS &gt; Web sites).

2. Right-click the Default Web site and select Properties.

3. Change the TCP port number to something other than 80. Then click OK.
Rerunning the Configuration

If you need to rerun the Configuration tool to change any parameters you have entered or selected, do so outside of normal business hours.

Rerunning the configuration will stop services.

You will need to restart the web server.

Row Limit

There is a Row limit fields in the Web application settings window (page 42) in the Configuration Tool for the Intelligence Web Server.

The default value for this field is 3000, and you can change it.

This value sets the result set that is sent for historical reports. An algorithm multiplies this value by 2.6 for real time reports.

Unified IS is qualified to return a maximum result set of 8000.

If you enter filters for a real time report that return more than 8000 rows, you see a warning message.

There are two ways to resolve this:

- Disable caching for the Value List.
  
  To do this:
  
  - Edit the report and open the Report Wizard Data Settings tab (page 155) to determine the Key Criteria field. This is the Value List field used for filtering.
  
  - Click the Field Map tab. Locate the Key Criteria field.
  
  - Right-click the fields and select Field Properties.
  
  - Click the Data Source tab (page 153).
  
  - Check the Pre-Filter Query box.
  
  This disables caching.

- Rerun the configuration to set a larger row limit.

  **Note:** Be aware that a larger row limit might affect the performance of historical reports.
Server Not Responding to Ping Command

There are several configuration actions that direct the Configuration tool to ping a server.

If you see an error message that indicates a server did not respond to the Ping command, the server might have Ping disabled.

It is safe to ignore these messages, as the Ping is done only to detect typos in the entry of the host name.

Setting Folder Permissions Failed

If you see this message, look at the CuisConfigTool.Log file and make every effort to resolve the error based on the information in that file.

Only if it is not possible to resolve the matter from information in the CuisConfigTool log, set folder permissions as follows:

1. In Windows Explorer, navigate to the directory where the web application is stored (<CUIS_HOME>CuisWeb).
2. Make sure that the only permissions that this folder has are the following. (Permissions should apply to the directory and to all subdirectories and files within it.)
   - For users in the CuisLocalUserGroup: read, read and execute, and list directory contents.
   - For users in the Administrators group: full control.
   - For the CUIC windows user: read, write, execute, and list directory contents.

Setting Up Permissions for CUIS SQL Server Login Failed

If you see this message, look at the CuisConfigTool.Log file and make every effort to resolve the error based on the information in that file.

Only if it is not possible to resolve the matter from information in the CuisConfigTool log, manually create a login as follows:

1. Open MS SQL Server.
   
   Make sure you are connected as a user who is an administrator in SQL Server and to the master database.

2. Open a New Query window.

3. Type the following: CREATE LOGIN "<domain>\<username>" FROM WINDOWS
The \<domain>\<username> is the internal Unified IC user that will run all applications.

4. Go to Security > Logins to verify that the Login was created for the user.

Troubleshooting Security

Windows Integrated Authentication or SQL Authentication

The default authentication method used by Unified IS is Windows Integrated Authentication.

If you are connecting to a Unified ICM/CCE Admin Workstation with Unified ICM Version 7.2, and if the SQL Server on that machine uses SQL Authentication and not Mixed Authentication, you will need to a SQL account created on the Unified ICM SQL Server and to assign correct database permissions to this SQL user.

The Archiver needs to create a linked server object to the Unified ICM databases using this SQL account (name and password).

Troubleshooting Licenses

License Message at Login

If the browser window displays a message the license is not available, verify that the file is installed in the correct directory. See Licensing (page 50).

License Message - Exceeded Number of Licensed Users

The user count is based on the number of sessions in IIS.

It is possible to see an error that you have exceeded the allowed number of concurrent licensed users if some users have more than one browser open.

This can be resolved by stopping and restarting IIS on the web server.

License URL

The URL for the Cisco licensing website is https://tools.cisco.com/SWIFT/Licensing/PrivateRegistrationServlet

Windows Event Viewer License Information

The following error codes might appear in the Event Viewer:
### Troubleshooting Login

#### Cannot Access Using IP Address

If you cannot access the Unified IC server through http://<CUIC Server IP>, check to see if the browser is using a Proxy server.

If it is, you need exclude the Unified IC IP address from Proxy settings.

To do this:

1. On the browser, select **Tools->Internet Options**.
2. Click the Connections tab. Then click **LAN Settings**.
3. In the LAN settings windows, Proxy server section, click **Advanced**
4. In the Exceptions, section, type in the IP address for Unified IC. Then click OK three times.
User Cannot Log In

Make sure the user has been added as a member of the CUISLocalUserGroup.

See Adding Unified IC Users (page 62).

If the environment requires a domain name or machine name, make sure it is prepended to the user name (AD_NAME\user01).

If you are prompted with an ActiveDirectory login prompt, re-enter your Windows login information.

Troubleshooting the User Interface

Dashboard Slide Show

In Dashboard Slideshow mode, you have the option to use the Esc key to stop the slideshow or to use the X close button.

If one of the dashboard items is an external web page, then the Esc key will not work and you must use the X button to close the slideshow browser window.

New Values Not Being Saved

If your changes to Value Lists, Data Source, Reports, and so forth, are not saved, check your Internet Tools.

If you see the following setting: "Check for newer version of stored pages = never", then change it to "= always."

Stylesheet StaticGroup.css

One of the stylesheets installed with Unified IC is called StaticGroup.css. It is designed for grouped grids only.

If you use this style sheet regularly, you might experience two negative effects:

- View a report - Edit Filters dialog.

  If you select the Explicit Range radio button, there is a display issue which does not give you the option to enter a Range. You can, however, click the buttons that display a Calendar.

- Save Report causes a display issue where the Save button is obscured and Cancel is the only option.
Troubleshooting Reporting

Bypass Filter

Before saving a report to bypass the filter, be sure to select a filter that does not return too many values. If there is no filter in place, Unified IC selects all items for today, which can cause problems. See Saving Reports (page 113).

Cloning Reports

If you notice script errors when attempting to clone reports, turn off the Internet Explorer Pop-Up Blocker.

Data Source Failover

Perform these steps if the data source from which a report retrieves information becomes unavailable (for example, if the HDS on Unified ICM Side A is down).

1. Select Administrative > Data Sources to open the Data Sources window.
2. Select the data source and click Edit to open the Edit Data Source window.
3. Edit the Server (IP or DNS: port) field to enter an IP address for an available data source.
4. Click Test Connection.

See also: Administering Data Sources (page 87).

Deleting Reports

Restricted Users cannot delete or rename personal reports.

If a Restricted User needs to delete or rename a report, an Admin or Security Admin can fake that user to complete the process of renaming the report (page 144) or deleting the report (page 145).

You cannot delete a scheduled report if it does not have a name.

Duplicate Collection Names

If there are duplicate names for collections, the Administrator can edit the duplicate collection, check its values, and rename the collection appropriately.
Dynamic Headers

Dynamic headers work only with the historical (static) grid. They allow you to embed a field's value into a header.

To use dynamic headers, you need to add Excel/Formula style field IDs into the header's Display/Friendly Name field.

For example, to embed the value of the Interval field into the Skill Group Name column header, you would edit the display name property of the skill group name field to include [Interval], such as "Skill Group [Interval]", which, when rendered, will display the value of the Interval value for the first row in the data set in place of the "[Interval]" string.

Note that in order for this feature to work, the dataset MUST return data. Also note that the string enclosed in brackets must match the field's base column name, which you can find on the data tab of the field properties dialog.

Export to Excel Error

There are two reasons you might see an error when you export a report to Excel.

- You see an error if you attempt to export a report to Excel and MS Excel is not installed on the system from which you are running the browser.

  As a workaround, if you have a PDF printer installed, print the report file to the PDF printer.

- Even if Excel is installed on the system, exporting to Excel sometime results in a alert.

  This alert is a result of a new security feature in Excel called Extension Hardening, which ensures that the file content being opened matches the extension type specified in the shell command that is attempting to open the file.

  You can safely ignore this error.

See Exporting a Report to Excel (page 115)

Importing Reports

It is possible to connect to the Unified IC web application locally or remotely.

Depending how you are connecting, you might encounter problems importing reports.

If you are connected using remote desktop and try to import a report that exists on the Administrator's desktop then you will not be able to import the report. You will see an error message indicating that the XML is not valid.
The web server is running as the Unified IC User, and that user does not have permission to the Administrator’s desktop.

If you are running from your desktop and pointing at a remote webserver, the Browse button on the Import dialog box will browse your own local machine, but the file you want to import exists on the remote server.

Independent Subgroup Footer Formulas

Each subgroup within a report can have its own footer calculations. This is set FOR EACH FIELD.

Each field, on its formatting tab, can specify a formula to use for the footer for group 1, 2, or 3.

If the field is set to use a custom footer formula, and if these formulas are populated, they will override the custom footer formula JUST FOR THAT GROUP.

In other words, the group 1 formula would only be used for the footer in subgroup 1, the group 2 footer formula would only be used for the footer in subgroup 2, and so forth.

The standard custom footer formula is used for the "grand summary" at the very bottom of the report.

Report Info Window Has Invalid Links

The Report Info window (page 129) will have invalid links if you specify 'localhost' for the web server name and not the Hostname or IP Address for the server.

The permalinks in the Report Info window will contain localhost and will not work for a user who runs the Unified IC web application from another site.

Saving Historical as Real Time or Real Time as Historical

Note: Saving a Real Time report as an Historical report, or vice versa, is not advisable.

If you save a Real Time as an Historical, the Date/Time filters are greyed out, but the report does not run unless you access the Report Wizard Data Settings Tab (page 155) and edit both the Key Criteria and Historical Key Criteria fields.

Scheduled Reports

When you run a scheduled report and then look at the Schedule Info page immediately after the report runs, it lists the Next Scheduled Run as 12:00:00 AM.

This is the case for a Daily report that runs once and also after the last job of the day for a recurring scheduled job that is set to run multiple times on a given day.
The report will not run at 12:00:00 AM.

The following day, Next Scheduled Run will show the correct times.

**Simple Wizard Does Not Allow Moving Grouped Columns**

If a report uses grouping, the Simple Wizard allows you to rename the grouped columns but not to move them.

For example, the Agent Historical All Fields report is grouped by default as Agent Name = Grouping 1 and Skill Group Name = Grouping 2.

When you run the report and open the Simple Wizard, you can rename Agent Name to Agent, but you cannot move that column to the left of the report display.

See also:

- Report Wizard Formatting Tab (Grouping Definition) (page 156)
- Simple Wizard (page 114)

**SQL Block Support**

Anonymous block support allows a report designer to use a block of SQL as the basis for a report to a relational data source instead of a query or a stored procedure.

By selecting an anonymous block as the report data source, you can enter a large chunk of text into a textbox.

After submitting this SQL, Unified IC parses through the block looking for parameters. Parameters are simply prefixed with a colon (".:parameter1").

When the block is executed, the parameters are replaced with the value from the Unified IC interface. Any parameters found in the block become stored procedure-like parameters.

You see a message asking you to provide test values so that the block can be run and the resulting fields parsed out. After a successful test, Unified IC pulls out the resulting fields just like a normal report. You can then adjust the parameters and fields as in a normal stored procedure report.

When the block is run, the stored procedure interface is used to collect validated values for the parameters. Those values are then substituted for the parameters in the resulting SQL.

**Note:**

- In the current release, stored procedure and anonymous block reports do not support any type of data caching, so they are far more expensive than query reports.

- The block parser *should* support WebView queries that you have cut and pasted. However, comment (/* */ ) are not supported. Remove them before parsing a block.
Using Temp Tables in Stored Procedures and Anonymous Blocks

Some stored procedures and anonymous blocks need to use temporary SQL tables in their logic. Unified IC can run these procedures and blocks but is unable to analyze them in order to build a report around them.

When you attempt to analyze, you see an error message asking you to ensure you have not used temporary tables.

To build a report on a stored procedure that uses temporary tables, you must first create a dummy procedure that returns a sample data set, and then put the original body of the procedure (with the temp tables) back once the report is built.

EXAMPLE

This test stored procedure uses temp tables to build a report around.

**Figure 89: Using Temp Tables in a Stored Procedure**

```
CREATE PROCEDURE sp_TestCUIS
  @Val AS integer
AS

CREATE TABLE #test
  val1 INTEGER, val2 VARCHAR(50)

INSERT INTO #test VALUES (@Val, 'test')

SELECT val1, val2 FROM #test

DROP TABLE #test
GO
```

This procedure simply returns an integer and a string, selected from a temporary table.

If you attempt to analyze this procedure, Unified IC presents an error.

In order to analyze the stored procedure you must TEMPORARILY replace it with a dummy that returns a sample set of data. The illustration below shows the SQL:

**Figure 90: Workaround for Temp Tables 1**

```
ALTER PROCEDURE sp_TestCUIS
  @Val AS integer
AS

SELECT 2 AS val1, 'test' AS val2
GO
```

Notice that the body of the procedure has been removed and a simple SELECT statement has been put in place to simulate a row of data returned from the procedure.
When you create a dummy procedure for analysis purposes, remember that column names MUST be specified in the output, and data types should match what will ultimately be returned from the procedure.

Now the procedure can be analyzed successfully:

Figure 91: Successful Analysis Using Temp Tables

Notice that the column names and data types match the original stored procedure. You can now continue to build the report as normal.

After the report has been built, you can put back the original procedure code using an ALTER PROCEDURE statement:

Figure 92: Workaround for Temp Tables 2

```
ALTER PROCEDURE sp_TestCUDS
@Val AS integer
AS

CREATE TABLE #test (val1 INTEGER, val2 VARCHAR(50))

INSERT INTO #test VALUES (@Val, 'test')

SELECT val1, val2 FROM #test

DROP TABLE #test

GO
```

WHERE Clause Required in Query

When you create a report, be aware that the Query statement or the Anonymous Block Text in the Report Wizard Data Source tab must contain a WHERE clause.

If it does not, the validation will fail.
The Where clause must be there as a placeholder and need not perform any logic. For example, this query will validate:

```sql
SELECT Call_Type.CallTypeID, Call_Type.EnterpriseName FROM Call_Type Where 1=1
ORDER BY Call_Type.EnterpriseName ASC
```

This one will not:

```sql
SELECT Call_Type.CallTypeID, Call_Type.EnterpriseName FROM Call_Type ORDER BY Call_Type.EnterpriseName ASC
```

Value List Items Deleted in Unified ICM Configuration Display in Unified IC

If a value list item, such as an Agent Team, a Call Type, or a Skill Group, is deleted in Unified ICM Configuration Manager, that item will still appear in Unified IC, even after a manual refresh.

The report will run correctly, and no data from that delete item will appear in the report.
Index

abandoned calls....167
adding
  collections....83
dashboards....100
data sources....88, 149
drilldowns....130, 152
report categories....119
report fields....151
report lists to a dashboard....102
reports to a dashboard....102
scheduled reports to a dashboard....102
thresholds....134, 152
URL Frames to a dashboard....104
user groups....73
users....62, 68
users to user groups....74
value lists....81
widgets to a dashboard....103
administrative menu
data sources....56, 87
data source status....90
flushing global cache....148
value list/collection....79
Admin users....55, 71
advanced filter dialog box....112, 117, 138
advanced filters
  adding fields to....117, 129
  working with....117
Agent Assignment Queue Report....277
Agent Handle Report....278
Agent Historical All Fields Template....183
Agent Not Ready Detail Template....193
Agent Real Time All Fields Template....189
Agent Reject and Timeout Report....278
Agent Skill Group Historical All Fields Template....239
Agent Skill Group Real Time All Fields Template....245
agent states....168
Agent State Summary Report....279
Agent Team Historical All Fields Template....196
Agent Team Real Time All Fields Template....202
Agent Team State Counts Real Time Template....205
anonymous block....110, 151, 154, 183, 193
temp tables....302
Appearance tab....160, 165
Archiver....8, 46, 125
Assignment Queue Detail Report....279
Axes tab....163
bypass filter....109, 114, 298
caching....147
calculated fields....119
Call Type Abandon/Answer Distribution Historical....211
Call Type Daily All Fields Template....125, 215
Call Type Historical All Fields Template....215
call type intervals....169, 172
Call Type Real Time All Fields Template....222
call types....169
charts....111, 112
Chart Wizard
  Appearance tab....160
  Axes tab....163
  Chart Title tab....165
  Edit Series....161
  Gauge tab....162
  Legend tab....164
  Series Data tab....160
cloning reports....129
collections....82
adding...83
and user roles...82
deleting...84
editing...84
sharing...84
configuration...35
Archiver...46
collection tool...35
type reports...44
log...50
prerequisites...36
reports...43
rerunning...293
tips...290
Unified IC database...37
Unified IC web server...40
user history...42
Contact Detail Reports...280
Contact Media Detail Report...281
CuisLocalUserGroup...45
dashboards...99
  adding...100
  adding report lists to...102
  adding reports to...102
  adding scheduled reports to...102
  adding URL Frames to...104
deleting...100
design mode...101, 105
editing...104
  menu...100
sharing...104
Data Settings tab...155
data source
  failover...298
data sources
adding...88, 149, 151
deleting...90
editing...89, 149, 152
initial configuration...56, 87
status...90
Data Source tab...149
deleting
  collections...84
dashboards...100
data sources...90
drilldowns...130, 152
report categories...119
reports...129
schedules...137
user groups...75
users...68
users from user groups...74
value lists...82
deleting reports...298
deployment models...9, 10, 11
diagnostics...85
domains...292
drilldowns...130, 152
  selecting fields...132
dynamic headers...299
editing
  collections...84
dashboards...104
data sources...89, 149
drilldowns...130, 152
report fields...152
reports...129
schedules...137
thresholds...134, 152
user groups...74
users....68
value lists....81
editing report XML....129, 145
Edit Series....161
encryption....15, 44
Enterprise Service Historical All Fields Template....227
Enterprise Skill Group Historical All Fields....249
Enterprise Skill Group Real Time All Fields Template....254
Error Message Detailed Report Template....124
Error Messages Report Template....123
Error reports....44
Excel
advanced integration....146
exporting reports to....145
required for export to Excel....24
exporting report data....112, 115
exporting report XML....129, 145
fake a user....75
Field Map tab....151, 154
flushing global cache....148
folder permissions....294
Formatting tab....156, 157
FTE....170
Gauge tab....162
grids....171
grouping
and grids....171
users....70
handled calls....170
hidden fields....114
historical data....171
Historical Reports templates
Agent Assignment Queue Report....277
Agent Handle Report....278
Agent Reject and Timeout Report....278
Agent State Summary Report....279
Assignment Queue Detail Report....279
Contact Detail Reports....280
Contact Media Detail Report....281
fields in....283
IIS....290
importing reports....60, 142, 143, 299
installation....23
installed directories....30
logs....31
prerequisites....28
procedure....29
reinstalling....30
tips....289
uninstalling....30
internal users....32
Archiver User....32
domain....33
local....33
Unified IC User....32
IVR Ports Performance Historical Template....271
Legend tab....164
licenses....50, 295
event viewer....295
URL for Licensing site....295
localization....93
Multilingual User Interface....95
SQL collation....94
log in....55, 296, 297
Logo URL....74
logs
configuration....50
installation....31
menus
administrative....97
and user roles....70, 96

dashboard....100

navigation....96

profile....98

reports....97, 109

security....97

Multilingual User Interface....95

named instances....292

navigation menu....96

online help....112

overflow out....172

parameters....154

percent utilization....173

Peripheral Service Historical All Fields Templates....231

Peripheral Service Real Time All Fields Template....234

Peripheral Skill Group Historical All Fields Template.259

Peripheral Skill Group Real Time All Fields Template....265

permalink....129, 300

ping command....294

port 80....292

printing reports....112

profile menu

   edit user tab....69

   user history tab....69

query

   timeout....44

real time data....174

refreshing reports....112

refresh rate....155

renaming

   report fields....114

   reports....113, 144

report categories....114

   creating....119

   deleting....119

report context menu....128

Report Designer users....71

report fields

   agent states....168

   calculated....119

   error count fields....170

   FTE....170

   handled....170

   hidden....114

   overflow out....172

   percent utilization....173

   properties....152

   renaming....114

   service levels....175

   visible....114

report info....129, 138, 300

report lists

   adding to a dashboard....102

   running reports....109

report manager....127

reports

   adding to a dashboard....102

   bypass filter....109

   cloning....129, 298

   configuring row limit....43

   creating....149

   deleting....129, 145

   editing....129, 149

   editing XML....129, 145

   exporting to Excel....112, 115

   exporting XML....129, 145, 146

   fields in....283

   filtering....109

   importing....60, 142, 143

   interface....111
menu....97, 109
modifying....112
permalinks....129
printig....112
refreshing....112
renaming....129, 144
running....109, 129
save as....113
saving....112, 113
scheduling....129, 135, 137
sharing....76
SQL query....112
tips....298
report summaries....121
report templates....121
Agent Historical All Fields....183
Agent Not Ready Detail....193
Agent Real Time All Fields....189
Agent Skill Group Historical All Fields....239, 245
Agent Team Historical All Fields....196
Agent Team Real Time All Fields....202
Agent Team State Counts Real Time....205
Call Type Abandon/Answer Distribution Historical Template....211
Call Type Daily All FieldsTemplate....215
Call Type Historical All FieldsTemplate....215
Call Type Real Time All Fields Template....222
Enterprise Service Historical All Fields....227
Enterprise Skill Group Historical All Fields Template....249
Enterprise Skill Group Real Time All Fields....254
Error Message Detail....124
Error Messages....123
IVR Ports Performance Historical....271
Peripheral Service Historical All Fields....231
Peripheral Service Real TimeAll Fields....234
Peripheral Skill Group Historical All Fields....259
Peripheral Skill Group Real Time All Fields....265
report types....114
Report Wizard....149
Data Settings tab....155
Data Source tab....149
Field Map tab....151, 154
Formatting Grouping Definition....156
Formatting tab....156
Help tab....157
Restricted Viewer users....72
row limit....293
RSS feeds....138
running reports....109
save as....113
saving reports....112, 113, 300
scaled deployment....11, 25
scheduled reports
  configuring email for....41
  setting frequency....42
  schedule info....137
  scheduler....291
schedules
  adding....135
  managing....137
  RSS feed....138
scheduling reports....129, 137
Security Admin users....72
security center....76
security menu
  edit user roles....70
  fake a user....75
  security center....76
user groups....73
user list....67
Series Data tab...160
service levels....175
services....179
sharing
  collections....84
dashboards....104
  reports....76
short calls....179
Show Welcome Screen....69
simple deployment....9, 23
simple filter dialog box....109, 110, 112
simple wizard....112, 114, 119
skill groups....179
slideshow mode....100, 297
SMTP server....42
SQL Block Support....301
SQL button....112
SQL collation....24, 26, 94
SQL Server Authentication....295
SQL Server login....294
standard deployment....10, 25
stock report templates
  and WebView templates....121
data sources....121
  initial import....60
stored procedures
  temp tables....302
stylesheets....69, 74, 297
subgroup footers....300
temp tables....302
thresholds....133, 152
  adding....134, 152
  editing....134, 152
timezone....69, 74
tips
bypass filter....298
cloning reports....298
configuration....290
data source failover....298
deleting reports....298
domains....292
dynamic headers....299
folder permissions....294
IIS....290
importing reports....299
installation....289
licenses....295
log in....296, 297
ping command....294
port 80....292
report info....300
reports....298
rerunning configuration....293
row limit....293
saving reports....300
scheduled reports....300
scheduler....291
slideshow mode....297
SQL block support....301
SQL Server Authentication....295
SQL Server login....294
stylesheets....297
subgroup footers....300
temp tables....302
Unified IC database....292
value list....304
value lists....297
where clause....303
Unified IC....7
  adding users....62
Index

logging in....55
Unified IC database....37, 292
Unified IC web server....40
Unified IC website....46
Unified IS....7
deployment models....9
encryption....15
installation....23
licenses....50
uninstalling....30
URL Frames....104
UserActivityLoggingEnabled
debug....43, 44
user groups
adding....73
adding users....74
default....69
editing....74
removing....75
removing users....74
sharing collections....84
sharing reports....76
user history....42, 69, 98
user list....67
user profile....69, 98
user roles....70
admin users....71
possible combinations....70, 71, 72
report designer users....71
restricted viewer users....72
security admin users....72
users
active/inactive....69
adding....62, 68
adding to user groups....74
data permissions....76
deleting....68
editing....68edit user profile....69
fake a user....75
grouping....70
locating....67
removing from user groups....74
sharing collections....84
sharing reports....76
user groups....73
user history ....69
user list....67
value lists
about....80
adding....81
and user roles....80
deleting....82
displaying values....82
editing....81
initial configuration....58
items deleted in Unified ICM ....304
tips....297
visible fields....114, 119
Welcome Screen....93
where clause....303
widgets....103
Windows Integrated Authentication....295